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Welcome

Welcome to the ProPresenter 7 User Guide. These pages are 
intended to give you a glimpse of all of the different features that 
ProPresenter offers. Check out each of the sections below and a 
little information on what you'll find inside!


• Getting Started -- This area goes through the process of 
downloading, installing and registering the software on your 
machine. This is intended to be used if you're first using the 
software and working through adding it onto your computer.


• Interface -- The Interface walks you through many of the 
main windows of the program including where you'll trigger 
your slides, what you'll see when running a show and how to 
organize your elements in the program.


• Screen Configuration -- This section walks you through how 
to setup the screens that will be seen by those in your 
Audience and those on the Stage.


• Working with Slides -- As ProPresenter is a presentation 
program, slides are one of the main items inside of it! This 
section will walk you through how to edit your slides and all 
the different things you can do with slides to create an 
exciting presentation.


• Working with Files -- Here you'll learn how to import and 
export items into the program, as well as, the fundamentals 
of printing in the software.


• Working with Media -- Media includes videos, images, audio 
and video inputs and this section explains how to put 
together those items in the software as you build your show.
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• Other Features -- This section explains many of the 
fundamental features of ProPresenter that allow you to 
convey your message in new and exciting ways.


• Preferences -- The Preferences in the program offer many 
ways where you can modify how the program itself works. 
This section walks through each tab of this window 
explaining those settings and how they'll affect you.
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Getting Started

As you prepare to use ProPresenter, there are three main steps you'll need to 
go through... downloading the program from the Renewed Vision website, 
installing the program on your computer and then, if you've purchased the 
program, registering and activating your license.


Downloading ProPresenter

To download ProPresenter, simply go to our Download page at 
www.renewedvision.com and you'll see options for both Mac and Windows 
there. The newest version will be in the Download link and older versions are 
offered under Version History. We would recommend always downloading 
the latest update for installation.


Installing ProPresenter

The installation process is slightly different depending on if you are on a Mac 
or Windows machine.


To install ProPresenter on a Mac, unzip the Zip file that downloaded from the 
website and you'll see the Application file appear. Drag that Application file 
to your Applications folder in the Finder and then launch the Application 
itself from there. You can add it to your Dock if you'd like at that time. Please 
note that when you open ProPresenter for the first time, you may be 
prompted to allow the program access to your Desktop and Documents 
folders. As ProPresenter stores it's information internally in these folders by 
default, we would recommend allowing this.
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To install ProPresenter on Windows, you'll work through an installer. In this 
installer, you are prompted to setup file associations for the program to work 
with presentation files from previous ProPresenter versions. You will then be 
prompted to add shortcuts on your Desktop and in your Start menu should 
you like. Finally, the installation will begin and you will be prompted to 
launch the program at that time.


Welcome to ProPresenter

When you first open ProPresenter on the machine, the program launches a 
new walkthrough to welcome you and help set up the program for its initial 
use.


First, a video showing the basic functions of the program window itself is 
shown explaining the ins and outs of what you’ll see when the program first 
launches. You'll then need to accept the licensing agreement for the 
program.


Once you continue, our Migration window will appear.


This window allows you to 
import Libraries from 
ProPresenter6, as well as, 
their corresponding Playlists, 
Media Bins, Audio Bins, and 
any settings/support files. If 
you are moving from a 
previous version of the 
software, this is a great 
option to get a lot of your 
data into ProPresenter in a 
quick and efficient manner!


If you don’t wish to migrate 
at this time or have no 
previous data to migrate, 

you can choose the Skip 
Migration window. You can always choose to migrate pre-existing data later 
by going to File>Import>ProPresenter Library.


Once the Migration is complete or has been skipped, the next window allows 
you to set up a single Audience screen and Stage screen.
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In this setup window, you can select the currently attached screens or SDI 
output devices to assign each 
screen to. You also can set this up 
for an NDI or Syphon output 
(Syphon is Mac only)


If you don’t have your outputs 
attached currently, the best option 
would be to select a Placeholder 
so you can assign the outputs 
later. Once you’ve set these 
screens up, you can click Continue 
and move on to our Options 
window.





Here, we ask three questions of 
items that will occur in the 
program.


1.House of worship? -- this is 
asking if you’d like our House of 
Worship integrations such as 
Planning Center Online and 
SongSelect as well as the Bible 
View to appear in the program.


2.Share Crash Reports -- though 
we certainly don’t want to see 
the program crash and the 
chance of it occurring is unlikely, 

enabling this option will allow your crash reports to be sent internally by 
the program to our development team so we can improve the program 
for everyone!


3. Share ProPresenter Analytics -- we like to know what portions of the 
program are being used by the greatest number of our users as we 
continue to improve and enhance your experience. Enabling this option 
will allow the software to send us data on the features you’re using the 
most and allow us to best plan for the future together.
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Once you finish 
answering these 
questions, we give you 
links to great resources 
to continue learning how 
to use and work with our 
software.


Clicking “Continue” off of 
this window will close our 
Quick Start wizard and 
you’ll be ready to begin 
your ProPresenter 
experience. If you find a 
time where you wish to 
work through this again 
or if you skipped it 

initially when you launched the program, you can always re-access this 
guide by choosing the “Welcome to ProPresenter” option in the Help menu.


Now, you can move on to registering the software.
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Registering ProPresenter

ProPresenter allows you to run the fully functional program at any time, you 
will just see a watermark appear at random intervals on your Screens. This 
allows the creation and export of presentations, as well as, testing of the 
program to be done without the need to physically register the program.


Instead of prompting to register the program when you first launch it, there 
is a green “Open Registration” icon in the upper right hand corner of the 
program window which you can click to open the Registration window. You 
can also go to ProPresenter>Registration in the menubar.





This will pull up a window that says “Not Registered” and has a Start Trial,  
Purchase, and Register button. 


If you wish to trial the software, you can click Start Trial here and be taken to 
a form to get a two trial code inserted right into your program window.  


Clicking on Purchase will load our Store which allows you to purchase the 
license you wish to use the program with.  


If you’ve already purchased the software or have an unlock code, click on 
the Register button which will open the window where you will enter your 
license information.


In this window you will enter your Registration Name and Unlock Code that 
you received via email when you made the purchase of or upgraded to the 
new version of ProPresenter. You will also see a Device name field that will 
auto fill with your device name. This is the name that will hit our server, so if 
you would like it to be different from what is auto-filled, you can edit that 
here!


Once you have entered your information and clicked Register, it will show up 
as it does below:
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In this window, you see the first and last five characters of the unlock code at 
the top. You also see the full Registration name, the name of your machine 
(as seen by our servers), the date of your ProPresenter+ Expiration, and your 
available seat count.


At the bottom of the window, you can see the Current Seat State.  In the 
screenshot above the seat state is “Active”. When a seat state is “Active” there 
is no watermark on the outputs. You can open this dropdown and choose 
“Inactive” as well. When a seat is in an “Inactive” state, there will be a 
watermark on your output, but you will still have full access to the program 
including access to your purchased Bibles.


Once you change a seat to "inactive," that seat will not count 
against your "available seats". So, you if you have a single 
seat, you can register multiple computers, you would just only be 
able to have one "active" seat. 


Another available option in this window is to renew your ProPresenter+ 
agreement.  With the ProPresenter+ maintenance plan you get all updates 
while your plan is active.  Clicking on the Renew ProPresenter+ button will 
allow a new window to open on your screen. On that window, you can 
choose how many years you want to renew for and then proceed to 
checkout! 


You also have the option in this window to Unregister the software. If you are 
wanting to move your seat to another computer, you will do so by 
clicking Unregister here and then can use your license information to register 
your seat on a new computer.
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Interface

ProPresenter's user interface (the primary window in which you interact with 
the program) has evolved over the years to where it is now. The goal is to give 
you powerful controls while also being streamlined and easy to use.


This page outlines the main features of the primary window inside of 
ProPresenter that are discussed further in this section.


Below we will dive into each section, but just in way of a quick overview:


1. The main area is the View Mode, where you see, interact with, and build 
your Slides


2. Across the top you have the Toolbar which quickly gets you to different 
areas of ProPresenter
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3. Along the left is where you see all of the Presentations in 
your Libraries as well as where you will build your Playlists


4. The bottom features your Media Bin (which can be hidden), giving you 
quick access to your Image/Video Media files


5. The top right is all about what is going out of ProPresenter; see 
the Preview, click on a Clear button or see the progress of the currently 
playing video in this area


6. The bottom right features our Show Controls.  Show Controls allow you 
to access different features for preparing and running a live show like 
Props, Messages and Timers.  


View Mode

The area with the most real estate in 
ProPresenter is the View Mode. This 
area covers the center area of 
ProPresenter and has multiple uses; 
you can switch between these 
functions using the buttons on the 
top left of the Toolbar.


Show View

During a live performance you will likely be spending most of your time in 
the Show view of the Multi-View. This is the main ProPresenter area where 
you can control and trigger your slides to your screens and literally, run the 
Show. 


The Presentation Header




1. Slide Show Mode -- The Slide Show button allows you to execute a 

trigger event that runs every slide in a presentation for a certain 
amount of time. As this setting is handled in the presentation data 
versus the slide/cue data, it does not add a Go to Next Timer on every 
slide, it just executes the trigger event at the end of each timer and it 
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applies to all slides. In this manner, if you already have a Go To Next 
Timer on a slide, the slide's Go to Next Timer would override the time set 
in the Slide Show button. In addition, the final slide will always loop 
back to the first slide in the presentation. When you enable this setting, 
it will show blue and list the amount of time that the slides will run for. 
The default values are 5, 10, 15, 20, or you can choose to set a Custom 
amount of time.


2. Operator Notes -- Clicking this button allows you to add a small line to 
enter Notes into the program for a Presentation. Notes that are added 
here are shown at the top of the Presentation in a dark gray bar just 
below the Title. Operator Notes are useful if you need to include a 
general reminder about something related to the Presentation for the 
person running ProPresenter.


3. Groups/Arrangements -- This button allows you to toggle open/closed 
the Arrangement window. This is where you can setup your 
Arrangements and set what Arrangement will be used by the 
Presentation. 


4. Timeline -- This allows you to open the Timeline for the Presentation. 
The Timeline gives the option to create presentations with custom 
timings between slides or to record the slides to match a song with or 
without an audio track.


5. Destination Target -- The Destination Target button lets you set 
whether the Presentation you have selected will go to the Presentation 
or Announcements Layer. Your choice here would be dependent on 
how you have your screens and your Audience Look setup.


6. Presentation Transition -- The Presentation Transition is where you 
can set a transition to be used for all of the slides in a Presentation. This 
would override the Global transition set in the bottom left of the Show 
View Area and would be overridden by a transition added locally onto a 
single slide.  
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Viewing/Triggering Slides

There are three different ways you can view your slides in this area: Grid View, 
Table View, and Easy View. You can change which view you're using in the 
bottom right corner of the Show View by clicking on 
one of three buttons. The fourth button is the Settings 
for that particular view. No matter what view you're in, 
the Slider on the far bottom right controls the size of 
the Thumbnails in the Show View area.


Grid View


Grid View is the default view for ProPresenter. There are a number of visual 
icons that appear on each slide thumbnail to help you know what will be 
triggered on each slide. Hot Keys and other slide action icons are shown in 
the upper left corner of the Slide thumbnail and a transition icon appears in 
the bottom right of the thumbnail if a local transition is set on the Slide. The 
active slide is outlined in orange.


The Settings at the bottom right include two options: Slides by Group and 
Background Color. With Slides by Group enabled, Slides are broken down 
into their individual groups and shown with more separation. If you are using 
an Arrangement, each instance of a group in the Arrangement will be 
separated. This view can be helpful if you don’t have a pre-set order for the 
song and want to be able to quickly find each section of the song. 
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The Background Color allows you to change the slide background color on 
your thumbnail. This does not affect the physical output of the slide and only 
applies to the thumbnail for better viewing of the slides.


Table View


Table View is similar 
to Grid View and Easy 
View, but you also get 
a plain text view of 
the slide text in 
addition to the 
thumbnail. This view 
uses the same icons 
to indicate Actions 
and Transitions. 


This view also includes any Slide Notes that you have 
added to your presentation. The active slide is orange, 
and more obvious than in the Grid/Easy View.


The Settings here are similar to Easy View, but affect the 
plain text view of your Slide's text on the right side of the 
view. You can also set a background color for the Table 
itself alongside setting up a separate background color 
for the Slide thumbnails.
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Easy View


Easy View is a new view option in ProPresenter that allows you to set what 
your thumbnails look like without changing the output of the Slides 
themselves. This View is similar to Grid View, but no media actions are shown 
in the Slide thumbnails and the text is formatted based on your Settings.


In the Settings tab, you can set the following items for how the text on your 
Thumbnails will look.


• Slides By Group: As in Grid View, here, slides are broken down into their 
individual groups and shown with more separation.


• Cue Background Color: Choose a color from the 
color palette to change the thumbnail's 
background color.


• Font Formatting: Change your font type, style, size 
and color. This allows you to setup your text to 
better read what is on the slide. This is especially 
helpful if you have smaller lower thirds on your 
slide that are harder to see on the thumbnail.


• Alignment: Here, you can set the horizontal and/or 
vertical alignment of the slide text in your 
thumbnail.


• Truncate: Truncate allows you to pick what portion of text would not be 
shown in the thumbnail if the text is too large to fit inside. You can cut 
either from the beginning, middle or end of the Slide text.
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Miscellaneous Options

There are a few other options that can affect how you view your slides and 
how they're triggered here.


Show Triggered Presentation/Announcement

The options for Show Triggered Presentation and Show Triggered 
Announcement can help you quickly load the currently showing items on 
both the Presentation and Announcement Layer. These items are found in 
the Presentation menu.


Show Triggered Presentation will load the currently showing Presentation 
from the Presentation Layer into the Show View. You can also use the 
keyboard shortcut of Command-L on Mac or Control-L on PC to load this 
item.


Show Triggered Announcement will load the currently showing 
Presentation from the Announcement Layer into the Show View. You can 
also use the keyboard shortcut of Shift-Command-L on Mac or Shift-Control-
L on PC to load this item.


Continuous Playlist

In previous versions of ProPresenter, this was known as "Contiguous" view. 
This allows all items in a Playlist to be loaded at one time into the Show View 
so you can scroll through the entire Playlist at once. You can toggle this on/
off by going to View>Continuous Playlist in the menubar.


Global Transition Control


Across the bottom of the Show 
View, there are three transition 
buttons which determines the 
Master Slide Transition; think of 
this as a "default transition" that 
all slides will use unless there is 
reason to use a different transition. 


You can either set a Cut, Dissolve or a more Advanced Transition here.
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Edit View

Clicking on the Edit view button brings up ProPresenter's Editor.  


Reflow View

The Reflow view makes it quick and easy to edit the text of your 
Presentations; click on the Reflow view button to open the Reflow Editor.


Bible View

Many of ProPresenter's users want to quickly show Bible verses to their 
audience. The Bible view quickly allows you to show one or more Bible verse 
on the screen at a given time.


Other Views

There are several other view modes that you may find ProPresenter using 
(such as while using the Stage Editor or the Props Editor); in all of these 
cases, the "More" button in the Toolbar will be highlighted. To return to one of 
the main views simply click on the associated view button and it will close 
out of that particular view.
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Toolbar

The Toolbar lives across the top of the ProPresenter user interface and lets 
you quickly access many of the features of ProPresenter.


Starting with the top left:


• Search: Brings up the Search window


• Text: Allows you to apply a new text formatting using the options in the 
menu to the currently selected slide(s) or Presentation(s).


• Theme: Allows you to quickly apply a new Template to the currently 
selected slide(s) or Presentation(s).


Multi-View Buttons:


• Show: Shows the Show view


• Edit: Shows the Edit view


• Reflow: Shows the Reflow view


• Bible: Shows the Bible view


• More: Opens a menu with access to all Editors other than the Slide 
Editor such as the Props Editor, Theme Editor and Stage Layout Editor


Feature Buttons:


• Store: Toggles the Media Store


• Media: Toggles the Media Bin


Library and Playlists

The leftmost section of ProPresenter's user interface allows you to interact 
with the Presentations that are in your Libraries and Playlists.


A Presentation is most simply a group of slides. That is, any time you want to 
have a number of slides that are grouped together for easy access, you will 
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create a Presentation and add those slides to that Presentation. Common 
examples of Presentations are songs, speaker notes, or announcements.


A Library is a large database of Presentations, typically containing all of the 
Presentations you have created and want to use again. For example, you 
may have a Library that contains all of your available songs, or maybe have 
different Libraries for different types of services that will be run on that 
presentation computer. Libraries will always sort their Presentations 
alphabetically.


A Playlist is a small group of Presentations, typically representing a specific 
event or service. For example, if you have an event or service coming up, you 
would create a Playlist, then add Presentations into that Playlist and 
organize them in the order that they will be used in your event or service.


Note: Presentations can be in multiple Libraries, but each 
Presentation is then seen as a different file. Think of a 
Presentation as having a property for which Library it is located 
in. That Presentation can also be added to one or more Playlists 
(or even to a single Playlist more than once), however the 
Playlist is simply referencing the original Presentation. So it 
doesn't matter where you make a change to a Presentation (its 
Library or a Playlist), that change will be made to all Playlists 
that reference that Presentation.

On the upper portion of the left side of ProPresenter you 
can see and organize your Libraries and Playlists.


Click the + button to:


• Add a New Library


• Add a New Presentation


• Add a New Playlist


• Add a New Playlist Folder


• Add a Planning Center Service… 

Click on the ^ button hide the Library and Playlist section, 
allowing the operator to focus solely on the contents of the currently selected 
Playlist or Library. While in this mode, the name of the current Playlist or 
Library will be shown across the top; click this name to show a list of all 
Playlists and Libraries, then click on a new Playlist or Library to show the 
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contents of that item. Click the v button to reveal the Library and Playlist 
section again.


Libraries

Click and drag a Library to re-order your Libraries. To rename a Library, right-
click on the Library and choose Rename. To delete a Library, right click on 
the Library and choose Delete, or select the Library and press the Delete or 
Backspace key.


If you have a Library selected, at the bottom of this area, there is a “Filter” 
option.  Here, you can search this specific Library for a title of a presentation 
or a portion of a title to narrow down what you’re looking for.  This can be 
especially helpful if you have multiple Libraries as this will only look at the 
specific Library you have open.  


Playlists

Click and drag a Playlist to re-order the Playlists. To rename a Playlist, right-
click on the Playlist and choose Rename, or select a Playlist, wait a moment, 
and click the name again. To delete a Playlist, right-click on the Playlist and 
choose Delete, or select the Playlist and press the Delete or Backspace key. 
You can export a Playlist by right-clicking on a Playlist and choosing Export, 
or select the Playlist and in the menubar select File > Export > Playlist….


Media Bin

The Media Bin, situated at the bottom of the main ProPresenter window, is a 
great way to organize and trigger still images and videos.


To show or hide the Media Bin:


• Click the Media button on the top right of the main ProPresenter 
window,


• Select from the menubar View > Media Bin


• Press Control-V on a Mac or Control-Shift-V on a PC.


Page  of 19 193



Note: For the purposes of this section, "media" refers to still 
images and videos; audio cannot be added to the Media Bin as it 
would need to be organized via the Audio Bin.


The Media Bin is divided into two sections: the Outline View which lists your 
Media Playlists and Folders on the left and the Detail View showing the 
contents of those Playlists on the right. Click and drag the divider between 
the sections to resize the two sections. Click and drag the divider across the 
top of the Media Bin to make it larger or smaller.




Media Playlists

The left side of the Media Bin allows you to have multiple Media Playlists to 
help organize your media. Add Smart Playlists to have ProPresenter 
automatically reflect the contents of a folder on your computer, and 
add Playlist Folders to help organize your Media Playlists.


Media Playlists are Playlists that can contain both Foreground and 
Background media. Think of a Media Playlist as a container for organizing 
and separating your media files. For example, you might have a Media 
Playlist for slow motion backgrounds and one for fast motion backgrounds; 
one for media that has blue as its primary color and one that has media 
with red as its primary color. You can add, remove, and sort as many media 
files as needed into Media Playlists.


A Smart Playlist is a special type of Media Playlist that looks at a folder on 
your computer and automatically adds and removes media based on the 
folder on your computer. You cannot manually add or remove Smart Playlist 
media directly inside of ProPresenter, instead that would have to be done via 
the operating system on the computer; open the operating system and add 
or remove your media from that folder and ProPresenter will instantly 
update to reflect the change.
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Note: Smart Playlists ARE "recursive," meaning it will not only 
search the folder you point it at, but also any sub-folders 
within that folder.


Playlist Folders are for organizing Media Playlists and Smart Playlists. That 
is, Folders cannot contain media themselves, instead they contain Playlists 
which contain media.


There are two special Media Playlists that are always visible:


• Downloads contains media that was downloaded from the Renewed 
Vision Media Store and is only present once you’ve downloaded a file 
from the Media Store.


• Video Input shows the video inputs that you set up in the Video Input 
tab of Preferences.


Click and drag a Playlist or Folder to organize the Playlist area. Click 
the + button to:


• Create a New Playlist


• Create a New Smart Playlist


• Create a New Playlist Folder


To rename a Playlist, select that Playlist, wait a few seconds, then click on the 
name again.


Media Cues

The main area of the Media Bin shows the contents of the currently selected 
Media Playlist. That is, it shows all of the media that is contained within the 
Playlist that you most recently clicked on.


This area has many uses. It helps organize and prepare your media. You can, 
with a quick look, see many of the properties of a given piece of media. You 
can fire media (send it to an audience screen) simply by clicking on it. You 
can also quickly drag media from the Media Bin directly on top of a slide in 
the Slide View to attach that media as an Action to that slide.


Add media by dragging the media from your computer's operating system 
onto this section, or by clicking the + in the lower left. Click and drag media to 
manually organize the media, or right click on a piece of media, hover 
over Clean Up By, and choose one of the options to sort the media by that 
category.
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On the bottom left, select one of the transition options for controlling what 
the default media transition effect/time will be. 


Note: The default media transition can be overruled by a 
transition being added to a specific media action.


Across the bottom of the Media Bin click on the Filter textbox to do a name 
search of all of the media in the currently selected Playlist. Click the X button 
to clear the search.


On the bottom right of the Media Bin you can control how the media 
thumbnails look in the Media Bin. Drag the slider to make the thumbnails 
larger or smaller. There are two views for the Media Bin:


• Grid View: The media thumbnails are shown in a grid; this shows more 
thumbnails but shows limited information about the media itself.


• Table View: The media thumbnails are shown in a table; this limits the 
number of visible thumbnails, however it provides more information 
about the media itself, such as the Path (where the media is located on 
the computer), its Duration, its Format, and Producer (if downloaded 
from the Media Store). Click on a column header to quickly sort by that 
column. To toggle a column in Table View, right click on the header and 
click the column you wish to toggle.


Right-clicking on a media thumbnail gives you a wide range of options:


• Layer: Control which layer (Foreground or Background) the media will 
play back in


• Scaling: Control how the media will be scaled (Scale to Fill, Scale to Fit, 
or Stretch to Fit)


• Playback: Control if the video will Stop, Loop, or Soft Loop at the end of 
the video


• Next Cue: Control which media file (if any) plays at the end of the video


The Next Cue setting is only applicable in the Media Bin Playlist 
and will not transfer if the Media Cue is added as an Action on a 
Slide or into a Library Playlist


• Inspector…: Opens the Media Inspector.


• Transitions…: Allows you to set a unique Transition for this media file
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• Show in Finder or Reveal in File Explorer: Shows where the media file 
is stored on the computer


• Clean Up By: Sorts the current Playlist by the option selected


• Cut, Copy, Paste, Delete: These are the standard use commands in 
working with files


Media Bin Actions

With the release of ProPresenter 7.3, you can now trigger Playlists from the 
Media Bin on a single slide click with an Action.  This is extremely useful 
when you want to trigger an entire playlist of media, such as 
announcements from a Smart Playlist.  


This can be accomplished by dragging your Media Playlist from the Media 
Bin to a slide in a Presentation. You can also add it in front of or behind a 
slide to create your own slide cue for this action, or from the Action Palette by 
adding Media Bin Playlist to a slide.
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Preview Window

The Preview area of ProPresenter, located on the top right of the main 
ProPresenter window, gives you quick access to not only see the output of 
ProPresenter, but also quickly turn on and off the Audience and Stage 
Screens, and clear Layers of content.


Audience and Stage Preview

There is a large Preview window which lets you see a preview of one of your 
Screens. Click the down arrow below the Preview window to select which 
Screen (Audience or Stage) you would like to Preview.

Across the top of the Preview window there are two icons will tell you if your 
Audience and/or Stage Screens are on or not. If the light is green then those 
Screens are on, if the light is red then those screens are off. You can click on 
these buttons to toggle the Audience and/or Stage Screens off/on. This 
applies only to the system outputs attached to the machine.
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Capture Button

The Live button in the upper right of the Preview window allows you to 
access the Capture settings for a screen recording or stream as well as 
starting the Capture itself.  


Once you start a Capture, there 
are three colors the indicator 
can be depending on the 
status of your capture.  The 
indicator will typically be green 
as that means the connection 
is properly streaming and 
there are no interruptions 
through ProPresenter.  If the 
color is yellow, this is a warning 
that the stream is dropping 
frames.  If the color is red, this 
signals that your network connection has been lost or the stream has been 
stopped for another reason.  This check happens on a regular basis and we 
recommend watching this indicator to confirm the health of your stream.  


Clicking on this indicator during a Capture will give you stats about your 
Capture and allow you to stop the Capture at any time.  


Clear Buttons

To the right of the Preview window are a series of icons, each one 
representing a Layer. If content is filling a given Layer, then that Layer's 
button will turn red.


Click on any of the buttons to Clear that Layer. Click the Clear All button to 
clear all of the Layers at once.


You can also clear Layers by going to the Action menu in the Menubar, or by 
pressing the corresponding keyboard shortcut:


• F1: Clear All


• F2: Clear Slide


• F3: Clear Background


• F4: Clear Props
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• F5: Clear Audio


• F6: Clear Logo


• F7: Clear Announcements


Clear to Logo

If you have a logo set in the General tab of ProPresenter Preferences, an 
option for Clear to Logo will appear in the bottom right corner of the Preview 
window. Clicking on this button will immediately send your selected logo to 
the Media layer of your Audience screens. If you do not have a logo set in 
Preferences, this option will not appear in the window.


Transport Controls

Below the Preview window is an area where you can see and control the 
progress of currently playing media; these controls are often 
called Transport Controls.


Across the top of the Transport Controls are three icons; these icons control 
which media the Transport Controls are showing:


• Foreground/Background Media


• Announcement Media


• Audio Files


Below these icons is a scrub bar. If you are playing a video in the currently 
selected layer (or audio file if the audio layer is selected) then you will see the 
progress of the video in the scrub bar; click and drag the scrub bar to control 
the timing of the video.


Below the scrub bar are four buttons:


• Rewind 15 seconds


• Pause/Play


• Fast Forward 15 seconds


• Jump to... 
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The *Jump to... button is customizable; right click on it and choose between:


• -0 (jump to the end of the video)


• -10 (jump to the end of the video with 10 seconds left)


• -30 (jump to the end of the video with 30 seconds left)


• -60 (jump to the end of the video with 60 seconds left)


• -90 (jump to the end of the video with 90 seconds left)
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Show Controls

ProPresenter 7.5 introduced a new function in the ProPresenter interface.  
Show Controls are tools in the bottom right of the program that allow you to 
prepare and run your live show.  This area of the program allows you to 
playback audio files, setup Props and Messages, change the way your Stage 
screen works and create Timers for many facets of your event.  


More about Show Controls can be found in that section of this user guide.  


Page  of 28 193



Screen Configuration

ProPresenter features a powerful render engine capable of outputting to 
multiple outputs and destinations at the same time. This functionality 
provides the option to add as many system outputs as your computer can 
handle to more advanced output types such as SDI, NDI, and Syphon.


Display Terminology

To master the Configure Screens window you must first master the 
terminology that the Configure Screens window uses.


Audience vs. Stage

ProPresenter has two types of screens: Audience and Stage. Generally 
speaking, an Audience screen is a screen that the audience will look at, and 
a Stage screen is a screen that people on the stage can see.


More specifically, the Audience screens have a full stack of Layers (as 
discussed in the Layer section) and is where your slides, media, and other 
content will be displayed. The Stage screens instead take the content that is 
being sent to the Audience screen, and, along with other content such as 
clocks, timers, and notes, is displayed in a user friendly way so that the 
people on stage can quickly see that information.


Tip: Screens that people on the stage can see have been called 
many things over the years. You might hear it referenced as a 
Confidence Monitor, Conference Monitor, Foldback screen, or, as 
in previous versions of ProPresenter, a Stage Display.


Screen

A Screen is the digital representation of your physical devices inside of 
ProPresenter. Think of a Screen as one render out of ProPresenter. Note that 
you can send one Screen to multiple devices (using the Mirror option), 
allowing ProPresenter to render something once yet drive multiple outputs.


There are four types of Screens (Single, Mirror, Grouped, and Edge Blend); 
each of these options will be covered more in depth separately.
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Output

An Output is the connection between a Screen (as defined above) and the 
physical device (or digital equivalent) that ProPresenter will be displaying on. 
That is, it is a property of a Screen that tells the rendered image where to go.


Here are the various Output types.


1. System -- this will be any physically connected outputs to your 
computer including VGA, DVI and HDMI outputs


2. BlackMagic -- this is any BlackMagic device that allows for SDI output 
from the program


3. NDI -- this option will create a virtual output that shows over the 
network on any software programs or external hardware capable of 
receiving an NDI input


4. Syphon -- this is a Mac only option that allows you to output on the 
same computer to a program that is capable of receiving a Syphon 
input


5. Placeholder -- this is used if you are not physically connected to an 
output, but wish to link it later and begin setting up your Screens and 
Looks for a program


Output Target

In many cases you will want the rendered image to fill your device, but there 
may be instances where you want the rendered image to not fill the device, 
such as if you are using a matrix device (DualHead2Go, TripleHead2Go, 
Datapath, etc.). In these cases you can set the Output Target to only render 
to a part of your Output.


Primary Output

In some cases a Screen might have more than one Output; in these cases 
there will be one Primary Output which sets limitations, such as aspect ratio, 
on the other Outputs in that Screen.


Screen Types

There are four types of Screens as described below. When you create a new 
Screen you can select which type it will be, or you can always change it later 
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by selecting the dropdown at the upper left of the Screen Configuration 
window.  


Single Screen

Selecting Single will have ProPresenter render one Screen that will be sent to 
one Output. This is the standard option that you'll wish to use in most 
installations.


Mirrored Screen

Selecting Mirror allows you to send one Screen to multiple Outputs. Each 
mirrored Output will be shown as a separate box in the center of the window. 
Click on a box to select it to control its properties. The Primary Output will be 
the leftmost Output that is shown. In the upper right corner of the Configure 
window, you can selected the number of mirrored Outputs you are seeing.


Note: Mirrored Outputs can have a different resolution than the 
Primary Output, however all Outputs will be rendered at the same 
aspect ratio as the Primary Output.


Grouped Screen

If you want for ProPresenter to output one Screen to a grid of multiple 
Outputs then you would select Grouped. The classic example of this would 
be a wall of TVs with one image stretched across all of the TVs.


In the upper right corner of the Configure window, you can select the 
number of Rows and Columns in your grid.


Edge Blend Screen

The Edge Blend option is perfect if you will be using multiple projectors with 
their edges blended to create a larger, seamless image.


In the upper right corner of the Configure window, you can select 
the Number of Devices that will be edge blended to create your Screen.


Note: Only horizontal edge blending is supported inside of 
ProPresenter.
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The Configure Screens Window

The Configure Screens window is where you set up your Screens and 
Outputs. Open this window by pressing Command-Option-1 on a Mac or 
Control-Alt-1 on a PC, or by selecting from the menubar Screens > Configure 
Screens.


Note: The 
Configure Screens 
window replaces 
the Display 
Preference tab in 
previous versions 
of ProPresenter.


The Configure 
Screens window is 
divided into three 
main sections: 
Audience Screens 
on the top left, 
Stage Screens on 
the bottom left, and 
the Configure area 
on the right side of 
the window.


Audience and Stage Screens

On the left side of the Configure Screens window there are two sections, one 
for your Audience Screens and one for your Stage Screens. All of your Screens 
will appear in one of these lists.


Click the toggle button next to the section header to turn on or off all of your 
Screens in that section. Note that only System screens can be toggled on/off. 
SDI, Syphon and NDI screens cannot be toggled off and stay on perpetually 
once they are created. Click the + button to add a new Screen in the 
appropriate section.


Click on a specific Screen to be able to edit that Screen. Single clicking on the 
name of a Screen allows you to Rename the screen or you can right click on 
a Screen to be able to Rename or Delete that Screen. If you have a trackpad, 
you can also Delete a Screen doing a full swipe across the Screen name. A 
partial swipe will bring up a Delete option that you can click on.
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Identify

On the bottom left of the Configure Screens window are 
two Identify buttons: Screens and Outputs. These buttons are useful for 
troubleshooting during setup.


Clicking on the Screens button will add an overlay on all of your Screens with 
the name of that Screen, the type of devices that it is being shown on, its 
resolution, and its aspect ratio shown.


Clicking on Outputs will add an overlay on all of your Outputs with the name 
of that Output, the hardware driver that is being used, its resolution, its 
aspect ratio, and its framerate shown.


This is specifically helpful when using an Output Target as the Output will 
show information on the full output of the hardware whereas the Screen will 
show each individual Screen that is rendering to the Output.





Note: The Audience and/or Stage Outputs must be turned on for the 
Identify buttons to work. You may only have either the Identify 
Screens or Identify Outputs on at any given time.


Configure Screens

The main area of the Configure Screens window lets you fully customize your 
Screens, including connecting them to your Outputs.


Across the top of the window you will see the name of the Screen as well as 
its resolution. Click on the name of the Screen to rename the Screen.  Click on 
the check box next to Screen Color to enable that screen's Background 
Color; click on the color chooser to select which color you would like to use for 
the background of that Screen.
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Below the name and resolution of the Screen is the Arrangement option; 
click the dropdown to select which type of Screen you would like to use: 
Single, Mirror, Grouped, or Edge Blend. To the right of the Arrangements 
dropdown is where you can edit the number of Outputs in your Screen (as 
covered in the Screen Types section).


In the center of the window you will see visual representations of all of your 
Outputs within the currently selected Screen. Click on an Output to select it 
and edit the properties below. If you are using an Edge Blend type, click the 
blend area between the screens to edit the properties for that blend area.


Across the bottom of the window you can configure the currently selected 
Output, including assigning your physical or virtual devices to that output. 
There are several tabs you can select to adjust different properties of your 
Output.


Hardware Tab

Click the dropdown menu under Output to select which device and 
resolution you will be sending the signal to. Below the dropdown it will show 
information about the Output; which information is shown depends on what 
type of Output you have selected, but it may have information such 
as Name and Resolution. Similarly, depending on what type fo Output you 
are using, you may be able to change some of these options, such as its 
Name.


On the right of the Hardware tab you can select the Output Target. Click the 
dropdown menu to choose if you want the rendered image to fill the entire 
screen or only fill a portion of the screen; you can select one of the defaults 
(such as 2 X 1, 2 X 2, or 3 X 1), or select Custom to specify a specific location on 
the Screen.


Color Tab

This tab allows you to adjust the color of your Output. You might use this 
feature if you have projectors or TVs whose colors don't match, or you are 
projecting onto a colored wall and need to compensate for it.


Toggle the checkbox on the left to Enable or disable the feature. Click and 
drag on the slider, type in a number between -1 and 1, or use the arrows to 
adjust each color as needed. Click Reset All to reset all of the properties back 
to zero.
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Corner Pin tab

If you are using a projector, the best case scenario is that the projector is 
completely perpendicular to what you are projecting onto, but this isn't 
always an option. For example your projector might be mounted off-center, 
or the "perfect position" might not be a realistic expectation to have.


This is an example of when you would want to use the Corner Pin feature. 
This feature lets you adjust (or "pin") one or more of the corners so that the 
projected image perfectly fits your screen.


Toggle the checkbox on the left 
to Enable or disable the feature. 
Type in a number into one of the 
text boxes, or use the arrows to 
manually adjust each corner as 
needed. Click Reset All to reset all of 
the properties back to zero.


Each number represents that 
corner's Delta (represented by Δ); 
this means that typing in a number 
will adjust that corner that number 
of pixels away from where that 
corner normally would be. Negative 
numbers are towards the center, 
positive numbers are away from the 
center.


For example, typing in -50 for ΔX and -50 for ΔY will move that corner fifty 
pixels in and fifty pixels down towards the center of the screen.


Note: Each number is limited to one quarter of the overall 
resolution of that Output. For example, if your Output is 
1920x1080, you divide these numbers by four to get your limits of 
480x270, thus your X value is limited to a number between -480 
and 480 and your Y value is limited to between -270 and 270.


Alpha Key tab

Note: The Alpha Key tab is only available for NDI Outputs and SDI 
Outputs with Alpha Key supported hardware.
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When the Alpha Key is 
enabled on an SDI output, 
you can set what type of Key 
you wish to use 
(External or Internal) and 
also the percentage level 
of Blend that will be used. 
An External key would be used 
if you are sending separate 
key and fill outputs to your 
broadcast video switcher. It 
sends the key signal through 
the preview out of the 
BlackMagic device and the fill 

out of the program output. An Internal key would be used if you are using 
the Alpha Keyer as a downstream key, with a video input coming into the 
BlackMagic device and one going out of it.


When the Alpha Key is enabled on 
NDI, ProPresenter will send the 
rendered image out with an Alpha 
Key in place of the background 
color. This can be useful if you want 
to key your text on top of video, for 
example. There are no other settings 
when sending an NDI Alpha Key 
output, you simply can enable or 
disable the Key.


Remember that only the Background Color will be keyed out; any 
content in any other Layer will not be keyed out.
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Audience Looks

Looks allow you to choose what components of your content goes to each 
individual Audience 
Screen.


To access the Looks 
pane, go to the 
Destination Target 
button in the 
Presentation header 
and hit Edit Looks, 
use the keyboard 
shortcut of Shift-
Command-1 on Mac 
or Control-Shift-1 on 
Windows or go to 
Screens>Edit Looks in 
the menubar.


The Looks Pane offers 
a column for each 
Audience Screen created in Screen Configuration. This allows you to set 
which elements go to each screen, and allows you to change the formatting 
of your slides if necessary.


The left side of the pane shows the currently Live Look at the top and then 
lists any Presets you've created below. To add a new Preset, click the + button 
and it will automatically appear at the bottom of this list. You can click on 
the Preset name to rename this preset to better describe what Look this is 
used for.


Once you select a Look Preset 
on the left, that preset's 
settings will appear on the 
right. At the top of the right 
side of the pane, the name of 
the preset will appear. 
The Enable Identify button 
allows you to visually see on 
your Audience Screen the 
layering of what components 
are enabled on that Screen for 
that particular Look Preset.
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You can also make changes to a Look Preset and click on the Save button to 
update the Preset you're using or Save as a new Preset to use in the 
program.


Audience Look Components

There are seven different layers that you can choose to send an Audience 
Screen depending on how your Look is setup.


• Mask -- Masks allow you to “mask” (or cover up) a part of your Screen to 
create custom projection screens or to keep the projector from 
projecting onto something you don’t want. You can choose which Mask 
(if any) you wish to use in the dropdown here


• Messages -- Messages are used to put a piece text on top of one or 
more screens — you can set these up in the Show Controls area either 
on the fly or to trigger using an action on a certain slide.  


• Props -- Props are used to overlay a persistent slide object on the third 
highest layer of your screens.


• Announcements -- The Announcements Layer allows you to send a 
presentation set with a Destination Target of Announcements to some 
screens while sending a different presentation to the main 
Presentation Layer. 


• Presentation -- The Presentation Layer is a static layer with two 
components. The dropdown menu allows you to change the Theme 
Template used to reformat your Presentation slides. This allows you to 
send the same text to multiple Audience Screens, but have it formatted 
differently on each Screen.


• Once this is set, there are two components to a Presentation you 
can enable.


◦ Slide - this shows any text/shape object component on the 
Cue itself to the Presentation Layer
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◦ Media - this shows any media action that has been added 
to the Cue to the Presentation Layer. This also would affect 
standalone Media from the Media Bin.


• Video Input -- The bottom-most layer on a Screen is the Video Input 
Layer. This allows you to show previously created Video Inputs in the 
program.


Audience Look Actions

Use Audience Look Actions on slides to quickly change which Look you are 
using to show content to the audience screens.


Add Audience Look Actions to slides by either:


• Opening the Action Palette and dragging the Audience Look Action 
onto a slide or


• Right clicking on a slide and selecting Add Action > Add Audience Look 
Action and choosing which Audience Look you want to use


When adding or editing an Audience Look Action you will be able to select 
which Look you want to use when that slide is clicked. This will change the 
Live Look that is used until a new Look is selected either via an Action or 
through the Looks menu.


You can only have one Audience Look Action per slide.
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Stage Layouts

The Stage Screen feature provides a “foldback”/“confidence” monitor so that 
the people on stage can receive information such as the Current and Next 
slides, clocks, timers, notes, chord charts, and even custom messages that 
only they can see. Stage screens continue to evolve and ProPresenter has 
even more flexibility now than ever before as to what components can be 
sent to these screens.


To setup these layouts, you will need to open the Stage Layout Editor. To 
open this, you can hit Command-4 on Mac or Control-4 on PC or go to 
Screens>Edit Layouts... in the menubar.





The Stage Layout Editor works similarly to the main Slide Editor, adding 
more options for linking to other parts of the program. To create a new 
layout, you can choose from a premade layout or add a blank layout by 
hitting the + button in the upper left of the Editor in the 
Slide Navigator.


There are three basic formatting options on the Stage 
Layout when you have no objects selected on it.


• Name - the Stage Layout’s name, shown 
throughout the program. This can be seen in the 
Screens menu when choosing Stage Layouts for 
each Screen.


• Background - this allows you to set the 
Background color for the Layout to something 
other than the default Black using the Color 
Palette to better integrate in your setup
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• Size - this allows you to set the resolution this Layout will run at. It's 
recommended to set this Size to match the resolution of the Output 
you'll be displaying this Stage Layout on.


The Stage Layout Editor is similar to the Slide Editor in that you have a lot of 
flexibility as to the different items you can add onto your Layout. This 
primarily uses the Linked Text and Fill options in the Editor to send different 
portions of the program's data to the Stage Screen at any given time. To add 
an object to the Layout, click on the + button in the upper left of the Editor's 
Canvas, just as you do in the main Slide Editor. Linked Objects will show in 
the Layout Editor window with a yellow outline and yellow text at the upper 
left of the object bounds will show what the Object is linked to.


The Objects that you can add to your Stage Layout are described below.


• Current Slide -- This is the current slide shown 
on the Audience screen. There are three 
options for Current Slide data:


◦ Text -- this is the text from the slide itself 
and will be formatted to whatever text 
style you set in the Text Tab of the 
Inspector on the right side of the Layout 
Editor


◦ Preview Image -- this will send a static 
image of the Slide to your Stage Layout 
similar to the thumbnail shown in the 
main "Show" view


◦ Notes -- this will send the Slide Notes 
that have been added in the Slide Editor to this box


• Next Slide -- This is the slide after the current slide. There are three 
options for Next Slide data:  


◦ Text -- this is the text from the slide itself and will be formatted to 
whatever text style you set in the Text Tab of the Inspector on the 
right side of the Layout Editor


◦ Preview Image -- this will send a static image of the Slide to your 
Stage Layout similar to the thumbnail shown in the main "Show" 
view
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◦ Notes -- this will send the Slide Notes that have been added in the 
Slide Editor to this box


• Screen Preview -- this allows you to send a live version of any of your 
Screens to your Stage Layout. This allows the Stage Layout to show any 
Screen including your Announcements Layer, main Presentation Layer 
or even another Stage Layout


• Chord Chart -- this will show a PDF or JPG chord chart that has been 
added to your Presentation


• Stage Message -- The Stage 
Message allows you to send 
a message specifically to the 
Stage. It’s not visible on the 
Audience screens. To access 
this feature, open the View 
menu and select Stage, click 
the Stage button in the Show 
Controls, or press Command-
Shift-S (Alt-S on PC). Type 
your message and 
click Show for it to send the 
screen. Clear will remove the 
message completely 
and Hide removes the 
message from the Stage 
Layout, but doesn’t delete the message. 


• Planning Center Live -- Planning Center Live is a web object that loads 
on the Stage Layout and can display the countdown time, current item, 
and next item as linked from Planning Center Live.


• Timers -- this menu will show any currently created Timer from the 
Timers window. You can also set Color Triggers for these Timers and the 
main formatting of how the Timer looks in the Text tab of the Inspector 
on the right side of the Layout Editor. 


• System Clock -- this is the actual System Clock showing (if you wish) 
both the date and time or any part of these items. You can set what 
format you would like the date and time to use in the Text tab of the 
Inspector on the right side of the Layout Editor.


• Video Countdown -- Video Countdown shows the time remaining on 
the currently playing video. This feature is helpful for those on stage to 
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know how much time is left in a video, such as a countdown video or 
intro video.


• Audio Countdown -- this clock shows the time remaining on the 
currently playing audio file.  


• Group -- You can select here to view the Group Label for the current 
slide, the next slide or the next Group in the Arrangement — this can be 
helpful for keeping those on Stage on track with the roadmap of a 
given presentation


• Label -- This is the physical label showing on the right of a Slide.  You 
can select this for the current or next slide and is another helpful option 
to keep those on the Stage to know where they are in the presentation.  


• Capture Status -- This feature allows you to see the current status of a 
capture in ProPresenter.  This is useful if you are using the Stage screen 
as a Producer mode to keep those abreast of any issues in a stream/
capture.  


• Shape -- In the same vein as the main Slide Editor, you can add a 
Shape to your Stage Layouts. The same formatting options apply for 
this and you can even choose to Fill this with either a Video Input or 
piece of Media to brand your Stage Layout.


• Text -- Again, a Text box can be added if you wish to have Text on your 
Layout that shows at all times. This can be helpful to label the elements 
on the Layout or to place a constant piece of information that needs to 
show on the Layout.


Outside of the + button, there are a few other items you can use as Linked 
Text through the dropdown in the Text tab of the Editor.  These are listed 
below.


• Slide Count -- This allows you to see either what number slide you’re on, 
how many slides are remaining in a presentation or how many total 
slides there are


• Presentation Name -- shows the current presentation name showing 
either on the Presentation or Announcement layer


• Playlist -- offers different options/facets of Playlist data including the 
name of the Playlist itself, the current item selected, the next item in the 
Playlist, the current active Header, and the next Header.  If the current 
item selected has an Arrangement, you can also toggle an option to 
show the name of the Arrangement selected.  
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• Auto Advance Time -- This allows you to see a timer for go to next 
timers for presentations on either the Presentation or Announcement 
Layer


• Operator Notes -- you can see here notes left for the Operator that you 
can edit through the Presentation toolbar 


There is no Build tab in the Layout Editor as this is a single Layout that would 
not have animations of any kind, but the Shape and Text tabs in the 
Inspector work the same way they do in the main Slide Editor.


You can dynamically change your Stage Layout as you trigger Slides and 
also choose whether you wish for slides to show only on the Stage Layout 
and not to the Audience Screens through Stage Actions. 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Test Patterns

ProPresenter provides several Test Patterns to help you with your setup. For 
example, the Blend Grid will help to align your projectors, the Color Bars 
helps to make sure your outputs are showing the correct colors, and Focus 
helps to make sure your device is properly focused.


Note: All of the Test Patterns are rendered on the fly. For 
example, the Focus grid will render differently depending on the 
resolution of your output, thus allowing you to see an actual 
representation of what different font sizes will look like on 
that display.

Open Test Patterns by going to the menubar and selecting View > Test 
Patterns. Close the window by clicking the X in the upper corner. Show the 
current Test Pattern to the audience screen(s) by clicking the Show button in 
the lower right. Clear the current Test Pattern by clicking the Clear button in 
the lower left.


Below are the available Test Patterns and their options:


• Blend Grid


◦ Center Circle


◦ Center Lines


◦ Grid and how large each subdivision in the grid is


◦ Invert Colors


• Color Bars


• Focus


• Gray Scale


• Black Color


◦ Black Level, where 0 = Black and 50 = Gray


• White Color


◦ White Level, where 100 = White and 50 = Gray


• Custom Color


◦ Custom Color, a color chooser where you can choose any solid 
color
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Example Configurations

Note: In these examples, assume that all devices are plugged 
directly into the computer as an output that the operating system 
can see as an external monitor.


Let's say that you want to output ProPresenter to one projector that the 
audience sees, one TV being used as a "confidence monitor," and two TVs in 
the foyer. This would be:


• One Screen for what the audience sees, going to one Output (the 
projector)


• One Screen for the confidence monitor, going to one Output (the TV)


• One Screen for the announcements, going to two Outputs (each TV, set 
to Mirrored)


To expand: Because the announcement TVs will be showing the same thing 
you will only need one Screen for the announcements, but that one Screen 
would have Mirrored Outputs turned on allowing you to set up multiple 
Outputs, one for each physical device that is plugged into the computer.


You are asked to add another projector for the audience which will be 
showing the exact same thing as the other projector. Because the new 
projector is a copy of the old projector, simply turn on Mirrored Outputs for 
the Audience Screen to send it to two outputs. You now have:


• Projectors: One Screen, two Outputs, Mirrored


• Confidence Monitor: One Screen, one Output


• Announcements: One Screen, two Outputs, Mirrored


Advanced Examples

In some of these examples we will now be exploring digital 
Outputs, such as SDI and NDI. These are handled the same way as 
physical Outputs, they are simply routed as needed by 
ProPresenter.
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You are now asked to have ProPresenter send a signal out via NDI to your 
streaming software, but instead of being an exact copy of the projectors, you 
are asked to send the text as lower thirds and without the background. Your 
list would now look like this:


• Projectors: One Screen, two Outputs, Mirrored


• Streaming: One Screen, one Output


• Confidence Monitor: One Screen, one Output


• Announcements: One Screen, two Outputs, Mirrored


You have a special service coming up and you are asked to merge the two 
projectors into one large double-wide image using Edge Blending. To do this 
you would still have the same number of Screens and Outputs, but instead of 
using the Mirrored Outputs option you would choose Edge Blend under 
Arrangements; this would have ProPresenter render the double-wide image 
with the appropriate edge blend, and send it to your two Outputs as needed.


• Projectors: One Screen, two Outputs, Edge Blended


• Streaming: One Screen, one Output


• Confidence Monitor: One Screen, one Output


• Announcements: One Screen, two Outputs, Mirrored
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Working with Slides

Every presentation in ProPresenter consists of at least one slide, even if it’s 
just a single media action. Each slide can tell you a lot about what is going to 
happen when you click on the slide, including the type of media action, 
whether there are any other Actions that will happen if you click on the Slide, 
if it is a part of a Group or has a Label, etc.


Slide Editor

The most comprehensive way to edit presentations is to use the Slide Editor. 
The Slide Editor provides the ability to make changes to the objects on your 
slides, the slides themselves, and even the Presentation as a whole.


To open the Slide Editor, click the Edit button in the toolbar, right-click on a 
slide and choose "Edit Slide," press Control-E on a Mac or a PC, or in the 
menubar select View > Editor.


Note: This section covers the Slide Editor, which is the most 
commonly used Editor, however there are several other Editors 
inside of ProPresenter that you may come across, such as the Mask 
Editor, the Props Editor, and the Theme Editor. All Editors are 
very similar, however each one has some unique characteristics 
that make them slightly different. Those differences will be 
covered in the respective sections for the feature.
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Overview


1. In the center of the Editor is the Canvas; this is where you can see and 
edit your currently selected slide.


2. To the left of the Canvas is the Slide Navigator where you can select 
the slides you want to see in the Canvas.


3. Below the Slide Navigator is the Object List which lists all of 
the objects on the currently selected Slide.


4. Below the Canvas is the Slide Notes area where you can add notes to 
the slide (useful for showing presenter notes on the Stage Display).


5. To the right of the Canvas is the Inspector; this is where you will make 
changes to the currently selected object, slide, or Presentation.


6. If you want to quickly send what you are working on to the audience 
screen, click on the Show button at the bottom right of the Editor.
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Slide Canvas

The central area of the Editor is the Canvas where you will see 
representations of the objects and text that is on the currently selected slide. 
The Canvas uses an (X, Y) coordinate system, allowing you to align objects 
with pixel precision.


Note: The top left of the slide is represented by the coordinates 
(0,0). The bottom right of the slide is represented by the 
coordinates (W,H) where W is the width of the slide and H is the 
height of the slide, both of which are set in the Presentation 
Tab of Slide Properties.  In the lower left of the Editor you 
will see the current position of your cursor as well as the Width 
and Height of the currently selected object.


Adjusting the Canvas

The Canvas contains several tools to customize how it looks and feels; these 
buttons are in the lower right of the Editor.


Checkerboard Background

By default the Editor will show a grey background on the slide that you are 
working on. If you have set a Presentation Background Color or Slide 
Background Color, this color will show in the Editor on the Slide. If you would 
prefer to see a checkerboard texture instead of a solid color, click 
the Checkerboard Background button to do so. Click the button again to 
turn it off.


Guidelines

Guidelines are lines to which you can "snap" 
objects to, allowing for easily lining objects to 
other objects or to the center of the slide, as 
examples. There are three types of Guidelines: 
Slide Guidelines, Template Guidelines, and 
Alignment Guides.


Note: To create Slide and Template 
Guidelines, first make sure that the 
Rulers feature is enabled.


• Slide Guidelines are guidelines that are unique per slide. That is, you 
can set up as many Slide Guidelines on a given slide as you would like, 
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and each slide can have its own set of Slide Guidelines. To turn on Slide 
Guidelines, click on the Guidelines button on the lower right of the 
Canvas and enable Show Slide Guides, or on Mac, option-click the 
Guidelines button to turn it blue. To create a vertical Guideline, hover 
your mouse over the Ruler on the left side of the Canvas then click and 
drag onto the Canvas; release the mouse where you want your 
Guideline to be placed. Horizontal Guidelines can be created by clicking 
and dragging from the Ruler on the top of the Canvas. To remove a 
Guideline, click and drag it up (for horizontal Guidelines) or to the left 
(for vertical Guidelines) and release the mouse when the X icon 
appears. You can also right click on the Guideline and choose the 
option for Delete Guideline. Change the color of your Slide Guidelines 
by clicking the Guidelines button and clicking the color chooser next 
to Slide Guidelines.


• Template Guidelines are very similar to Slide Guidelines, however 
instead of being unique to a specific slide, they are applied when you 
apply a Template to a slide, To use Template Guidelines, first go into the 
Template Editor and create one or more Slide Guidelines on that 
Template. Then, apply that Template to a slide; when you edit that slide 
it will contain the Guidelines that were contained within that Template. 
To turn on Template Guidelines, click on the Guidelines button on the 
lower right of the Canvas and enable Show Template Guides, or on 
Mac, option-click the Guidelines button to turn it blue. Change the color 
of your Template Guidelines by clicking the Guidelines button and 
clicking the color chooser next to Template Guidelines.


• Alignment Guides will have objects snap to other objects that are in 
the Canvas. For example, with Alignment Guides you can snap an 
object to the side of another object, or even have it snap to the same 
spacing as other objects. There are several options that you can enable 
under Alignment Guides:


◦ Show Relative Spacing: Enables snapping to similarly spaced 
objects


◦ Show Relative Sizing: Enables snapping to similarly sized objects


◦ Show Object Center Guides: Enables snapping to the center of 
other objects


◦ Show Object Edge Guides: Enables snapping to the edges of 
other objects Change the color of your Alignment Guides by 
clicking the Guidelines button and clicking the color chooser next 
to Alignment Guides.
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Grid

You can add a grid of lines to the Editor to help align your objects; click on 
the Grid button in the lower right of the Editor to access this feature.


To toggle the grid on or off, click the checkbox next 
to Enable, or on Mac, Option-click on the Grid button. 
Click on the Color option to select which color you would 
like to use for your Grid. You can adjust the spacing of the 
Grid by setting the Spacing (the space between the 
major lines) and Subdivisions (minor lines that appear 
between the major lines). Click outside of the Grid 
window to close the window.


Rulers

The Editor includes a set of Rulers that will show on the top and left edges of 
the screen to better help you see the positioning of the objects in the Editor. 
You can enable and disable the Rulers by clicking on the Rulers button in the 
lower right of the Editor or by selecting the Editor menu and choosing Show 
Rulers.


Zoom

To adjust the zoom level of the Editor select the Zoom button in the lower 
right. You can select a predefined value or you can select Custom… to enter 
your own value. To have ProPresenter zoom so that you can see the entire 
slide, select Fit, or on Mac, Option-click on the Zoom button. Click outside of 
the Zoom window to close it.


Slide Navigator

To the left of the Canvas is the Slide Navigator. From 
here you can select which slide is currently being edited 
in the Canvas.


You can scroll up and down this list to see all of the 
slides in the currently selected Presentation. Click on a 
slide to select it and show it in the Canvas.


Right clicking on a slide will allow you 
to Copy, Paste, Delete, or Duplicate a slide.  You can 
also change the Theme used for that slide or copy the 
Text Style on that slide to paste onto another slide.  
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Click the "+" button at the top right of the Slide Navigator to insert a new 
slide after the currently selected slide. If you have your slides grouped using 
the Groups feature you can click the triangle next to the name of the Group 
to hide or show the slides in that Group.


Slide Objects

ProPresenter has a wide range of Objects that you can insert onto your 
slides, from simple text boxes to complex shapes and even custom shapes 
that you can draw yourself. There are several attributes to objects; these 
attributes allow for powerful control over what you show on the screen, 
however without a proper understanding they can cause some confusion.


An Object is any item inside of the Canvas of the Editor. Objects are very 
versatile inherently and may be of many shapes and content.


All Objects have a Shape. This Shape can be one of many pre-defined 
shapes (such as a square, circle, or triangle) or a custom shape that you 
create yourself. There is no limit to an object's shape.


For each individual object you can decide if (and with what) you want 
to Fill the object's shape with. You can fill the shape with a solid color, a 
gradient, media such as a still image or a video, or one of several other 
options. In addition to the fill there are other properties that are linked to an 
object's shape (such as Stroke and Shadow) which will be covered later.


All objects are also inherently textboxes. That is, no matter the type of object 
you originally started out as, you can add text to it. You can activate the 
textbox of any object by double clicking on the object.


Note: the text of an object is NOT affected by the object's 
shape. Text will not stay within the bounds of an object's shape; 
instead the text will stay within the bounds of the object 
itself. To put it another way, textboxes are always rectangular, 
even if the object has a different Shape.


ProPresenter also has a Linking system which allows you to link Fill content 
as well as Text to other objects and other information within ProPresenter. 
Something that can be linked to is called a Token. For example, you can set 
the text of an object to be linked to the token of a countdown timer; if you 
were to do that, then whenever that object is shown the text would be 
replaced by the current value of that timer.


Insert an Object by clicking on the + in the upper left corner of the Canvas.  
From this menu you can insert the type of object that you would like:
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• Text


• Shape


◦ Rectangle


◦ Rounded Rectangle


◦ Elipse


◦ Triangle


◦ Right Triangle


◦ Rhombus


◦ Polygon


◦ Star


◦ Custom


◦ Double Arrow


◦ Arrow


• Media


• Video Input


• Web


Some of the shapes feature controls to customize the shape. For example, 
creating a Star allows you to control how many points are on the star, as well 
as the angle of depth for each of the points.


Interacting with Objects

There are several ways you can interact with objects in the Editor. Here are a 
few quick tips to get more out of ProPresenter:


• Click and drag an object to position it where you want it to be


• Hold the Option key on Mac or Control key on Windows when you click 
and drag an object to copy (duplicate) that object


• Click and drag the edge of an object (also called its "bounding box") to 
resize the object
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• Hold the Command key on Mac or Alt key on Windows and hover your 
mouse near a bounding box to turn the cursor into a Rotate cursor


• Hold down the Shift key while dragging a bounding box to lock the 
aspect ratio


• Hold down the Option key on Mac or Control key on Windows while 
dragging a bounding box to scale from the center of the object instead 
of the far corner of the object


To Align multiple objects, select multiple items, then, from the menubar, 
select Editor, choose Arrangement, and then Align Objects; from here you 
can align your items horizontally or vertically. Similarly you can select 
multiple items and select Distribute from the Editor menu to distribute your 
items horizontally, vertically, or evenly.


Object List

To the bottom left of the Canvas is the Object List which allows you to see 
and interact with all of the objects on the currently selected slide.


Objects that are higher on the list will appear on top of (will cover up) objects 
that are lower on the list. Click and drag an object in the Object List to 
reorder the list, allowing you to move something higher or lower in the list.


Hover your mouse over an object and click the Lock icon to lock or unlock 
that object. Locking an object locks it into place on the slide and you cannot 
edit any of its attributes until you unlock it again. Clicking on the Visible icon 
will hide or show the object on the Editor Canvas. Note that the object will 
show on your Screen when you Show the Slide.


Right click on an object to Rename, Hide/Unhide, Lock/Unlock, 
or Delete the object. If you have a touchpad device then you can two-finger-
drag to the left of an object to delete it.


Slide Notes

The Slide Notes section of the Editor allows you to create notes on each Slide. 
These Notes can be used for your own reference or you can show them on 
the Stage Display to help the presenter remember their talking points, as an 
example.


To toggle the Slide Notes area click the Slide Notes button on the bottom 
right of the Editor. You can change the Background Color of the Slide Notes 
area; click the color box to select one of the pre-defined colors or click the 
color wheel to select your own color.
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Note: The Background Color feature is a setting that is shared 
across all slides and all Presentations. That is to say if you 
change the Background Color in one Presentation then it will 
change it for all slides in all Presentations; you cannot 
customize this setting per slide or per Presentation.




You can type your text into 
the textbox in the center of 
the Slide Notes area. This 
textbox supports rich text 
formatting, meaning 
selected text can be bold, 
italicizes, different fonts, 
sizes, and even colors. Use 
the Inspector on the right of 
the Editor to make changes 
to the formatting of the 
text. Click on the gear icon 
for more features, such as 
paragraph settings and 
margins.


Tip: Sometimes you want to paste text into a textbox but you 
don't want to keep the formatting that was previously in the 
text, you want to match the formatting that was already in the 
textbox. To do this you can use the **Paste and Match Style** 
feature: press Command-Option-Shift-V on a Mac, Alt-V on a PC, or 
select Paste and Match Style from the Edit menu.


Slide Inspector

The right side of the Editor features the Inspector which offers you the most 
in-depth options for objects on your slides as well as the slide itself and even 
the Presentation as a whole.


Note: there are several variants of the Editor window in 
ProPresenter that cover unique features, for example the Slide 
Editor, the Template Editor, and the Props Editor (just to name a 
few). Each of these Editors are largely the same, however there 
are some features that are unique based on which Editor you are 
in. The following covers the Slide Editor as it is the most often 
used Editor; areas that are unique to each Editor will be covered 
in the sections that cover the overarching feature.
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The Inspector is context-aware, so which options are shown at any given 
time is dependent on what is (or is not) selected in the Canvas. There are 
three groups of Tabs that the Inspector can show in the main Slide Editor: 
The Slide Properties Tabs, the Object Properties Tabs, and the Slide Notes 
Tab.


Slide Properties Tabs

If you do not have any objects selected in the Canvas, then the Slide 
Properties Tabs will show in the Inspector. These Tabs are the Presentation 
Tab (to control information for the entire Presentation), the Slide Tab (to 
control information about the currently selected slide), and the Build Tab (to 
control the Build-Ins and Build-Outs on the currently selected slide).


Presentation Tab

The Presentation Tab allows you to access information 
about the currently selected Presentation.


Toggle a Background color for the entire Presentation by 
clicking the checkbox next to Background. Click the color box 
to select a pre-defined color, or click the color wheel to select 
any color.


The Size option allows you to change the resolution of your 
Presentation. (Note that all slides in your Presentation share 
the same resolution.) Click the dropdown menu next to Size 
to choose a resolution for your Presentation. 


Tip: Generally speaking you want your slides to be 
the same size as your primary output, however there 
are cases where a different setting may be needed. 


If the size selected for this 
Presentation does not match the 
output size for any of your outputs 
then an alert will appear; click 
the Resize button to choose a 
screen to match your Presentation's resolution to.


The Transition feature allows you to set, change, and remove the transition 
for this Presentation. The Copyright section allows you to set, change, and 
show the copyright information for this Presentation.


Page  of 57 193



Tip: If you would like for the copyright information to show, not 
only does the Presentation have to have Display Copyright 
checked, you must also have Enable Copyright display checked in 
the General Tab of Preferences.


Slide Tab

To change information about an individual slide that 
you've selected, go to the Slide Tab in the Inspector.


Click the checkbox next to Enabled to enable or 
disable the slide. Change the Hot Key for the slide by 
clicking in the textbox and typing a letter. 
The Label section allows you to change the Label for 
the slide. Once you select or enter a Label, you can 
choose a color for that Label and have the option to 
Save to global labels which allows you to add that 
Label in the future from the list shown in Preferences.  
Toggle a Background color for the slide by clicking the 
checkbox next to Background. Click the color box to 
select a pre-defined color, or click the color wheel to 
select any color. You can also add, change, or remove 
a slide's Chord Chart. The Chord Chart feature allows 
you to add a PDF into the slide that will trigger to a 
Stage Screen if you've added a linked item to a Chord 
Chart on your layout.


This tab also offers an option to add media actions or 
Video Input actions to a slide.  Here, you can select 
what media file or video input you wish to use, 
whether it’s used as a Background, Foreground or will 
go on the Video Input layer and you can choose the option to Always 
Retrigger.  Enabling this option means that each time a slide with this input 
or media file is triggered, it will restart at the “beginning” of the time.  For a 
video input, this will just mean loading the file once more.  For a more 
cohesive look, this would traditionally be unchecked, but some users would 
like media files to start over anytime certain slides are triggered and for that 
instance, this would be enabled.  
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Build Tab

The Build Tab in the Inspector allows you to set an individual transition for 
the Slide you have selected. There are a lot more options in this tab used 
once you have an Object selected.  Here, you would just have the options of 
whatever transition you choose for the slide to appear on your screens.   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Object Properties Tabs

When an object is selected in the Canvas the Tabs on the right change to 
the Object Properties Tabs. These include the Shape Tab (controls the 
overall shape as well as any fill content for the object), the Text Tab (controls 
the text that is within the object), and the Build Tab (for controlling Build-Ins 
and Build-Outs on the slide).


Tip: Many of the numerical input boxes in the Object Properties 
Tabs allow for simple math to be performed directly in the 
textbox! For example, if you type "100+100" into the width box 
and press Enter then it performs the calculation and will use/
show 200 as your final width!


Tip: For some numerical input boxes you can click and drag on the 
label for the box and drag to the left or right to change the 
value in the textbox. For example, you can click on the text 
"Width" and drag to the left to make the object more narrow. Want 
even more control? Hold Shift while dragging to make bigger 
changes and hold Option on Mac, Alt on Windows, while dragging to 
make smaller changes.


Shape Tab

The Shape Tab offers a lot of great ways of controlling the object itself and 
what the object looks like.


Alignment and Distribution

Across the top of the Shape Tab there is a 
series of Alignment and Distribution buttons. 
If you only have one object selected in the 
Canvas then the first three buttons will 
horizontally align that object to the slide (left 
side of slide, center of slide, and right side of 
slide) and the next group of buttons will align 
the object vertically to the slide (top, middle, and bottom of slide). When only 
one object is selected the third group of buttons is not available for use.


When two or more objects are selected the Alignment buttons will align the 
objects to themselves (instead of the slide). For example, selecting two 
objects then clicking on the leftmost button (Align Left) will align the left side 
of both objects to the leftmost of the objects. That is, it will make their left 
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sides line up. All of the Align buttons work this way (left, center, right, and top, 
middle, and bottom).


The three Distribute buttons only activate when you have three or more 
objects selected in the Canvas. These buttons will evenly distribute the 
objects amongst themselves. For example, if you have three textboxes and 
you want them to each be the same distance apart from left to right, you 
could move the textboxes into their approximate locations, select all three 
textboxes, then click the Distribute Horizontally button and they would each 
be distributed evenly along the horizontal plane.


Position, Size, Transform, and Opacity

Below the Align and Distribute buttons you can control 
the Position and Size of the object. Enter a number into one of the textboxes 
and press Enter or Tab to apply the change, or click the up and down arrows 
to nudge the number in the appropriate direction.


Between the Width and Height textboxes there is a lock icon. Click this icon 
to toggle the Lock Aspect Ratio feature. With this feature enabled the 
aspect ratio of the object will always stay the same.


You can also Transform the object; click the Flip Horizontal and/or Flip 
Vertical buttons to flip the object. Rotate the object by clicking and 
dragging on the rotation dial, typing an angle into the textbox and pressing 
Return or Tab, or by using the arrows next to the textbox.


You can change the opacity of the object by clicking and dragging on 
the Opacity slider, typing a number into the textbox and pressing Return or 
Tab, or by using the arrows next to the textbox.


Fill


In the Fill section you can choose what (if any) fill the currently selected 
object has. There are many options for filling the shape of an object, 
including a solid color, a gradient, a still image, or a video. You can also fill 
the shape with an active Webpage or Video Input from a camera or another 
input source.  There are a few options here as well that allow you to use 
elements traditionally reserved for Stage layouts.  These include Screen 
Previews and images, Capture status, Group and Label colors, and chord 
charts.  


One other option is to link to another object on 
the Slide. If you choose this option, the menu will 
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show you all other Objects on your Slide and you can choose to link to the fill 
attributes of that Object. This is especially helpful if you are using a Gradient 
or specific color pattern and want to get the same specific formatting 
settings to two or more separate Objects.


Tip: Fill can also be limited by the Lines Only option in the 
Text Tab; if your object isn't filling correctly you might make 
sure that the Lines Only option in the Text Tab is unchecked.


Stroke, Shadow, and Feathering

The Stroke option allows you to add an outline to the shape of an object. You 
can choose if you want the stroke to be a solid line or one of several dashed 
lines. You can also choose the width and the color of the stroke.


The Shadow provides the option of adding a 
shadow to the shape of an object. Properties include 
Blur, Opacity, color, Angle, and Offset.


Note: The Shadow only applies to the shape 
property of an object and it respects both 
the Fill and Stroke options selected. This 
means that if both the Fill and the Stroke 
options are disabled, there will be no 
Shadow. To add a shadow to text go to the 
Text Tab of the Inspector.


The Feathering option allows you to feather (soften) 
the shape of an object. The higher the number, the softer the shape will be.


Visibility

ProPresenter allows the user to show or hide objects based on several 
variables. For example, you can have an object be hidden while a timer is 

counting down, but once the timer hits zero the 
object shows. Or you may want an object to 
show only if another object's textbox doesn't 
have any text in it.


If you would like the object to show only under 
certain circumstances then you can enable 
the Visibility feature. Select if you want the 
object to show when "All...," "Any...," or "None of 
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the following conditions are met".


Below that you can add as many conditions as you would like. You can select 
another object on the slide and have the current object only visible if there is 
or isn't text inside of that other object. The other option is to select a Timer 
and choose to show the current object if that timer has time remaining, has 
expired, is running, or is not running.


Text Tab

The Text Tab of the Object Properties Inspector gives you full control over the 
text that is inside of an object.


Font and Paragraph

The first section offers control over the font styling of the text.


Use this area to change formatting such as the Font, Font Style, Font Size, 
and other styling effects. The Copy Style and Paste Style buttons allow you 
to take the formatting from one slide and paste it to another slide that may 
have different text on it. To do this, simply click Copy Style on the slide that 
you wish to use the formatting for, go to the other slide and then click 
on Paste Style to apply that text formatting to the second slide.  Once you 
have copied a Text Style, you can also go to the Editor object in the menu bar 
and choose Text>Apply Text Style to All Slides if you wish to have the 
formatting used there apply to all slides in the presentation.  There are 
individual buttons for Bold, Italic, Underline and Strikethrough.  


There is also a gear menu which allows further 
formatting like those listed below.


•Custom Underline Color — if the text you 
select is underlined, you can then set a custom 
underline color that is not linked to your font 
color or any other color


•Text Background — here, you can set a 
colored background to highlight any portion of 
your text on a slide


•Baseline -- this allows you to have both 
SuperScript and Subscript characters


•Line Height
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• Line Spacing 

• Paragraph Spacing 

• Margins 

Many of these formatting options for the font can also be adjusted in the 
Editor>Text menu in the menubar at the top of the program.


Below the gear, there is an option to adjust Capitalization.  There are four 
different options here.  


• None -- the text will show as you’ve entered, no changes are made


• All Caps -- all text is capitalized 


• Title Case -- the first letter of each word is capitalized, except for 
prepositions, articles and conjunctions


• Start Case -- the first letter of every word is capitalized 


Text Color allows you to set the color of your text.  The dropdown here also 
allows you to select Gradient Fill.  Gradient Text allows you to set two colors 
to create a blend in your text.  In creating this, you can set the two colors you 
wish to use, the angle at which they blend and choose to use either the 
object or text bounds for the gradient.  Depending on the position and size of 
your text object versus the amount of text you have, this option may need to 
be enabled or disabled for the best look.  
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The next item is Text Scaling which allows you to dynamically scale the 
object based on the text in it or dynamically scale the text based on the 
object it’s in. Here you can choose from one of four scaling options.


•Fit Container to Text -- this 
option will size the object 
larger or smaller to fit to the 
amount of the text being 
inputted


•Scale Text Up to Fit 
Container -- this will make the 
text larger so it’s able to cleanly 

fit inside of the Object box


• Scale Text Down to Fit Container -- this will make the text smaller so 
it’s able to cleanly fit inside of the Object box


• Scale Text Up or Down to Fit Container -- this will make the text do 
whatever it needs to do to best fit inside of the Object box


Below the Font section you can control the paragraph formatting, such as if 
the text is justified to the Left, Center, Right, or Left Justified, and if the text is 
centered on the Top, Middle, or Bottom of the textbox.


Stroke and Shadow

If you would like to add a Stroke and/or a 
Shadow to the text then you can do so by 
checking the appropriate check box.


The Stroke (an outline around the text) allows 
you to control the Width and the Color of the 
line.


The Shadow option gives you the option to set 
the Blur, Opacity, Color, Angle, and Offset of the 
shadow.


Note: The Stroke and Shadow options in the Text Tab will only 
affect the text. If you would like to add a stroke and/or a 
shadow to the shape of the object then you can do that from the 
Shape Tab.


Page  of 65 193



Lines Only


The Lines Only option allows you to limit the object's Fill to only show in lines 
behind the text. This can create a masking effect on the shape behind the 
text, bringing focus to the text itself.


There are three options available for how this works.  


• Full Width:  This option places the object’s fill across the full width of 
the text object for whatever amount of lines are in the text


• Line Width:  This option only puts the fill behind the text itself and once 
the text is done on a line, the fill does not continue.  


• Max Line Width:  This option places the fill at the position where the 
text is the longest in the object.  


Each of the options here allow you to set padding and alignment to the Fill 
color.  


List

The List feature allows you to enable bulleted and numbered lists inside of 
textboxes. Toggle this feature by clicking on the checkbox next to List.


Note: This feature can be applied to all lines of text in a 
textbox by simply having the object selected, or you can apply it 
to individual lines of text by selecting text inside of the 
textbox. You can mix and match different List formats inside of 
one textbox, but each line can only have one set of formatting 
applied to it.


• Style: Click on the first dropdown to select which shape or numbering 
style you would like to use for your list.
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• Size: The Size option allows you to control how large the shape or 
number is.


• Color: Click the color box to select one of several predefined colors, or 
click the color wheel to select a custom color.


• Indent Bullet: Controls how indented the bullet shape/number is.


• Indent Text: Controls how indented the text to the right of the bullet is.


Linked Text

The Linked Text feature allows you to link the textbox to other sources within 
ProPresenter, such as Timers, the System Clock, and other textboxes on this 
same slide. This can help create a more dynamic slide as well as create 
unique effects for some stage layouts.


For example, let's say you have a very wide output screen and want the 
same text to appear multiple times on the same output. Instead of copying 
and pasting the same text onto each slide multiple times, you could create 
one textbox, enter the text into that textbox, then create several textboxes 
that are linked to the original textbox. Joining this feature with the Themes 
feature of ProPresenter can create unique outputs with minimal work.


You can toggle this feature by checking the checkbox next to Linked Text.


Page  of 67 193



Below are the Linked Text options that are available in the Slide Editor. Other 
Editors may have more or less options; see those respective sections for more 
information.


Slide Object: This option allows you to dynamically show the text that is in 
one object inside of another object. With the mouse hovered over this option 
it will list all of the objects on the current slide (with the currently selected 
object grayed out as it cannot be selected). Select the object that you would 
like to link the text from and any text that is in that object will also be 
displayed in this object. There is also a Transform box that will appear below 
that allows you four options to transform the linked text dynamically on the 
Slide for more advanced integrations.


• No Transform: This will leave your linked text with the same look as 
your original text only changing any formatting altered in the Text tab 
for the Object.


• Remove Line Returns: Check this box if you would like to remove all of 
the carriage returns in the linked text.


• One Word Per Line: This will transform the linked text to have a 
carriage return after every word in the text.


• One Character Per Line: This will transform the linked text to have a 
carriage return after every character in the text.


Timers: Any timers that you have set up in the Timers window can be 
selected to be shown in the currently selected textbox.


• Format: Under Format you can choose how the timer will be shown on 
the screen. There are options for hours, minutes, seconds, and 
milliseconds. For each of these options you have up to five choices; 
however depending on what you have selected in one section might 
disable options in another section. Here are the five options, using 
hours as an example:


◦ h: Always show the hours but hide leading zeros


◦ hh: Always show the hours and show leading zeros


◦ h: If there are hours then it shows them with no leading zeros; if 
there are no hours then it doesn't show them


◦ hh: If there are hours then it shows them with leading zeros; if 
there are no hours then it doesn't show them
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◦ - -: Hide the hours text; if there would be hours to show it adds 
that time to the minutes Below the formatting options there is a 
textbox which serves two purposes: It allows you to see a preview 
of what your timer will look, and it allows you to type extra text 
which will appear on the screen. For example, you could add the 
text "The service will start in " before the timer token and that text 
will show on the screen appropriately.


• Color Triggers: This area allows you to dynamically change the color of 
the timer depending on what time is currently showing on the timer.


◦ Click the + to add additional color triggers


◦ Click the ˅ to Save as Default the current set of Color Triggers 
(allowing them to be restored in another object) or to Restore 
from Default, replacing the current Color Triggers with ones that 
had been saved before.


◦ Once you have added one or more Color Triggers you can edit the 
time at which point they will trigger and change the color to 
which the timer will change to.


System Clock: The System Clock can be shown as linked text.


• Click the ˅ next to Format to Save as Default the current set Format 
options (allowing them to be restored in another object) or to Restore 
from Default, replacing the current Format options with ones that had 
been saved before.


• Date and Time: Select how you would like the Date and/or Time to be 
shown on the screen.


• 24 Hour: Click the checkbox to toggle showing the time as a 12 hour or 
24 hour clock.


• Below the formatting options there is a textbox which serves two 
purposes:


◦ It allows you to see a preview of what your clock will look, and


◦ It allows you to type extra text which will appear on the screen. 
For example, you could add the text "The current time is " before 
the clock token and that text will show on the screen 
appropriately.
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Video Countdown: Shows the time left of a video that is currently playing in 
the Media layer of ProPresenter (such as a Foreground or 
Background). Formatting options are the same as Timers above.


Build Tab

The Build Tab in the Inspector allows you to "Build In" and "Build Out" objects 
onto the screen. Think of this as animating objects onto and off of the screen.


You can have any and all objects on a slide build in as well as 
build out; however you can only have one build in and one build 
out per object, and the build in must be before the build out.


Builds

Build Ins and Build Outs are great ways to animate text onto and off of the 
screen. If you have a slide with Build Ins, Build Outs, and/or you have the 
Delivery mode set, when you are in the Slide View you will see empty circles 
across the bottom of the slide; each circle represents additional animations 
that you can perform on that slide.


To fire Build Ins, Build Outs, and Delivery modes, first fire the slide as normal, 
either by clicking on it or by using the space bar or right arrow key. After the 
first time you fire the slide and you are ready to show the next step in the 
animation sequence, fire the slide again by any of the above methods 
(clicking on the slide, spacebar, or right arrow key); each time you fire the 
slide after the first the next circle will fill in, showing your process through the 
animation sequence.


At the end of the animation sequence you can manually click on the next 
slide, or press the spacebar or right arrow key to fire the next slide. If you are 
in the middle of the animation sequence and want to go to the next slide 
without finishing the sequence, click on the next slide.


Note: Once you start the animation sequence, there is no way to 
go backwards in the animation sequence; if you want to start the 
animation sequence again you would need to clear the slide and 
click on that slide again to start from the beginning.




Build In and Build Out

To add a Build In or Build Out to an object, first select that object in the 
Canvas, then, at the top of the Build tab, select Add Build next to either Build 
In or Build Out to choose which Transition you would like the Object to follow.    
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Click the trash can in the upper right to remove a selected Build Transition 
and set it back to None.  


Delivery

Once you select a Transition, you will have an option to set the Delivery of 
that object.  This feature of ProPresenter allows you to add additional levels 
of control about how the text will appear on the screen. There are three 
Delivery modes:


• All at Once:  This mode brings in the entire object at one time and is 
the default option.  Most of your objects will use this selection unless 
you are using a List or Fill In the Blank option in a Text Object.  


• By Bullet: This mode will animate each line of text separated by a 
carriage return separately; while having bullet points in your text is not 
required, this is a great way of showing multiple lines of text one line at 
a time


• Underline: This mode will first show all of the text in the text box with 
the exception of text with underlines; as you click through the slide the 
text that is underlined will animate onto the slide, giving a "fill in the 
blank" look


Build Order
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The Build Order area of the Build Tab offers a visual representation of all of 
the Build Ins and Build Outs that you have set up on the currently selected 
slide. Each Build In and Build Out will have a separate row associated with it; 
this row will show the name of the object as well as the Transition that you 
have set for that build.


The first build in the list happens first in the animation sequence, and each 
subsequent build below it happens in that order.


To reorder builds in the animation sequence, click and drag a build to be 
higher or lower in the animation sequence.


Note: An object's Build Out can never happen before its Build In, 
thus it can never be higher in the sequence than the Build In for 
that object.


When you click and drag a build and hover the mouse between two other 
builds, you will see a blue line appear between those builds, showing you 
where the build will be located. If you drag, however, on top of another build, 
the blue line will appear on top of that other build, either on the top half of 
that build or on the bottom half, depending on where your mouse is. If you 
release the mouse when the blue line is on top of another build it will put it 
above or below that other build, however it will attach itself to that other 
build (represented by there not being a space between the two builds). This 
puts the lower build into a Start mode called With Build, which is covered in 
the Start and Delay section.


Start and Delay

At the bottom of the Build Tab is the Start and Delay section. This section 
controls when the selected build will start animating.


You can set the Start of the build animation to happen:


• After Transition: (only available for first build in sequence): Starts the 
animation (or delay timer) after the slide transition is finished


• On Click: Waits for the user to click (or press spacebar or the right 
arrow key) to start the animation (or delay timer)


• With Build: Starts the animation (or delay timer) whenever the 
previous build is fired; note that this ignores the delay (if any) on the 
pervious build


Page  of 72 193



• After Build: Starts the animation (or delay timer) after the previous 
build is actually animated, accounting for the delay (if any) on the 
previous build)


• With Slide:  This option will only appear if you only have one Build In on 
the slide or if you select the first object to Build In — this will allow the 
object to come onto the slide as the slide itself is transitioned to


You can Delay the time between when the animation is fired and when it is 
actually animated onto the screen. Set the Delay time by manually typing 
into the Delay text field, or by clicking on one of the arrow buttons to nudge 
the number higher or lower. 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Reflow View

The Reflow Editor makes it fast and easy to make changes to text that is on 
your slides. This is particularly helpful when, for example, you first import a 
song and you need to adjust slide breaks and Groups so that the text shows 
correctly on your screens.


To open the Reflow Editor:


• Click on Reflow in the Toolbar


• Press Control-R on Mac or Option-R on PC


• In the Menubar select View > Reflow


• Right click on a Presentation in the Library or a Playlist and 
select Reflow


In the Reflow Editor, the left side displays all of the text in your Presentation, 
and the right side shows the slides themselves. Making changes to the text 
on the left will immediately update the text inside of your slides on the right. 
Click and drag on the center divider to make one side larger or smaller.


Use the slider on the lower 
left to control how large 
the text appears in the 
Reflow Editor, and use the 
slider on the lower right to 
control how many 
columns of slides are on 
the right side.


While editing text, if you 
would like to break a slide 
into multiple slides you 
can use the Insert Slide 
Break feature. First, put 
the cursor where you 
would like the text to 
break between slides, then 
either click the Insert 
Slide Break button on the 
lower left or press Option-

Return on Mac or Control-Enter on PC. This will create a new slide and move 
any text that is below the cursor to the next slide.
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Tip: Pressing Option-Return on Mac or Control-Enter on PC to 
insert a Slide Break also works inside of the Slide Editor!


Clicking on the disclosure to the top right of each slide on the left side or right 
clicking on a slide thumbnail on the right side will bring up the same menu 
as if you right-clicked on a slide in the main Slide View Area.
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Themes

Themes allow you to quickly define a set of styles for your slides.  A Theme is 
made up of multiple template slides that can be applied to your slides.  
ProPresenter comes with a collection of Themes to help get you started and 
you can also learn to create your own to use for sermon series, events or 
other times where a certain style is helpful across all of your slides. Using and 


Applying Themes

There are a number of ways to 
select the Theme that you want 
to use, so we’ll start with 
updating an existing set of 
slides. To quickly change the 
appearance of a presentation, 
open it from the Library then 
click on the Theme 
dropdown menu in the toolbar. 
Select the Theme you’d like to 
use from this list.  When you 
mouse over any of the Themes 
you will be shown what the 
Theme Slides look like that you 
can choose from.  


Click on the Theme Slide you want to use from this list. Doing so will update 
all of the slides in your presentation. You can also select multiple 
presentations and use this method to change several presentations at once.


Selecting New Theme will prompt you to name your new Theme and then 
opens the Theme Editor. You can add as many Theme Slides as you wish 
within a Theme.


If you go to an individual Theme in the menu, there are two options at the 
bottom of the list of Theme Slides as well. These options are fairly self 
explanatory to either Edit an existing Theme which opens the Theme Editor 
or Delete Theme which removes that Theme from the program.


Right clicking on a slide and opening the Theme menu offers one other 
option. If you build a slide you'd like to save as a Theme Slide in a Theme, you 
can do this by right clicking on the Slide and going to Themes, selecting the 
Theme you wish to put this slide under and then choosing Add Selection to 
Theme
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Theme Editor

If you need to edit a Theme that has already been created or wish to create a 
new Theme, the Theme Slides are found in the Theme Editor.


Note: The Theme Editor is very similar to the Slide Editor. This 
section will only cover parts of the Editor that are unique to 
the Theme Editor. For general information about the Editor as 
well as items that are not covered here, please see the Slide 
Editor section.


Theme Editor Interface

There is no Slide Notes feature in the Theme Editor.


Theme Slide Tab

When no objects are selected on the Theme Slide in the Editor, the Inspector 
on the right side of the Editor window will show a single Theme Slide tab.





This is where you set the basic formatting of your Theme slides. This includes 
three editable options...


• Name -- Here, you can name your Theme Slide. This is the Label that 
will show in the Theme menu alongside the thumbnail of what the 
slide will look like once applied.


• Size -- This allows you to set the size of the Theme Slide itself -- typically, 
this would match the resolution of the screen the slides will be 
displayed on.
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• Background -- Here, you can toggle on whether the Theme Slide has a 
colored background on it or not. Enabling this option allows you to set a 
color using the basic or advanced Color Palette.


Object Inspector

There are no differences in the Object Inspector when an object is selected in 
the Editor between the main Slide Editor and the Theme Editor.
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Groups and Arrangements

Groups and Arrangements make it easy for you to create multiple versions of 
a single Presentation without having to save several files in your Library. This 
feature allows you to define slides as part of a stanza (Group) and then 
arrange them in whatever order you need.


By default, there is a set of 
Groups already created 
inside of the program that 
can be used and/or 
modified. You can view 
these Groups in the Label 
tab of ProPresenter 
Preferences.


To get started, right-click on 
a slide and select a Group Name. If you have 8 slides and start on the first 
slide, all 8 slides will be grouped into the selected group. If you start on slide 
five, the first four slides will remain with the generic “No Group Name” and 
the last four slides will be in your selected Group, for example “Verse 1”. This 
second scenario is shown in the image below.


You can right-click on any slide to start a new Group for the slides between 
that slide and the next Group. If slide three is selected above and named 
“Chorus," only slides 3 and 4 will be affected. Slides 1 and 2 still have “No 
Group Name”.
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Groups can be renamed by repeating the naming process and selecting a 
new name. Groups can also be split into additional groups by right-clicking 
on one of the slides and selecting a new Group. In the image below, the last 
four slides have been split up into three groups, with slide five being the only 
one that is still part of Verse 1.


You can also turn on the Arrangement feature by clicking on the third button 
in the Presentation Header. This will show each Group represented by its own 
button (“Token”).  Each of the tokens there are colored to match the color of 
the Group Label that you’ve created.  


To create a new 
Arrangement for your 
presentation, open the 
Arrangements toolbar 
and click on the 
dropdown menu on the 
left and select New 
Arrangement.... You will 
be prompted to name 
this new Arrangement.


Once you have created your new Arrangement you will need to drag the 
Groups into the order that you want to be shown in that new Arrangement. 
Click on the Tokens in the top row and drag them to the second row to 
organize your Arrangement.


If you repeat a Group in your Arrangement, any edits made to one of those 
instances will apply to the others. For example, if you have Chorus in your 
Arrangement five times and add a background to the first slide of the 
Chorus, it will be added to the other instances of Chorus. This also applies to 
any changes made to the text on a slide. These changes are also reflected in 

Page  of 80 193



other Arrangements that 
use the same Group. 


The properties of an 
Arrangement are not 
unique to that specific 
Arrangement.


Due to how 
Arrangements are stored 
within the song file, you 
can actually have the 
same presentation in 
your playlist multiple 
times with a different 
active Arrangement 
selected for each 
instance of the 

presentation. To change 
the Arrangement, right-click on the Presentation in the Playlist and select 
the Arrangement from the Arrangement> menu. You’ll see the 
Arrangement name in [brackets] at the top of the presentation when you 
open as you can see in the image above, as well as, in the Library and 
Playlist. The selected Arrangement is stored as part of the Playlist data, so 
exporting the Playlist will maintain the proper Arrangement when you open 
it on another computer.


When operating a presentation that has an Arrangement in it, opening the 
Arrangement dropdown in the toolbar allows you to see which Group you’re 
using at that time.  This will be indicated by a white highlight around the 
Group Name and position.   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Slide Actions

Slide Actions are one of the most powerful and versatile features of 
ProPresenter.


An Action is an event that happens inside of ProPresenter. This can be 
showing ("firing") a Background to the audience screen, or the changing of a 
Stage Display layout, or sending a Midi signal out of the computer.


ProPresenter lets you add Actions to slides so that when you click on the 
slide, the Actions attached to that slide are also triggered. These are 
called Slide Actions.


Let's say that you want a background to fire when you click on a specific 
slide, or you want a timer to start when a slide is clicked, or you want a 
Message to show on the screen when you get to a specific part of a 
Presentation. All of these are perfect examples of Slide Actions.


In fact you can have multiple Slide Actions on one slide. So you might have a 
single slide that fires a Background, changes the Stage Display Layout, 
changes the Audience Look, and sends a Midi signal to turn on the stage 
lights. That's a lot happening with one mouse click!


This section describes all available Slide Actions inside of ProPresenter, as 
well as how to add them to a slide and how to edit them.


Slide Action Basics

Slide Actions are represented by icons that appear on or near a slide's 
thumbnail so that you can quickly identify what Slide Actions are attached 
to which slides. In the main slide area of ProPresenter, if you are using Grid 
View or Easy View, the Slide Action icons appear on the top left of the slide's 
thumbnails; in Table View the icons appear to the right of the text.


Note: For some Slide Action types there can only be one of that 
type per slide, but for other types there can be multiple of the 
same Slide Action on a given slide.


How to add Actions to slides will be covered in each specific section below. To 
edit (change the properties) of a Slide Action, right-click on that slide and:


• If there is only one editable Slide Action on that slide, choose Edit 
Action: [Name of Action].
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• If there are multiple editable Slide Actions on that slide, hover your 
mouse over Edit Action and choose the Action from the submenu that 
you would like to edit.


To remove a Slide Action from a Slide, right-click on that slide and:


• If there is only one Slide Action on that slide, choose Remove Action: 
[Name of Action].


• If there are multiple Slide Actions on that slide, hover your mouse 
over Remove Action and choose the Action from the submenu that 
you would like to remove.


To remove all Slide Actions from a slide, right-click on that slide, hover 
over Remove Action, and choose Remove All.


Action Palette

Often times the easiest way to add an Action to a slide is via the Action 
Palette. This is one window that gives you access to many (but not all) 

Actions you can drag onto slides for easily 
adding Actions to Slides.


To open the Action Palette:


•Right-click on a slide, hover over Add 
Action, and click on Action Palette…


•Press Control-Shift-C on Mac or Alt-A on 
PC


•In the menubar select View > Action 
Palette


To add an Action to a slide from the Action 
Palette, simply click and drag the Action 
from the Palette onto a slide.


Clear Actions

Add a Clear Action to a slide to clear other areas of ProPresenter when you 
click on that slide. These Actions can be added to slides by right-clicking on a 
slide and hovering over Add Action > Add Clear Action; Actions marked with 
an * can also be added via the Action Palette.
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Clear Actions that are available:


• Clear All


• Clear Audio


• Clear Background (Clear Bkg)


• Clear Video Input 


• Clear Props


• Clear Messages


• Clear Announcement


You can have multiple Clear Actions on one slide, however you can only have 
one of each type on a given slide.


Media Actions

ProPresenter can fire media files such as a still image, a video, and audio 
from a Slide Action.


Graphic Action

Adding a graphic (that is, a still image or a video) to a slide will fire that slide 
to the Foreground or Background layer of ProPresenter, depending on how 
that Action is set up:


• Foreground Graphic


• Background Graphic


You can add a graphic to a slide one of several ways:


• Right click on a slide and choose Add Media Action…, then browse to 
the graphic file on your computer


• Drag the Graphic icon from the Action Palette to the slide, then browse 
to the graphic file on your computer


• Drag a graphic from the Video/Image Bin onto the slide


• Drag a graphic from the computer file manager (Finder on Mac, 
Windows Explorer on Windows) onto the slide


Once the Action has been added to the slide, if you need to change the 
behavior between Foreground and Background you can right-click on the 
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slide and under Media Action Behavior, choose which behavior you would 
like.


You can only have one graphic Action on a slide at a time.


Media Bin Playlist Action

This action, added in ProPresenter 7.3 and above, allows you to trigger a full 
Playlist in your Media Bin from a single slide.  This is especially useful for 
playback of scrolling slides before an event from a Smart Playlist. 


You can add the Media Bin Playlist to a slide through a few options:


• Drag the Media Bin Playlist icon from the Action Palette to the slide, 
then select your Media Bin Playlist you wish to use from the dropdown 
menu that appears below the slide thumbnail


• Drag the Playlist icon from the Media Bin onto the slide


Audio Action

To fire audio on a slide you can add an Audio Action to that slide. Audio 
tracks have two types:


• Audio Track


• Sound Effect


See the Audio Bin section for more information on the two Audio types.


You can add audio to a slide one of several ways:


• Right click on a slide and choose Add Media Action…, then browse to 
the audio file on your computer


• Drag the Audio icon from the Action Palette to the slide, then browse to 
the audio file on your computer


• Drag audio from the Audio Bin onto the slide


• Drag audio from your operating system onto the slide


You can only have one Audio Track on any given slide, however you can have 
multiple Sound Effects on slides.


Note: Once an audio file has been added to a slide as an Action, 
there is no way to change the behavior between Audio Track and 
Sound Effect; you would need to add the audio to the Audio Bin, 
change the behavior, then drag the audio to the slide.
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Audio Bin Playlist Action

This action, added in ProPresenter 7.3 and above, allows you to trigger a full 
Playlist in your Audio Bin from a single slide.  This is especially useful for 
playing back a collection of audio files before an event.  


You can add the Audio Bin Playlist to a slide through a few options:


• Drag the Audio Bin Playlist icon from the Action Palette to the slide, 
then select your Audio Bin Playlist you wish to use from the dropdown 
menu that appears below the slide thumbnail


• Drag the Playlist icon from the Audio Bin onto the slide


Video Input Action

Add the Video input Action onto a slide to automatically turn on or change 
the Video Input layer of ProPresenter when that slide is clicked.


Add the Video Input Action to a slide by opening the Action Palette and 
dragging the Video Input Action onto a slide; doing so will give you the 
option to choose which Video Input you would like to assign to that slide.


Audio Input Action

In much the same way as the 
Video Input action, you can add 
an Audio Input Action onto a 
slide to automatically alter an 
Audio Input’s mode or level 
when that slide is triggered.  You 
can change what Mode the 
input is set to (Off, On, Auto Off, 
Auto On) and also set the level 
you wish the input to playback 
at.  


Add the Audio Input Action to a 
slide by opening the Action 
Palette and dragging the Audio 
Input Action onto a slide; doing so will give you the option to choose which 
Audio Input you would like to make changes to on that slide.
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Interactive Actions

This section covers the rest of the features of ProPresenter that can be 
controlled by Slide Actions.


Stage Layout Action

Use the Stage Display Layout Action to change Stage Display Layouts on the 
fly.


Add a Stage Display Action to a slide by 
right-clicking and going to Add Action > 
Stage Display Layout or opening the 
Action Palette and dragging the Stage 
Display Action onto a slide; doing so will 
give you the option to choose which Stage 
Display Layout you would like to assign to 
that slide.


You can also change your Slide 
Destination here which allows you to 
choose if you'd like to send the slide to only 
your Stage screen or to both the Stage 

and Audience screens. Selecting Stage will toggle on the Stage Only mode 
for your slides. You would need to set a second Action and set it to Stage + 
Audience to toggle this setting back off when you wish for your slides to show 
on the Audience screens again.


You can set both the Layout and Slide Destination to change with the same 
Action.


Timer Action

Adding Timer Actions to slides offers additional controls 
for starting, stopping, and restarting your Timers.


There are two ways to add a Timer Action to a slide:


• Right-click on the slide and choose Add Action > 
Timer > [Timer]


• Open the Action Palette and drag the Timer Action 
onto a slide


When adding or editing a Timer Action you will have the 
ability to configure the Action in one of several ways:
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• Select which Timer this Action is controlling


• Select if this Action will Start, Stop, or Reset the given Timer


• Toggle if you want to Set the Configuration (such as Type, Duration, and 
Overrun) of the Timer using custom parameters to this Action, or if you 
want the Timer to keep the configuration that it already had


You can have multiple Timer Actions on one slide.


Prop Action

You can quickly add Prop Actions to slides to show specific Prop(s) when you 
click on a specific slide.


Add Prop Actions to slides by opening the Action Palette and dragging the 
Prop Action onto a slide. When adding or editing a Prop Action you will be 
able to select which Prop you want to fire when that slide is clicked.


You can have multiple Prop Actions on one slide.


Audience Look Action

Use Audience Look Actions on slides to quickly change which Look you are 
using to show content to the audience screens.


Add Audience Look Actions to slides by either:


• Opening the Action Palette and dragging the Audience Look Action 
onto a slide or


• Right clicking on a slide and selecting Add Action > Add Audience Look 
Action and choosing which Audience Look you want to use


When adding or editing an Audience Look Action you will be able to select 
which Look you want to use when that slide is clicked. This will change the 
Live Look that is used until a new Look is selected either via an Action or 
through the Looks menu.


You can only have one Audience Look Action per slide.


Message Action

Add Message Actions to slides to show specific Message(s) when you click on 
a specific slide. Add Message Actions to slides by opening the Action Palette 
and dragging the Message Action onto a slide.
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When adding or editing a Message Action you will be able to select which 
Message you want to fire when that slide is clicked, as well as be able to edit 
any variables that you have set up inside of that Message.


You can have multiple Message Actions on one slide.


Communication Action

Using Communication Actions on slides helps to quickly send 
Communication signals when a slide is clicked.


Add Communication Actions to slides by either:


• Opening the Action Palette and dragging the Communication Action 
onto a slide or


• Right clicking on a slide and selecting Add Action > Add 
Communication Action


When adding or editing a Communication Action you will be able to select 
which device you are sending a signal to and what command you want that 
signal to have. 
You can have multiple Communication Actions on one slide.
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Working with Files

Importing

There are various types of files that can be imported into ProPresenter and 
options as to how those files will come into the software.


To access the Import options inside of 
the program, go to File>Import in the 
menubar and select one of the options 
from the submenu. You can also drag 
files from your computer folders into the 
Library or Media Bins in the program to 
start this process.


Import File

This option is used to import many different types of files including text files 
(.txt or .rtf), Word files (.doc or .docx), ProPresenter Presentation files (.pro6, 
or .pro) and ProPresenter Bundle/Playlist files 
(.pro6plx, .pro6x, .proBundle, .proPlaylist).


If you select a ProPresenter file to import and you have multiple Libraries, 
you will be prompted what Library you wish to put this presentation into. If 
you only have a single Library, the file will begin importing automatically.


If you select a text or Word file to import, you will see an Import window 
where you can set your parsing, presentation properties and destinations.  


Slides delimited by allows you to specific a number 
of lines or paragraphs per slide, or to use a custom 
slide break marker in the source file. Regardless of 
which delimiter you use, the number placed in 
the Delimiters per slide box determines when new 
slides are generated. If you have selected “Line 
Break” and enter “2," you will end up with two lines 
on each slide, with respect for stanza breaks. Same 
with paragraphs. If you have used a customer 
delimiter such as “//” or “*” in your file, just type that 
into the “Slides delimited by” field.
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The middle section allows you to update the Size and Template that will be 
used for the file you’re importing.


You can also set the Destination where the file will go setting both a Library 
(provided you have multiple Libraries) and Playlist. You can also choose for 
the presentation to go to a New Playlist or No Playlist. If you choose New 
Playlist you’ll be prompted to enter a name for that Playlist.


The Edit button in the lower-left corner opens the presentation in Reflow 
View. 


Import Text from Clipboard

This option uses the same import options as Import File, but allows you to 
copy text from a website or a file such as a PDF or other file type not 
supported by ProPresenter and import it into a Library.


Import PowerPoint

ProPresenter makes it possible to import PowerPoint files. However, there are 
some limitations that you will need to be aware of before you get started. It's 
important to remember that importing from a third-party like PowerPoint is 
not a simple process and we are often limited in what we are able to support 
or something may stop working unexpectedly following an update from 
Microsoft.


The biggest limitation right now is that the Windows version of ProPresenter 
7 is only able to import PowerPoint files as images. If you have used 
ProPresenter 6 on Windows or ProPresenter on Mac, you're familiar with the 
other options that are available. We hope to find a way to add these back to 
ProPresenter 7 on Windows in the future.


You will need to have a full version of PowerPoint installed in order to import 
presentations. We recommend Office 2019 or Office 365 on both Mac and 
Windows. Office 2016 may still work, but due to changing support policies 
and timelines for this version from Microsoft, it may not work reliably. 
PowerPoint Viewer may still work on Windows, but since it is no longer 
supported by Microsoft we are not recommending it or supporting it 
anymore.


Mac Importing

To get started, open ProPresenter 7, click on File in the menu bar, select 
Import, and then PowerPoint. This will open a file browser window. Navigate 
to the PowerPoint file that you want to import.
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Here you will have three import options available. To access these settings, 
click the Options button in the lower-left corner of the Finder window. After 
you have selected your option for importing, click the Import button.


These three options will control how your files are imported. The option you 
select will be used for all future imports, so unless you need to change the 
import option, you shouldn't need to click on Options for every import.


Import All Slides as JPEG Images

This will import the each slide as a single image. There is no way to edit the 
content of each slide without importing a new version of the PowerPoint file.


Each slide imported and looks like it does in PowerPoint. Hidden slides are 
not imported using this method and slides that have notes in PowerPoint 
will also have Slide Notes in ProPresenter that you can show on your Stage 
Screen.  


Import Text Objects as ProPresenter Slide Elements

This option will import all of the text, but will ignore any media. While we will 
attempt to reproduce the slide accurately, not all elements or formatting can 
be converted. This method will get you close to the original PowerPoint slide, 
but you may still need to do some additional formatting in ProPresenter.


Hidden slides are not skipped with this import method. PowerPoint slide 
notes are also imported. None of the media elements are imported, however, 
shapes are imported. Slide builds and animations are not converted, so any 
slide with builds will import as the final version of the slide.  Each text object 
can be edited directly inside of ProPresenter itself.  Currently, any non-text 
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object that is not imported gets converted to an empty text box. These will 
not show on your output, but you may want to remove them in the Editor.


Import Text and Graphic Objects as ProPresenter Slide 
Elements

This import method is the closest representation to the original PowerPoint 
file. As with the Text Objects import option, some work will still need to be 
done in ProPresenter. Slide builds and animations are not converted, so any 
slide with builds will import as the final version of the slide.


Every object on the slide is able to be selected in the Editor and the slide 
notes are also imported. Some objects don't convert properly, and they will 
be added as empty text placeholders. We will continue making 
improvements to support more elements, but there may always be some 
PowerPoint slide objects that don't have an equivalent in ProPresenter.


Windows Importing

To get started, open ProPresenter 7, click on File in the menu bar, select 
Import, and then PowerPoint. This will open a file browser window. Navigate 
to the PowerPoint file that you want to import. For Windows users, once you 
find the file, click on the Open button. This will import the each slide as a 
single image. There is no way to edit the content of each slide without 
importing a new version of the PowerPoint file.


Import SongSelect

Choosing this option loads the QuickSearch window already in the 
SongSelect tab. SongSelect is owned by Christian Copyright Licensing 
International (CCLI). If you are an active license holder of a CCLI license for 
your church or organization then you have the option of purchasing a 
subscription to SongSelect.


For more information about CCLI and SongSelect, visit www.ccli.com.


If you have access to SongSelect, ProPresenter can store the registration 
information for you and provide direct access to SongSelect through the 
program. This makes it easy to get songs from SongSelect without having to 
leave ProPresenter.


To use SongSelect, please make sure that the Show House of Worship 
Integrations option is enabled in the General tab of ProPresenter 
Preferences. You will be prompted to login to your account upon first 
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searching in the QuickSearch window or by going to the Services tab of 
ProPresenter Preferences and clicking the Login button under SongSelect.


ProPresenter allows you to search for songs from SongSelect in the 
QuickSearch window. To do this, click on Search in the toolbar or go to 
File>Import>SongSelect... to access this window. You can search here by title, 
author, keywords, or CCLI number.


Once you search for a song, you can highlight it and a preview will show of a 
portion of the song lyrics and then simply click Import to begin the import 
process of the file.


Songs downloaded from SongSelect are also stored in a CCLI Reporting file. 
You can access this file in the General tab of ProPresenter Preferences by 
clicking Reporting in the bottom right corner of the window. This file can be 
exported and/or reset at any time and shows the date the file was 
downloaded, title of the file, author, publisher, copyright year and CCLI 
number for the song.


Copyright information is also downloaded from CCLI and there are ways to 
send this to your Screen when that presentation is triggered.


Import Media

This option will load a computer browse window where you can search for 
the media files you wish to import. Navigate to the media file you wish to 
import and select it. The file will be added to either the Audio or Media Bin 
depending on its file type and will add into whichever Playlist is currently 
selected in the respective Bin.
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Import ProPresenter Library

This area allows you to import any previous ProPresenter6 or current 
ProPresenter libraries and migrate them into the program. You will see a 
window showing any Library from Pro6 that is currently able to be located 
on your machine provided ProPresenter6 is installed on your machine. This 
will allow you to select a library to import and convert to ProPresenter. 
Importing these files does not affect your previous files, so you can import 
the files while you are getting ProPresenter configured without affecting the 
previous versions. More information on this is found in 
the Migration section below.
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Exporting

There are several ways and formats to export an 
individual document or multiple documents that 
have been selected from the ProPresenter 
program.


To access the Export options inside of the 
program, go to File>Export in the menubar and 
select one of the options from the submenu.


Export Presentation

Exporting as a Presentation file will include simply the text slide data itself 
and will not include any media that is used in the Presentation.


Export Presentation Bundle

Bundles are used to gather Library files and media files together into a 
single package that can be opened in ProPresenter on another computer. If 
you select multiple songs in the Library, they will all be included in the same 
bundle along with the media. Importing a bundle file will prompt you to add 
the documents to a Library


Export Text

This option will export the select presentation(s) as a plain text file with a .txt 
extension. This export method strips all formatting except line and 
paragraph breaks.


Export Slide Images

This option will export all slides in a 
presentation as a JPG or PNG image. The JPG 
image will include any slide background color 
you've selected, while the PNG will not include 
the slide background color.


You can also choose whether you wish to 
include thumbnails of your Media Actions or 
not. Once you click Save, a folder will be 
created in your file's destination with 
individual images of each slide inside.
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Export Playlist

This option will export the selected playlist. When you export a playlist you 
can choose to include the media with the playlist if you want. Importing a 
playlist on another computer will rebuild the playlist exactly the way it is on 
the original computer. Playlists can also be exported by right-clicking on the 
playlist name and choosing Export.


Export Themes

ProPresenter makes it easy to export Themes to be used on another 
computer. Instead of having to search through the computer folders to find 
these files and manually add them on another computer, you can export 
specific Themes to a single bundle file.


Simply check the box next to each of the 
Themes you wish to export. You can also 
use the All or None options to select 
these Themes from the list. By default, all 
Themes will be selected when you open 
this window.


When you double-click the exported 
Theme file on another computer, the 
Themes will be imported and be 
available for immediate use.
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Migration

There are a few different types of Migration that may occur with your 
ProPresenter files. This would include migrating from a previous 
ProPresenter version or migrating to a new computer with your current 
ProPresenter installation. We will describe options for both of these here.


Migrating from a ProPresenter6 Installation

Initial ProPresenter Install


When you initially launch 
ProPresenter, you will see 
the Welcome to ProPresenter series 
of screens that allow you to do a 
quick/initial setup of the program. In 
this window is also an option to 
migrate existing ProPresenter6 data 
into the ProPresenter program. You 
can also access this setup process by 
going to Window>Welcome to 
ProPresenter in the menubar.


Here, you will see your existing Pro6 Libraries that are found on the computer 
provided ProPresenter6 is installed on the machine. You will also have the 
ability to enable migration of Library Playlists, the Media Bin, the Audio Bin 
and various Settings/Support Files here.


Once you click on Migrate, your migration process will begin automatically 
at that time.


Migration Using the File Menu

Migrating via the File menu is similar to migrating through the Welcome to 
ProPresenter window, but is simply accessed differently. To open this 

migration window, go to 
File>Import>ProPresenter Library.


This loads a Migration window that 
will show each of your previous Pro6 
Libraries provided Pro6 is installed on 
the machine.
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You can choose to migrate your Libraries, migrate the Playlists for the 
selected Libraries, migrate the Media and Audio Bins from Pro6 and also any 
Settings/Support Files in this window.


Once you click on Start Migration, the program will begin to bring the data 
into ProPresenter automatically.


Migrating ProPresenter7 from One Machine to 
Another

To move ProPresenter data from one machine to another, you can use the 
Local Sync feature inside of ProPresenter Preferences. It's recommended you 
have the same version of ProPresenter installed on both machines for this to 
work properly.


On the Original Computer...

1. Create an empty folder on the Desktop and name it "ProPresenter 

Sync" (or something similar).


2. Open ProPresenter, 
open Preferences, 
click on the 
Advanced Tab, and 
make sure 
"Manage Media 
Automatically" is 
checked.


3. Click on the Sync 
tab


4. Click the "+" near 
the top right and 
select the new 
folder you just 
created on the 
Desktop. Also, check 
all five check boxes below that. If you are not moving everything, you 
would choose which components you wish to migrate here.


5. Select the option to "Sync files up to repository". This will add all of your 
data to the folder. (Right now the "Replace Files in Repository" box is 
irrelevant because the folder is empty.)
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6. Click Sync. Note that this may take a minute or two depending on how 
much media you have.


7. Once the Sync operation completes, copy this folder to an external drive 
or a network drive.


You can now move to the new computer


On the New Computer...

1. Copy the folder from the external drive or the network drive to your 

Desktop.


2. Open ProPresenter, open 
Preferences and then 
click on the Sync tab


3. Click the "+" near the top 
right and select the folder 
you just copied to the 
Desktop. Also, check all of 
the boxes you had 
enabled on the original 
computer.


4. Select the option for 
"Sync files down from 
repository". This will make 
sure that your data gets 
copied from the folder to 
your ProPresenter folders.


5. You would only wish to enable Replace My Files if you want the 
program to remove what is currently there before adding what is 
coming across from the original computer


6. Click Sync. Note that this may take a minute or two depending on how 
much media you have.


Your data should now appear inside of the program on your new machine.
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Printing

ProPresenter provides a way for you to print out your Slides and Playlists. This 
section will cover all of the Printing options inside of ProPresenter.


Printing Presentations

To print your Presentations, select one or more Presentation and choose one 
option:


• Press Command-P on Mac or Control-P on PC


• In the Menubar select File > Print


• If the presentation(s) are inside of a Playlist: right click on the 
presentation and choose Print


Printing a Playlist

You can print an entire Playlist which will print each Presentation in that 
Playlist. To print a Playlist, right click on the Playlist and choose Print 
Playlist.


Printer Options

When you tell ProPresenter to print it will bring up the Print Options Box. 
This process is slightly different between Mac and Windows, and the 
platforms are separated here below.


Mac

The top half of this window is controlled by the operating system and will be 
customized based on your printer. Use this section to choose which printer 
you will be printing to, the paper size, and other similar options.


Tip: If you would like to "print" to a PDF, click the PDF 
dropdown in the lower left and choose Save as PDF.


ProPresenter's options are on the bottom half of the window. If you don't see 
these options, click the Show Details button at the bottom of the Print 
Dialog Box. More on these Details is available below...


Once you've setup the parameters of how you'd like to Print, you can click 
the Print button.
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Windows

ProPresenter's options are on the first window. This allows you to set the 
parameters of what will be printed. More on these Details is available below...


Once these details are set, you can click on either Print or Preview to move 
forward. Clicking on Preview will show a PDF preview of your printout, 
while Print will open the computer printer window. This window is controlled 
by the operating system and will be customized based on your printer. Use 
this section to choose which printer you will be printing to, the paper size, 
and other similar options.


Once you've setup the parameters of how you'd like to Print, you can click 
the Print button.


Parameters on Printouts

There are two main ways to print your Presentations:


• Thumbnail View will print images of each of your slides; this is 
preferable if you are wanting visual representations of each slide 
(including media and all slide objects)


• Outline View will extract the text from each slide and print it as text; 
this view is better if you are printing lyrics or otherwise just need the 
text from your presentation


Each of these Views offers several options to help customize what you are 
printing. Click the check box next to each item to toggle the printing of that 
option.


Both Views have the following options:


• Document Information: Prints information such as:


◦ Artist


◦ Author


◦ Publisher


◦ Copyright Year


◦ Song Number
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• Presentation Notes


• Current Date


The Thumbnail View also has this option:


• The number of Columns that the thumbnails will print in


The Outline View also has these options:


• Slide Numbers


• Slide Labels


• Slide Notes


• Disabled Slides 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Working with Media

ProPresenter offers many versatile ways to work with media and send it to 
your screens. Media inside of ProPresenter is stored in Bins at the bottom 
and right sides of the program. You can also setup Video Inputs in the 
software to bring in live video elements from outside sources into the 
program. Cue Inspectors help to change individual Media actions and give 
them a completely different look to fit your presentations.


Media Cue Inspector

The Media Cue Inspector is an in-depth window that allows you to both 
preview your Media files before playing them back and edit the Properties of 
these items. These Properties include how the Action will look, play and act 
when triggered in ProPresenter.





To open the Inspector, right click on a Media Action either in the Media Bin or 
on a Slide and choose Inspector. If you have multiple Media Actions selected 
at the same time, you can also open all of these at once in the Inspector.
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Media Action List




Inside of the Inspector, the far left area is the Media Action List. This will list 
any Media Actions you had selected when you opened the Inspector window 
and allow you to select each one to work with. Click on a Media Action in the 
list to select it, open it in the Preview Pane and edit its Properties.


Preview Pane

When a Media Action is selected the Preview Pane offers a place for you to 
customize the settings for your Media. Across the top it lists the name of the 
Media Action. By default this is the name of the file, however if you would like 
to change this then you can click on the name and enter your own name.





The main preview area will show you a preview of your media. If the media is 
a video, you can use the scrubbing bar to jump the preview to a specific 
place in your media. Below the scrubbing bar are some Playback 
Controls to control the playback of the media. Use the Play/Pause button to 
pause or play the media, or use the Skip Backwards/Forwards buttons to 
skip backward or forward 15 seconds.


Click the Step Backward/Forward buttons to step frame-by-frame through 
your media. This can also be done by clicking the left or right arrow keys on 
your keyboard.  Use the Go To Beginning button or Go To End button to skip 
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directly to the beginning or end of the media. You can also right-click (or click 
and hold) on the Go to Beginning/End buttons and choose how far from the 
beginning/end you want to jump to (90 seconds, 60 seconds, 30 seconds, 10 
seconds, or directly to the beginning/end).


To change the starting point of a video, move the playhead to the desired 
location and then click In to set the In Point. Similarly you can click on Out to 
set the Out Point. Click Reset In or Reset Out to reset the respective features.


Edit Pane

When you have a Media Action selected the Edit Pane on the right allows for 
fine-tuning your media by way of the Info, Properties, Effects, and Audio (if 
the file has audio on it) tabs.


Info Tab

The Info Tab has information about the 
media that you have selected. Across 
the top it lists the Action’s 
Name (which you can click on to edit) 
as well as the File Path that 
ProPresenter is referencing this file 
from. Click on the magnifying glass to 
open the location of the file in the 
Finder on Mac or in Windows Explorer 
on PC. If you want to change the file 
that ProPresenter is linking to or to 
point the program to a different copy of 
the same file, click on the gear icon to 
open a computer browser window 
where you can select a new file to 
reference.


The Thumbnail feature will show you 
the currently used thumbnail for the 
media. If your media is a video and you 
want to change the thumbnail, use the 
scrub bar in the Preview Pane to select 
the desired location then click Set to 
Current Frame. The bottom of the Info 
Pane will provide information about 
the media itself, such as its Type, Duration, Format, Size, and Frame Rate 
(FPS), depending on the type of media that is selected.
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Properties Tab

The Properties Tab of the Inspector allows you to adjust multiple properties 
of your Media Actions.


Click the drop-down menu next to Scale Behavior to adjust how the media 
will scale in your Target:


• Scale to Fit will make sure that all of your 
content shows within the bounds of a 
given Object and the media won’t be 
stretched; it will achieve this by adding 
black bars on the top/bottom or sides of 
the media as needed.


• Scale to Fill will keep your media not 
stretched and it won’t have any black 
around the sides or top/bottom; it will 
achieve this by cropping off the top/
bottom or sides as needed.


• Stretch to Fill will fill the bounds of the 
Object with the media and it won’t crop 
any of the media out; it will achieve this 
by stretching the media as needed.


Change the Scale Alignment to control if the 
media will try to stay in the center of the Target 
or if it will tend towards one of the corners or 
sides of the Target. Scale Alignment is only 
available if you set the Scale Behavior to Scale to Fit or Scale to Fill. You can 
also enable Flip Horizontally and/or Flip Vertically to flip the media.


Enable Crop to scale the media yourself to a subset of the original image. For 
example, if you wanted to show only the top left of a piece of media but have 
it fill the screen, you would adjust these numbers to do so. Options for 
adjusting this are to enter numbers into the boxes as needed, use the arrow 
buttons next to the boxes, or use the black bounding boxes that surround the 
media itself in the Preview Pane.


The Playback Behavior will affect what happens at the end of the media; 
depending on which Playback Behavior you select there may be other 
options available to you.


• Stop plays the video file in it's entirety once and then moves on to 
the End Behavior
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• Loop will continuously play the video file until you choose to clear the 
Media or trigger a different Media file


• Loop for Play Count adds an option where you set how many times 
you wish for the file to play. It will continue looping until it reaches the 
number of times entered in the Times to Loop box that appears and 
then move on to the selected End Behavior.


• Loop for Time allows you to set a certain amount of time that you want 
the Video to run for. Once it reaches the end of that time, it will move on 
to the End Behavior


When choosing an option that involves looping the video for Playback 
Behavior, a check box will appear for Soft Loop. Enabling this will allow the 
video file to dissolve back to the start of the video instead of a hard cut. This 
is especially helpful if you have a video that has action continuing through 
the last frame that has different content back at the beginning of the clip.


If you set Playback Behavior to Stop, Loop for Play Count, or Loop for Time, 
the option to set an End Behavior will appear in the window as well. Here 
you can choose one of five options for the video to follow once it finishes 
playback.


• Hold Last Frame -- this will freeze the video on it's last frame and stay 
there until the video is cleared or a new media action is triggered


• Black after Last Frame -- this will cut to Black at the end of the last 
frame of the video


• Clear after Last Frame -- this will clear the Media file after the 
playback of the last frame of the video. If you have a Video Input in 
place and triggered, it would clear the Video file out and show the 
Video Input on the Screen.


• Fade to Black -- this will dissolve to Black at the end of the last frame 
of the video


• Fade to Clear -- this will dissolve the Media file after the playback of 
the last frame of the video and clear the Action. If you have a Video 
Input in place and triggered, it would dissolve the Video file out and 
show the Video Input behind it on the Screen.


For still images, you can set the Duration (that is, how long it will show on 
the Screen); videos will have their Duration pre-filled. You can set the Delay 
Time which is how long the media will wait before it plays. For video actions 
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you can also set the Rate at which it will play (from 20% to 200%) speeding 
up or slowing down the video playback.


At the bottom of the Properties tab you can select a Transition for the 
individual Media Action. This Transition will trump the Master Transition 
which allows media to have custom transitions which are unique to just that 
media. 


Effects Tab




Effects allow you to modify the look of your Media files. Click the plus button 
to add an Effect to the media. Adjust an Effect’s properties by adjusting the 
options below that Effect (note that not all effects have properties that you 
can edit). To disable/enable an Effect click on the checkbox to the left of the 
Effect’s name. To change an Effect to a different Effect or to remove an 
Effect, click on the down arrow to the right of the Effect’s name.





The Effects Preset allows you to assign a predefined set of Effects to a Media 
Action. If you have previously saved an Effect Preset you can use this drop-
down to apply it. If you have applied an Effect Preset and you make changes 
you can Save those changes or Save As a new Preset. If you have made 
changes, you'll see a small * to the right of your Effects Preset Name. Another 
option is to Unlink Preset which allows you to show that no Preset is set, but 
leave the Effects in place on the Media Action. You can also use this drop-
down to Clear Effects from the media.
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Audio Tab

The Audio Tab allows you to adjust the physical audio output properties for 
the Media item. This tab will only appear if your media file has an audio 
track on it.


Under Transition Behavior you can add a Fade In and/or a Fade Out. Check 
the boxes that you want to enable and adjust the slider to customize how 
long the fade will last.


Click the Channel Routing button to open a window where you can route 
audio channels to specific outputs. For more information on how Audio 
Routing works, you can look at that section


The boxes at the bottom of the Audio tab give you more insight into each 
audio channel. For each channel you can Mute or Solo the channel and you 
can adjust the Volume of each specific channel. This area will also tell you 
which Outputs each channel is assigned to (which is set via the Audio 
Routing button above).
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Audio Cue Inspector

The Audio Cue Inspector is an in-depth window that allows you to both 
preview your audio files before playing them back and edit the Properties of 
these items. These Properties include how the Action will look, play and act 
when triggered in ProPresenter.





To open the Inspector, right click on an Audio File either in the Audio Bin or 
on a Slide and choose Inspector. If you have multiple Media Actions selected 
at the same time, you can also open all of these at once in the Inspector.


Media Action List




Inside of the Inspector, the far left area is the Media Action List. This will list 
any Media Actions you had selected when you opened the Inspector window 
and allow you to select each one to work with. Click on a Media Action in the 
list to select it, open it in the Preview Pane and edit its Properties.


Preview Pane

When an Audio Action is selected the Preview Pane offers a place for you to 
customize the settings for your file. Across the top it lists the name of the 
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Audio Action. By default this is the name of the file, however if you would like 
to change this then you can click on the name and enter your own name.





The main preview area will show you a sound wave representation of your 
audio file. You can use the scrubbing bar to jump the preview to a specific 
place in your media. Below the scrubbing bar are some Playback 
Controls to control the playback of the media. Use the Play/Pause button to 
pause or play the media, or use the Skip Backwards/Forwards buttons to 
skip backward or forward 15 seconds.


Click the Step Backward/Forward buttons to step frame-by-frame through 
your media. Use the Go To Beginning button or Go To End button to skip 
directly to the beginning or end of the media. You can also right-click (or click 
and hold) on the Go to Beginning/End buttons and choose how far from the 
beginning/end you want to jump to (90 seconds, 60 seconds, 30 seconds, 10 
seconds, or directly to the beginning/end).


To change the starting point of the file, move the playhead to the desired 
location and then click In to set the In Point. Similarly you can click on Out to 
set the Out Point. Click Reset In or Reset Out to reset the respective features.
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Edit Pane

When you have an Audio file selected the Edit Pane on the right allows for 
fine-tuning your media by way of the Info, Properties, and Audio tabs.


Info Tab

The Info Tab has information about the media that 
you have selected. Across the top it lists the Action’s 
Name (which you can click on to edit) as well as 
the File Path that ProPresenter is referencing this 
file from. Click on the magnifying glass to open the 
location of the file in the Finder on Mac or in 
Windows Explorer on PC. If you want to change the 
file that ProPresenter is linking to or to point the 
program to a different copy of the same file, click on 
the gear icon to open a computer browser window 
where you can select a new file to reference.


The bottom of the Info Pane 
provides information about the media file itself 
such as its file type and original duration.


Properties Tab

The Properties Tab of the Inspector allows you to adjust different behaviors 
of your Audio Actions.


The Playback Behavior will affect what happens 
once the audio file completes its playback. You can 
choose one of three options.


• Stop -- This behavior will play the file back one 
time and end after one full playback


• Loop -- This behavior will continue playing and 
repeating the file until a new audio action is 
triggered or a Clear Audio action is triggered


• Next -- This behavior is only applicable for 
playback from the Audio Bin.  This behavior 
allows the next audio action in the Bin to 
playback at the conclusion of the currently triggered action.
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The Duration of the action will be pre-filled and will update if the In/
Out settings are changed in the Preview Pane. You can set the Delay 
Time which is how long the media will wait before it plays after being 
triggered. You can also set the Play Rate at which it will play (from 20% to 
200%) speeding up or slowing down the audio playback.


Audio Tab

The Audio Tab allows you to adjust the physical audio output properties for 
that item.


Under Transition Behavior you can add a Fade In and/or a Fade Out. Check 
the boxes that you want to enable and adjust the slider to customize how 
long the fade will last.


Click the Channel Routing button to open a 
window where you can route audio 
channels to specific outputs. For more 
information on how Audio Routing works, 
you can look at that section


The boxes at the bottom of the Audio tab 
give you more insight into each audio 
channel. For each channel you 
can Mute or Solo the channel and you can 
adjust the Volume of each specific channel. 
This area will also tell you which Outputs 
each channel is assigned to (which is set via 
the Audio Routing button above).
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Video Input


Video Input Configuration

Setting up your Video Inputs is done through the Input tab of ProPresenter 
Preferences. For more information on this, please see the Preferences section.  


Video Input Playlist

Once you have created and setup your Inputs, you can add them to the 
Video Input Playlist in the Media Bin. The Video Input Playlist can be 
accessed by clicking on the Video Input button on the bottom left of the 
Media Bin area. This is a custom Playlist type that allows you to see all of 
your video input feeds at once and fire them directly as needed.


Add Video Inputs to the Video Input Playlist by clicking the + in the lower left 
and selecting your desired Input. If you have not created an Input, you will be 
directed to Video Input Configuration from the + menu which opens up the 
respective tab in ProPresenter Preferences.





Video Input Actions

Add the Video input Action onto a slide to automatically turn on or change 
the Video Input layer of ProPresenter when that slide is clicked. You can also 
drag a Video Input from the Video Input Playlist to a slide directly and it 
would trigger alongside the slide content when that slide is triggered.


Add the Video Input Action to a slide by opening the Action Palette and 
dragging the Video Input Action onto a slide; doing so will give you the 
option to choose which Video Input you would like to assign to that slide. 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Audio Input


Audio Input Configuration

Setting up your Audio Inputs is done through the Input tab of ProPresenter 
Preferences. For more information on this, please see the Preferences section.  


Triggering Audio Inputs

At this time, you would either have an “always on” input or to trigger an 
Audio Input, it has to be linked to a Video Input in the Input tab of 
ProPresenter Preferences.  For an input that is “always on,” you would select 
the On or Auto Off modes in the Audio pane of the Input tab of Preferences.  
If you link an Audio Input to a separate Video Input, the audio would 
playback once the Video Input is triggered.  More about these options is 
explained in the Preferences section below.  


Audio Input Actions

In much the same way as the Video Input action, you can add an Audio 
Input Action onto a slide to automatically alter an Audio Input’s mode or 
level when that slide is triggered.  You can change what Mode the input is 
set to (Off, On, Auto Off, Auto On) and also set the level you wish the input to 
playback at.  


Add the Audio Input 
Action to a slide by 
opening the Action 
Palette and 
dragging the Audio 
Input Action onto a 
slide; doing so will 
give you the option 
to choose which 
Audio Input you 
would like to make 
changes to on that 
slide. 

Page  of 116 193



Show Controls

ProPresenter 7.5 introduced a new function in the ProPresenter interface.  
Show Controls are tools in the bottom right of the program that allow you to 
prepare and run your live show.  Each item will be discussed below as this 
allows you to playback audio files, setup Props and Messages, change the 
way your Stage screen works and create Timers for many facets of your 
event.  


Audio Bin

ProPresenter has a dedicated Audio Bin for organizing, editing, and playing 
audio files. Create Playlists to organize your audio, use the Media Inspector 
to edit and customize your audio, and use the playback controls from within 
the bin to control the audio as it plays.


Audio Types

Inside of ProPresenter, audio files must be categorized as one of two types:


Audio Track:  Generally used for longer audio files such as songs or spoken 
word, Audio Tracks are limited to only playing one at a time inside of 
ProPresenter and can be controlled via the playback controls at the top of 
the Audio Bin.


Sound Effect: Generally used for shorter audio files such as sound effects in a 
dramatic program, Sound Effects can have several playing at once and have 
no direct control options.


Tip: Audio files less than 10 seconds are automatically 
categorized as Sound Effects, while longer audio files are 
categorized as Audio Tracks. This can always be changed for any 
file by right-clicking on the file and selecting "Set as…”


Outline View

Across the top of the Audio Bin is the Outline View where you can create and 
organize Playlists of audio files.


An Audio Playlist can contain audio files. Audio Playlist Folders do not 
contain audio files themselves, instead they contain Audio Playlists. That is, 
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you can use Playlist Folders to 
organize your Playlists, and 
Playlists to organize your 
audio files.


Create new Playlists and 
Playlist Folders by clicking the 
+ button across the top of the 
Playlist view. Click and drag 
Playlists and Playlist Folders 
to rearrange them.


Select a Playlist or Playlist 
Folder then click the name 
again to rename the item. 
Right click or select and press 
the Delete key to delete items.


You can collapse the Playlist 
view by clicking the ^ button; 
this allows the operator to 
focus on the contents of just 
one Playlist. In this mode, click the name of the Playlist to select a different 
Playlist, and click the v to open up the full view again.


Audio View

Once you select a Playlist you can then see the audio files contained in that 
Playlist at the bottom of the Audio Bin.  Clicking on any audio file will play it 
immediately.


You can add audio files to a Playlist by clicking the + between the Playlist 
View and Audio View, or by dragging them from your operating system to 
this area.  The Filter bar will allow you to search the currently selected 
Playlist.


Use the slider at the bottom of the Audio bin to control how long the 
transition is between audio files (including when you start and clear audio 
files) and you can click on the Shuffle button to shuffle the Audio Playlist that 
you have selected.


Right click on an audio file to access additional options:


• Reveal in Finder/Open File Location:  Shows where the audio file is 
currently stored on the computer
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• Playback Behavior (Audio Track only): Controls what happens at the 
end of an Audio Track:


• Stop


• Loop


• Loop for Play Count…


• Loop for Time...


• Next Cue (Audio Track only): Controls what audio files plays when this 
one finishes


•  None: Nothing happens


• Next:  The next file in the Playlist (or, if Shuffle is turned on, a 
random file in the Playlist) is played


• Set as [Sound Effect type/Audio Track type]:  Changes the audio track 
type


• Inspector:  Opens the Audio Cue Inspector. 


• Rename:  Allows you to rename the file


• Delete: Removes the audio track from the Playlist


Audio Bin Actions

With the release of ProPresenter 7.3, you can now trigger Playlists from the 
Audio Bin on a single slide click with an Action.  This is extremely useful if you 
are playing back a series of audio tracks before an event or need to trigger a 
grouping of audio to play from one click.  


This can be accomplished by dragging 
your Audio Playlist from the Audio Bin 
to a slide in a Presentation. You can also 
add it in front of or behind a slide to 
create your own slide cue for this action, 
or from the Action Palette by adding 
Audio Bin Playlist to a slide.
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Stage 


The Stage control options in Show Controls allow you to both send Messages 
to your Stage screens and set layouts for each of the screens.  


The top portion of this window shows any currently active Stage screens that 
you have setup in Screen Configuration and the current Layout is shown in a 
thumbnail.  Clicking on the thumbnail brings up a dropdown menu where 
you can select a new Layout for that screen or go to the Stage Editor.  


Below the selection menu, you can send a Stage Message to your screens.  
Any object using the “Stage Message” linked text data link will see this 
message appear on their screen.  Enter your text and then click to Show to 
send this message to the screen.  The Show button will toggle to a Hide 
button when the message is active and clicking it will remove the Message 
from the screens.  
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Timers

Many users need timers to keep track of services or events. A band wants to 
know how long until they need to start playing. A pastor wants to know how 
long he has been talking. Attendees want to know how long before the event 
starts.


ProPresenter can create and track multiple timers at the same time, and 
there are various timer types to cover your various needs.


Timers can be used in multiple places in ProPresenter. For example, you can 
show them on the Stage Display, or use a Message or Linked Text to show 
them on the audience screen. You can also use Cues to start, stop, and reset 
Timers as needed.


Note: This section only covers the Timers Show Control area where 
you can create and edit Timers; for more information on other 
features that use the Timers, see that respective feature's 
section.
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There are three types of Timer types:


• Countdown: Set a specific amount of time for it to count down from


• Countdown to Time: Set a time of the day and ProPresenter will count 
the time left to that specific time (based on the computer's internal 
clock)


• Elapsed Time: Count up; you can start from zero or include a Starting 
time, and you can optionally set an Ending time


Create a new Timer by clicking the + in the upper right of the area. Delete a 
Timer by right-clicking on the Timer and selecting Delete or, if you have a 
trackpad, swipe to the left and click Delete.


Click the disclosure triangle to show or hide the Timer's options. Rename the 
timer by clicking on the name of the Timer. Click on the Type dropdown 
menu to change which kind of Timer you’re using.


Check Allows Overrun if you would like the Timer to keep running after it 
reaches zero or its end; uncheck Allows Overrun to have the Timer stop when 
it reaches its end. 


The Reset button will revert the timer back to the beginning and the Play 
button will start the timer.  While a timer is running, it will be highlighted 
green to signify it’s in motion.  If you have Overrun enabled, the timer will 
highlight in red once a timer has reached its original “ending” time.  
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Messages

The Messages feature in ProPresenter is a versatile way of showing extra 
content on your audience output. This content is independent of the slides 
and other media inside of ProPresenter, which means it will appear on top of 
your slides and other content; for example, Messages will stay on top of your 
slides, even if you change slides. This makes it a preferable way to show 
content across multiple slides.


Examples of this might be:


• "Car with License Plate X852WT, your lights are on."


• "The service will begin in 03:32."


• "Parents of child 485 please come to the nursery."


Tip: The Props feature of ProPresenter is similar to the Messages 
feature, but there are some unique characteristics between them. 
In general, if you want your content to be pre-programmed then 
you would be looking at a Prop; if you want to make changes to 
text on the fly then we recommend investigating the Messages 
feature.


Tokens

To use the Messages feature you will be setting up a block of text that will fill 
a text box that you set up inside of a Template. This block of text can include 
prewritten text as well as one or more Tokens, or variable blocks of text.


Using the same examples as before, let's look at what the blocks of text 
would look like with tokens:


• "Car with License Plate [License Plate], your lights are on."


• "The service will begin in [Service Countdown]."


• "Parents of child [Nursery Number] please come to the nursery."


The above blocks of text and Tokens would be setup beforehand, then when 
the operator is running ProPresenter live, they would only have to enter the 
pertinent information inside of the Token and click the Show button for it to 
appear on the screen.
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Note: Messages can be set up on the fly, however they are most 
powerful when they are set up beforehand so that the operator is 
able to keep their focus on the rest of the show.


There are several types of Tokens:


• System Clock: Shows the current computer time


• Timers: Any Timer that you have set up in the Timer Pane can be sown 
via a Message


• Pre-Defined Text: ProPresenter provides some text boxes that are 
already set up to use, including "Name", "Message", and "Room"; these 
Tokens cannot be deleted but are otherwise the same as Custom Text 
tokens


• Custom Text: Create your own Token with its own name and content


Let's dive into one of the above examples: "Parents of child [Nursery Number] 
please come to the nursery." In this example, someone had previously set up 
a Message for this contingency. They created a Message called "Nursery Call" 
and applied a Template to it. They then created a custom Token called 
Nursery Number; this is simply a text field that the end user can use to enter 
the child's number. After they create the Token, they type into the text field 
"Parents of child please come to the nursery." and they drag the "Nursery 
Call" Token into the text field which creates "Parents of child [Nursery Call] 
please come to the nursery."


The Message is now set up and ready to go. The next day, during a service, 
the operator is notified that a nursery call is needed. They open the 
Messages feature of ProPresenter, type the nursery number ("485") into the 
Token area, and click Show. ProPresenter then correctly shows the text 
"Parents of child 485 please come to the nursery." on the screen.


Create a new Message by clicking the + in the upper right of the area. Delete 
a Message by clicking on the message and pressing the Delete or Backspace 
button on your keyboard, or, if you have a touchpad device, swipe to the left 
on top of the Message name and click the Delete button.


Click the Modify Transition button to change the transition that Messages 
will use when they Show and are removed from the screen. All Messages 
share the same Transition and there is not an option to set individual 
Transitions on individual Messages.
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Clicking the Network 
button at the bottom of the 
area will open the webpage 
where users can send 
Messages over the network. 
The Allow Web Notifications 
checkbox at the bottom of 
the area will quickly toggle 
this feature on and off. See 
the Web 
Notifications section for 
more information.


Click the Show button to 
Show the currently selected 
Message to the screen. You 
can identify which 
messages are currently 
being shown as they will be 
highlighted in Orange in 
the Message List; click on 
Hide to remove the message from the screen. To remove all Messages, click 
the Clear Messages button in the Preview Window, or in the menubar select 
Actions > Clear Messages.


Editing a Message

To set up and edit non-Token parts of a Message, click the Edit button in the 
upper right of the window; this will show additional controls for editing the 
Message itself; click this button again to hide these additional controls.


With the Edit controls showing, the text box will show where you can type 
your message and include any Tokens that you will be using. Below this 
window is the Token dropdown.  You can click on the dropdown to add an 
established Token or if you have a Token you want of your own, you can type 
it in the box there and hit Enter.  


Note: The pre-defined Tokens that come with ProPresenter cannot be 
deleted. Any Clocks/Timers that are created in the Timers area will appear as 
Tokens as well.


Click the Template to change which Template this Message will use for 
formatting when it is shown on the screen. To have a Message clear 
automatically after a certain amount of time, click the dropdown menu next 
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to Dismiss and select the amount of time before it clears, or select Manually 
to have it not clear automatically.


Tokens

Here are the Token types and the options you have when editing them:


• Pre-defined ("Name", "Message", and "Room") and Custom Tokens


◦ These are simple text boxes; enter any text you would like and the 
Token will pass that text through to the Message when it is shown


• Clock -- this is the standard system Clock


◦ Date Format: Choose how the Date will look


◦ Time Format: Choose how the Time will look


◦ 24 Hour: Click to enable a 24 hour clock, unclick to enable a 12 
hour clock


• Timer -- this will appear for Timers setup in the Timers Pane


◦ Timer Type: Click the dropdown menu to select if the timer is a 
Countdown timer, a Countdown to Time timer, or an Elapsed 
Time timer


◦ Countdown timer: Duration allows you to select how long the 
timer will be


◦ Countdown to Time timer: Choose the Time at which the tier will 
countdown to, then select the Format (AM, PM, or 24 Hour) you 
are using


◦ Elapsed Time: Choose then number at which the timer will Start 
and End.


◦ Overrun: Check this box if you want the timer to continue to count 
after it hits its destination, uncheck it if you want it to stop at its 
final goal


◦ When a Timer is running click the Reset Timer button to reset the 
timer, Start Timer button to start the timer, or Stop Timer button 
to pause the timer


◦ You can also choose how the timer will be shown on the screen. 
There are options for hours, minutes, seconds, and milliseconds. 
For each of these options you have up to five choices; however 
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depending on what you have selected in one section might 
disable options in another section. Here are the five options, 
using hours as an example:


◦ h: Always show the hours but hide leading zeros


◦ hh: Always show the hours and show leading zeros


◦ h: If there are hours then it shows them with no leading zeros; if 
there are no hours then it doesn't show them


◦ hh: If there are hours then it shows them with leading zeros; if 
there are no hours then it doesn't show them


◦ - -: Hide the hours text; if there would be hours to show it adds 
that time to the minutes


Web Notifications

You can configure ProPresenter to allow other people to send Messages over 
a local network. Using this feature allows other users on any internet 
enabled device to load a web page, make changes to the Tokens (just as the 
operator would inside of ProPresenter, and Send a request for that Message 
to be sent to the audience screen. The operator running ProPresenter can 
either approve or disprove the showing of that Message.


Before this feature is utilized you must enable a feature inside of the 
Preferences. In the top left of the screen click on ProPresenter then click on 
Preferences. Click on the Network tab and make sure that Enable 
Network is checked. It will automatically generate a Network 
Name and Port; you can change the Network Name if you would like, we 
recommend leaving the Port number alone unless there is a specific need to.


Now that the Network is enabled, close the Preferences window and open 
the Messages Pane. You can toggle Web Notifications by clicking on the 
checkbox next to Allow Web Notifications.


Click on the Show Web Access button across the bottom of the Messages 
Pane to open in your default browser the web page where you can access 
the Web Notification feature. Make a note of the web address and share it 
with users who you would like to be able to send Web Notifications. (For 
example, you can copy the web address from the browser and paste it into 
an email to someone who should have that access.


Sending Web Notifications
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To send a Web Notification the sender will need to open the web address 
provided to them on a device that is on the same network as the computer 
running ProPresenter.


Note: The user's device that will be accessing this feature must 
be able to see the device running ProPresenter on the network. 
Generally speaking this means that the devices need to be on the 
same wired or wireless network as each other, however each 
network is unique so you may need to speak to your network 
administrator about how to enable a feature like this.


Once they open that webpage they will see a list of all of the Messages listed 
inside of ProPresenter. They can add text and make other changes as 
necessary to their desired Message, then click on Show. This will send a 
request to the ProPresenter operator to show the Message on the screen.


Receiving Web Notifications

When a Web Notification is sent the ProPresenter operator will see a 
notification on the top right of their computer screen notifying them of the 
request. The notification works slightly differently between Mac and 
Windows. To show the Message on the audience screen on a Mac, click Show 
Alert, to dismiss the request on a Mac and not show it on the audience 
screen, click Dismiss. To show the Message on the audience screen on a PC, 
click directly on the notification, to dismiss the request on a PC and not show 
it on the audience screen, click the arrow to "archive" the notification.


Once approved the Message will show on the Audience screen just as if the 
ProPresenter operator had shown the Message. It will follow all of the same 
rules and can be cleared the same way as other Messages.


Message Actions

Add Message Actions to slides to show 
specific Message(s) when you click on a 
specific slide. Add Message Actions to 
slides by opening the Action Palette and 
dragging the Message Action onto a slide 
or by dragging the Message you wish to 
use as an Action from Show Controls onto 
a slide.


When adding or editing a Message 
Action you will be able to select which 
Message you want to fire when that slide 
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is clicked, as well as be able to edit any variables that you have set up inside 
of that Message.


You can have multiple Message Actions on one slide.
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Props

There are many times where users have a need to put a persistent image or 
some text on top of one or more slides. Some examples of these types of 
needs are:


• A logo (often times called a "bug") in the lower corner of the screen


• A mission statement or other text that will be shown across multiple 
slides


• An icon during the last verse of a song telling children to come to the 
front of the sanctuary for Children's Time


The Props feature of ProPresenter was created to address these needs and 
much more!


Props are a way to show text and media on top of the Slides layer and have 
that text/media persistent across one or more Slides. You can create multiple 
Props, show one or more at a time, and even control them via Cues on slides.


Props are created, edited, and can be shown in the last tab of Show Controls. 
You can open this area by clicking the Props button in the Show Controls, 
pressing Control-P on Mac or Control-Shift-P on Windows, or selecting in the 
Menubar View > Props.


All available Props will show in this 
window. Click the + button in the upper 
right to add a new Prop.  Click on a 
Prop to show it live on the audience 
screen. Once it is triggered, the line the 
Prop is on will highlight in orange.  
Select a Prop by holding the Command 
key and clicking on one or more Props. 
Once selected you can Copy, Paste, and 
Delete the selected Prop(s) by right 
clicking on one of the props, pressing 
the appropriate keyboard shortcut, or 
going to the Edit menu in the menubar.


You can set a transition for your Props 
in the bottom left of this area and open the Props Editor in the bottom right.  
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Props Editor

You can create and edit Props via the Props Editor. Open the Props Editor by 
opening the Props Pane then clicking the Edit Props button at the bottom of 
the window.


Note: The Props Editor is very similar to the Slide Editor. This 
section will only cover parts of the Editor that are unique to 
the Props Editor. For general information about the Editor as 
well as items that are not covered here, please see the Slide 
Editor section.  


Props Editor Interface

There is no Slide Notes feature in the Props Editor.


Prop Tab




When no objects are selected on the Prop in the Editor, the Inspector on the 
right side of the Editor window will show a single Prop tab.


Due to the limited nature of Props, there are four editable options here.


• Name -- Here, you can name the Prop and this is the Label that will 
show on the thumbnail in the Props Pane and also on the left side of 
the Props Pane when the Prop is Live


• Background Color -- Note that using the Background Color in Props 
only affects the Props Editor and Pane to help you to see your content 
better, it will not change the output to the audience screen.
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• Size -- This allows you to set the size of the Prop itself -- typically, this 
would match the resolution of the screen the Prop will be displayed on.


• Transition -- This will control the Transition for the currently selected 
Prop (Slide). Each Prop can have its own Transition, which will trump 
(replace) the Transition that is set in the Props Pane.


Object Inspector

When you have an Object selected on the Prop, two tabs will appear in the 
Editor that are almost identical to those in the original Slide Editor.


Shape Tab

The only difference in the Shape Tab is that the Visibility feature is not 
available.


Text Tab

There is no change in the Text Tab in the Props Editor.


Props Actions

You can quickly add Prop Actions to slides to 
show specific Prop(s) when you click on a 
specific slide.


Add Prop Actions to slides by opening the 
Action Palette and dragging the Prop Action 
onto a slide. When adding or editing a Prop 
Action you will be able to select which Prop you 
want to fire when that slide is clicked.


You can also drag a specific Prop from the area 
in Show Controls directly to a slide to apply it as 
an action on that slide.  


You can have multiple Prop Actions on one 
slide. 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Other Features

ProPresenter has many different features that allow you to modify how you 
create presentations, how you trigger them to your screen and what 
specifically goes into those slides. As you dig into each of these items, you'll 
see new and exciting ways to convey your messages across to those viewing 
your presentations!


The Announcement Layer

The Announcement Layer gives you the ability to have a second 
presentation running simultaneously with your normal presentations for 
your service or show! For example, if you have screens in your lobby that you 
want to send an announcement loop or other content to during a service or 
show, you can use the announcement layer to do that from the same 
computer!


Setting up a presentation to be an “Announcement Presentation” is as quick 
as pressing a button. In the Presentation Header, there is an icon that looks 
like a target that denotes whether the Presentation is seen on the 
Announcement Layer or the Presentation Layer. 
If you click on this button, you will see three options. The first 
is Presentation and is what all presentations have selected by default. The 
second is Announcements. If you choose this, that icon will turn green and 
this presentation will now playback on the announcements layer.  And 
lastly, Edit Looks which allows you to manage which layers of ProPresenter 
are going to each screen.


Now that you have the presentation assigned to the announcements layer, 
you’ll have to tell it to show up on the appropriate screen. This is done by 
setting up an Audience Look to send the proper layers to the proper 
Audience Screens.


Sending to the Announcements and Presentation Layer at 
the same time

To make the Announcements layer run continuously while you are running 
the rest of your presentations, set it up with Go To Next Timers with the last 
slide having the box to “Loop to Beginning” checked.
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Then, you can start that Presentation and then click on any other 
Presentation (that is set to send to the Presentation Layer) and that will send 
to your other Audience Screens while not affecting the Announcements 
Layer.
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Audio Routing

ProPresenter's audio engine allows for inputs from multiple audio devices to 
be routed in to any of up to 16 internal  ProPresenter audio channels. These 
can then be routed out to the channels of a primary audio output device, as 
well as SDI/NDI feeds with separate routing. For example, you can input any 
or all of the channels coming into your computer from a mixing console to 
ProPresenter's internal channels, specify the internal channels used for any 
audio or video played back from ProPresenter, and route these ProPresenter 
channels to the channels of your output device.


In addition to simple default setups (Channel 1 is Left, Channel 2 is Right, 
etc.), ProPresenter is capable of fully customizing your audio setup.


Routing Audio Outputs

You can customize what ProPresenter audio channels go to specific 
channels on your audio output device. In the Audio Preferences pane, you 
first specify the number of channels of audio you want ProPresenter to 
process. Then, clicking on Channel Routing for your main output device will 
bring up a window that allows this custom routing.
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The left side of the Audio Routing window shows you ProPresenter Channels 
based on the number you specified in the channel count. You can click on 
the channel name to rename it if desired. To the right are the channels 
supported by your output device.


Click on the cells where you want the audio to be heard.  For example, if you 
want ProPresenter’s Channel 1 to output to Channel 3 of your output, click on 
the cell at the intersection of those two selections and the box will light up. To 
turn off a cell, click on it again.  Click on the M next to a channel to Mute that 
channel. Click S to Solo that channel. Click T to send a Tone to that channel. 
You can turn these functions on and off for as many channels as you wish, 
which is a great tool for troubleshooting audio signals in your system.


On the top left of the routing windowpane, you can click on the M to mute all 
of the channels. If you have one or more channels solo'd, click the S in the top 
left to turn them all off at the same time. Click on the Mapping drop-down 
and select Auto to automatically route ProPresenter channels to their 
counterparts on the output (1:1: 2:2, etc.). Clear removes all of the current 
routes.


Media played back in ProPresenter can also be routed to specific 
ProPresenter Channels. By default, the audio channels of your media will be 
routed to the corresponding ProPresenter channel (1:1, 2:2, etc). You can 
access individual Audio Routing for a specific Media Action in the Cue 
Inspector's Audio tab (right click on the media action, choose "Inspector", 
then select the audio tab on the right of the inspector window). You will only 
be able to access the Audio tab if the Media Action you're viewing in the 
Inspector has audio embedded within it.
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Just like in the routing for outputs, the inspector's left side lists all of the 
audio channels for the piece of media that is selected. The top lists the audio 
channels that are available in ProPresenter.


Click on the cell of the row/column that you want the audio to play in. Click 
on the Mapping drop-down and select Auto to autofill the cells and Clear to 
remove all of the selected cells.


Routing Audio Inputs

The option for routing audio inputs allows you to use devices such as USB 
audio interfaces and choose how channels of the device are routed to the 
internal ProPresenter channels. 


To set this up, go to the "Input" tab of ProPresenter Preferences and select 
your Audio Input device from the device list on the left.


Select your Audio Input source and you will see all incoming channels from 
the Source appear in the bottom part of the window.  You can then click the 
Routing button to choose what channels from the Input go to what 
channels of your ProPresenter channels. 


Once you open 
the Routing 
window, you’ll 
notice that the 
left side shows 
your Input 
channels and the 
top shows your 
ProPresenter 
Audio channels.  
Selecting Auto 
will match the 
channels up in 
the standard way 
(input channel 1 
routes to 
ProPresenter 
channel 1 and so 
on).  If you wish to 

customize this, 
you would simply click on the cell at the intersection of those two selections 
and the box will light up. 
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Bibles

ProPresenter features a robust Bible browser allowing you to quickly search 
(via passage or keyword), curate, and show to the screen passages out of the 
Bible.


Bibles work off of Templates, so first you will need to create a Template that 
your Bible will use (or you can select one of the example Bible Templates that 
are included with ProPresenter). Once you have selected the desired 
Template you can select the Bible version(s) that you would like to use, then 
search for a passage or keyword. After you find the desired passage you can 
show the passage directly to the screen, or you can save the slides out as a 
Presentation that can be added to a Playlist for easy organization into your 
service.


Bible Pane

The Bible Pane is where you will search for passages as well as set options for 
how the Bibles will look on the screen.


Open the Bible Pane through one of the following options:


• Click the Bible icon in the Toolbar


• Press Control-B on Mac or Control-Alt-B on PC


• In the menubar select View > Bibles


Close the pane by choosing one:


• Click one of the other buttons in the Toolbar (such as the Show, Edit, or 
Reflow View)


• Press Control-B on Mac or Control-Alt-B on PC


• In the menubar select View > Bibles


On the top left of the Bible window is the Scripture Lookup and Search boxes, 
both used to find Bible passages to show on the screen. To the right of the 
search box is the Options button; click this button to customize how the 
Bibles are shown on the screen (such as selecting the Template that is used 
when building the Bible slides). Below the search boxes you can select one or 
more Bible versions to show on the screen. The center area of the Bible 
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window shows thumbnails of the 
slides based on what you have 
entered into the Scripture 
Lookup or Search boxes. Click on 
a slide to show it to the screen.


Note: You cannot directly 
edit slides inside of the 
Bible Window, instead you 
indirectly create and edit 
slides through the other 
features in the Bible 
Window. If you would like to 
directly edit a slide that a 
Bible verse is on, then you 
will need to save the 
slide(s) out as a 
Presentation, as seen below.


In the lower left of the Bible Window is a Save As… button. Click this button if 
you want to save the currently showing slides out as a Presentation or if you 
want to copy them to the current Presentation. When you click this box you 
have three options:


• Save as Presentation will save the currently showing slides out as a 
presentation; this is helpful if you want to edit one or more of the slides 
or you want to create a stand alone Presentation with your Bible slides


• Copy to Current 
Presentation will copy 
the currently showing 
slides to the currently 
selected Presentation; 
use this feature if you 
are creating sermon 
slides and want to 
quickly copy the Bible 
slides to your 
Presentation


• Save to Playlist gives you a sub-menu, allowing you to select one of 
your Playlists; once you do, it will save the currently showing slides out 
as a Presentation and add that Presentation to the currently selected 
Playlist
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Next to the Save button is the Transition feature of the Bible Window. This 
feature controls how the Bible slides will transition onto and off of the 
audience screen. This transition is specifically used when the slides are 
clicked in the Bibles window. If you save a Presentation from Bibles, that 
presentation would then use the default Presentation transition set in the 
Slide View Area. The Transition feature is covered in depth in the Transition 
section of this User Guide.


Across the bottom of the Bible window are the <Verse and Verse> buttons. 
When you click on one of these buttons it quickly adds one verse either 
before or after the currently showing verse(s). For example, let's say you have 
Psalm 115:5-7 currently selected; clicking the <Verse button will add the 
previous verse to the selection, making the selection Psalm 115:4-7, whereas 
clicking the Verse> button would make the selection Psalm 115:5-8.


Note: These **Add Verse** buttons are also available if you use 
the Save feature to save a Bible verse out as a Presentation.


Buttons on the bottom right of the Bible Window control how the 
thumbnails are shown in the center area. You can toggle between the Grid 
View (shows all slides in a grid) and Table View (shows slides in a column 
with the text of each slide to the right of the thumbnail) by clicking on the 
appropriate button. Click and drag the slider to control how large the 
thumbnails appear in the slide area.


Scripture Lookup and Search

There are two primary ways to search for a Bible passage: by looking up the 
Bible reference itself, or by doing a text search of the text of the Bible.


Scripture Lookup

You can use the Scripture Lookup box when you know the passage (book, 
chapter, and verse) that you want to reference. One option for searching this 
way is to type the reference into the Scripture Lookup box; for example you 
can type in Matthew 1:2-3 and it will return those two verses.


Tip: Don't know how to spell a book's name? Don't have time to 
type all of the extra punctuation? No worries! ProPresenter will 
take what you type and do its best to figure out what you mean. 
For example, if you type out "Ephes 2 4 6" it will return 
Ephesians 2:4-6.
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The other way to use the Scripture Lookup is to use the drilldown menu. Click 
on the down arrow on the right side of the Scripture Lookup box and 
manually navigate to the reference you are looking for.


Tip: Using the drilldown menu you can select one verse, one whole 
chapter, or even an entire book! If you use the drilldown menu 
and want more than one verse, then either click on the chapter 
number to get back the entire chapter, select one verse then use 
the Add Verse buttons at the bottom of the Bible Pane to add a 
few verses to your selection, or select one verse then manually 
change the Scripture Lookup box to match what you are looking 
for.


Search Box

You can also contextually search your Bibles to find a specific passage based 
on text.


Type in a word in the Search box and press return/enter. You will see a 
window appear with a list of all of the instances that that word appears in 
the currently selected Bible. Find the passage you would like to show on the 
screen, then on the right side of the scripture reference click 
either Verse or Chapter to generate slide(s) with only that one verse or the 
whole chapter that the verse is contained in.


Note: If you have more than one Bible selected in the Bible 
Version section of the Bible Window, by default it will search 
the one that is listed first. If you would like to search one of 
the other Bibles, click the down arrow that is inside of the 
Search box to select a different Bible.


Bible Options

Use the Options button in the top right of the Bible Window to control how 
Bible will render the verses onto the slides as well as to install new Bibles.


Click on the Options button to open the Options window, then click 
either Slide Options to control how ProPresenter will render the verses or 
the Bible tab to install Bibles.
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Slide Options

The Slide Options tab of Options allows you to control how ProPresenter will 
present the slides on the screen.


Click on the down arrow next to Theme to control which Theme slide will be 
used when rendering the text.


On the top left of the Slide Options window there are several options:


• Show Verse 
Numbers will 
toggle the 
inclusion of 
the verse 
numbers 
within the 
text that is 
being shown


• Break on 
New 
Verse will, if 
checked, only 
have one verse per slide (instead of filling the text box and then 
breaking to a new slide)


• Display Translation will, if checked, include the abbreviated version 
name in the Bible reference; as an example: "Matthew 1:2-5 (NIV)"


• Preserve Font Color will keep the font color of the Bible if present 
(useful for Bibles that have Jesus' words in red letters)


The top right options control how (if at all) the scripture reference will be 
included.


• Verse References is only available if Break on New Verse is selected 
and will show each individual verse with each slide (IE: Matthew 1:2, 
Matthew 1:3, Matthew 1:4, etc.)


• Passage Each will show the entire reference (IE: Matthew 1:2-5) on every 
slide


• Passage Last will show the entire reference (IE: Matthew 1:2-5) only on 
the last slide


• No Reference will hide the scripture reference
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Note: If you have a Reference text box selected then the 
scripture reference will be included in that text box. If no 
Reference text box is included, then the scripture reference will 
be included as a separate line at the bottom of the Verse text 
box.


At the bottom of the Slide Options window, select the Import Library which 
is the Library that your Bible verses will import into if you create a new 
Presentation with Bible verses.


Downloading and Installing Bibles

You can download, install, and manage installed Bibles via the Bibles tab of 
the Option window.


Click on the Purchased tab 
to see available paid Bibles 
and the Free tab to see 
available free Bibles.


Note: To see Purchased 
Bibles you must first 
register ProPresenter.


Scroll up and down either of 
the tabs to find the Bible 

you are looking for. Click the Install button to install the Bible. If you have 
already installed a Bible, click the Remove button to delete the Bible from 
your computer.


Bible Themes

ProPresenter uses the Theme feature to format and render Bible slides. You 
can set up as many Template Slides as you want, and, while any Theme can 
be used for rendering Bible slides, there may be reasons to format Template 
Slides that will be used for Bibles slightly differently.


When you are setting up a Template Slide for use with the Bible feature, 
remember that you will need a text box for the text of the Verse and, 
optionally, a separate text box for the scripture Reference. If you are using 
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multiple Bible versions at once, you will want a separate text box for each 
Verse as well as (optionally) a text box for each Reference.


Tip: Remember that in ProPresenter, all Objects are Text Boxes, 
so even simple shapes on the Template Slide can be selected as 
containers for your text.




Once you have set up your Theme to have one or more text boxes/objects, 
you will need to select this Theme to be used by the Bible feature. Open the 
Bible tab, click on the Options button on the top right, click on the Slide 
Options tab, then at the bottom of the window select the Theme that you 
would like to use.


You will now need to assign your Verse(s) and Reference(s) to the desired text 
boxes/objects. At the top of the Bible window, on the left select the desired 
version from the dropdown menu that contains all of the versions that are 
installed on your computer. Next, click the dropdown next to Verse: and 
select which text box/object you would like your verse text to appear in. 
Optionally, next to Reference: select the text box/object that you want the 
scripture reference to appear. For Reference, you can also select With 
Verse if you'd like the Reference to appear in the same text box as your verse 
with the same formatting.


Multiple Bible Versions

ProPresenter allows you to show multiple versions of the Bible on one slide 
without having to copy and paste text on every slide. This is perfect for multi-
lingual churches, as well as churches that want to compare and contrast 
multiple Bible versions.
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First you must have more than one Bible version installed on your computer. 
Next, just below the Options button on the top right, click on the + to add 
additional Bible versions. You can add multiple versions, limited only to the 
number of Bibles that are installed on your computer.


You can now click the dropdown boxes on the left to select which Bible 
versions will be used and click the dropdown box next 
to Verse: and Reference: to select which text box/object will be used for each 
section. You will likely want to create a custom Template with multiple Text 
Objects to set for the verses of the different translations.


Click the - button to remove a Bible version.
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Calendar

The Calendar allows you to schedule Presentations inside of Playlists to fire 
at specific times of the day, specific dates, and/or reoccurring days of the 
week. This feature is great if you want a countdown to start five minutes 
before an event or if you want a slideshow to change at a specific time, just 
to name a few examples.


To open the Calendar window:


• Press Control-Option-C 
on Mac or Control-Alt-C 
on PC


• In the menubar 
click View > Calendar.


To toggle all Calendars on or 
off:


• Click the Calendar 
Enabled checkbox 
across the top of the 
Calendar window;


• Press Command-Option-S on Mac (there is no keyboard shortcut for 
this function on Windows)


• Select Calendar > Enable Calendar from the menubar.


The left side of the window will list all of your Events and the right side shows 
you information about the currently selected Event. If there is an Event that 
is currently active, you can select it by clicking the Go To Current button.


The Show/Hide Reoccurring Events button toggles how repeating Events 
are shown in the left pane of the window and looks different based on what 
is currently being shown: this can be set where only one copy of each Event 
will be shown or where every occurrence of a repeating Event will be shown.


Events

An Event is a single or reoccurring Action that fires at a given day and time. 
You can assign a specific Playlist or Presentation within a Playlist to fire at 
the designating date and time; think of it as the program clicking on the first 
slide of a Presentation for you at a specific time.
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To create a new Event:


• Click on the + button in the bottom left of the Calendar window;


• Press Option-Command-N on Mac


• From the menubar select Calendar > New Event.


To delete an Event, select it in the Calendar window and press the delete key 
or, if you have a trackpad, you can use two fingers and swipe to the left on 
the name of the Event and then click Delete.


If you are deleting an Event that has more than one occurrence it will ask 
you if you want to delete only that one occurrence or all occurrences of the 
Event.


You can customize an Event’s Name and Description at the top of the 
Calendar window when an Event is highlighted by simply single clicking on 
these headers. Below that is where you set the Event’s scheduled time 
to Start; each Event must have a date and a time that it will become active.


Next to Repeat you can select days of the week that you want the Event to 
repeat. If you select one or more days of the week then you can optionally set 
a date and time for the Event to End On.


At the bottom of the window you can select the Action which will control 
what happens when the Event fires; you can select a Playlist or a specific 
Presentation within any Playlist. Click on the Test button to immediately see 
what will happen when the Event activates. If you select a Playlist, the 
Scheduler will trigger the first item in the Playlist. If this is a Presentation, it 
will fire the first slide.
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Communications

ProPresenter provides connectivity to external devices via network or serial 
communications according to what the protocol supports. There are a 
number of different protocols which can be organized into three groups 
including the following: AMP, VDCP, Sony BVW, GVG100, Sony BVS, 
GlobalCache, RossTalk, DMX, and MIDI.


The Windows version of ProPresenter offers Midi Communication only while, 
Mac offers Midi and all other protocols discussed below.


To add any of the available protocols to ProPresenter, click on the Add 
Device button in the lower right corner of the Devices tab of ProPresenter 
Preferences and select the protocol from the list. Each protocol has unique 
configuration settings. We have set each protocol to use the standard 
configuration as specified by each manufacturer. If your configuration 
requires different settings you will need to refer to the documentation for the 
device you are connecting to with ProPresenter. The screenshot below shows 
GVG100 as an example.


After you have added a protocol, you will see a box that shows you the active 
protocols. You can connect or disconnect any protocol, or remove it, from 
here. If you need to change the settings for a protocol, click on the gear icon 
to open the settings menu.


Click on MIDI Setup or DMX Setup to modify these protocols.


The following screenshot shows several of the protocols listed at the same 
time. ProPresenter is capable of supporting more than one protocol at the 
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same time, within reason. Some protocol combinations don't make sense to 
run at the same time, like AMP and VDCP, but some do like AMP and 
RossTalk.


Midi Communication

The MIDI configuration allows you to auto-fill all the commands from a 
starting note, or you can assign any MIDI note to a given command. You 
must ensure that you don't assign the same MIDI note to multiple 
commands since this will result in undefined behavior.


Click on the Device menu in the lower-left corner of the Devices tab of 
Preferences and add a new MIDI device. Select the correct device that you 
have setup to be used with your computer. Click Save and 
then Connect after you have finished configuring the rest of the MIDI 
settings.


Click on the MIDI Map button to open the MIDI communication settings. 
MIDI notes range from 0 to 127. Entering a number next to Auto Fill and then 
clicking the button will fill all of the values beginning with your chosen value. 
If you want each section to start at a different, type your starting value in the 
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first box of each list and then click the Auto Fill using the first value in each 
Form button at the bottom.


MIDI values cannot be shared 
between commands. For 
example, you could not assign 
All: 48 and Next Playlist: 48 at 
the same time.


ProPresenter also allows any 
slide to have a MIDI cue 
attached to it which will 
generate a MIDI note when that 
slide is clicked.


To add a MIDI cue, right-click on 
a slide and select Add Cue > 
Communication Cue > MIDI and 
select either MIDI Note On or 
MIDI Note Off. For each MIDI 
cue, you can specify the MIDI Channel, Note and Intensity.


DMX Communication (Mac Only)

The DMX configuration allows you to define the starting channel and 
displays how the other channels are mapped. DMX supports ArtNet over a 
network only. USB-DMX 
interfaces are not 
supported. The 
screenshots below show a 
standard DMX setup. 
These values are entered 
by clicking on the DMX 
Setup button in 
ProPresenter 
Preferences>Devices.
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Playback Deck/Media Server Control 
Protocols (Mac Only)

These protocols include AMP, VDCP, and Sony BVW. AMP and VDCP are 
media server protocols that have more capabilities than Sony BVW such as 
triggering clips by name. BVW can only control the playback of an already 
triggered clip.


Switcher Control Protocols (Mac Only)

These protocols include GVG100, Sony BVS, and RossTalk. These protocols 
can control a switcher, allowing you to remotely enable and disable keys or 
fade to black.


Sony BVS is preferred over GVG100 when available since it has greater 
capabilities. RossTalk is a proprietary protocol supported by some Ross 
switchers. RossTalk is the preferred choice for a compatible Ross switcher 
because it uses network communication rather than serial. RossTalk is 
supported as 2 modes, Device and Controller. In Controller mode, 
ProPresenter can send commands to a connected Ross switcher. In Device 
mode, RossTalk provides some control of ProPresenter from a compatible 
Ross switcher. For Device mode, the Ross switcher is setup to connect to 
ProPresenter as if it were an Expression CG machine. Once connected, Up/
Down on the switcher will advance through the items of the selected playlist, 
and next will trigger slides or videos just like pressing the spacebar/right 
arrow key on the ProPresenter machine. Note that if you want to use both 
Controller and Device modes for RossTalk, you must configure 2 RossTalk 
devices, one for each mode as these modes require two different network 
connections.


Page  of 151 193



Copyright Display

ProPresenter makes it easy to display copyright information for songs. When 
you import a song from SongSelect, the data is automatically filled in. If you 
create your own song files, you can manually enter the copyright 
information if you want to. To show Copyright Information, you must 
have Show House of Worship Integrations enabled in the General tab of 
Preferences.


There are two places that you need to configure copyright display. The first 
place is in Preferences at the bottom of the General tab. These are the global 
settings that apply to every presentation in the library. As you can see, you 
can choose to show the copyright information on the first, last, first and last, 
or every slide of your presentation. The second place this must be enabled is 
in the Slide Editor in the Presentation tab.


The License # box on the right is for you to enter your church’s unique license 
number. You will need to contact CCLI for this number if you aren’t sure what 
it is.


To change the copyright elements that are shown (Title, Artist, publishing 
information, etc.) click on the CCLI Layout... button. This will open the options 
shown below.


Each of the copyright 
elements are 
controlled by “Tokens," 
a feature in 
ProPresenter that 
allows text from one 
part of the program to 
be automatically 
shown by a different 
feature. The tokens on 
the left are the active 
tokens, meaning these 
are the ones that will 
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be shown. The column on the right shows all of the options available. You 
can add and remove tokens from the left column by clicking and dragging 
them in and out of the right column.


Clicking on Edit Template will open the CCLI Editor and allow you to format 
the position and text settings for your copyright information. Since tokens 
aren’t actually text, the only thing you’ll see in the text box is the copyright 
symbol. If you want to see how text will look formatted, add any text you 
want since this will be replaced automatically.


Once you have configured how you want your copyright information to be 
displayed, you will need to make sure a presentation has information to 
display and that it’s enabled. The Copyright section of the Presentation tab 
of the Slide Editor allows you to set, change, and show the copyright 
information for the selected Presentation. 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Localization

ProPresenter offers you the ability to operate the software in ten different 
languages:  English, Spanish, Portuguese, French, German, Korean, 
Norwegian, Russian, Chinese and Czech.  


To activate the program in these languages, simply change the language 
setting on your OS and ProPresenter will launch automatically in that 
language if it's one of the eight languages above. If your language is not 
listed above or another language is selected on the OS, the program will 
default to English.  


For Windows users, due to the way Windows handles certain languages, 
changing the system language may actually cause ProPresenter to run in a 
different language than you may expect. If this occurs for you, simply go to 
the General tab of ProPresenter Preferences and you can select the 
language you want to run ProPresenter in. This option will work without 
needing to install the Microsoft language pack for the selected language. 
Open Preferences. Select General. Choose your language from 
the Preferred Language menu at the bottom. You will need to restart 
ProPresenter for the change to be applied.
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Masks

The purpose of a Mask is to allow you to “mask” (or cover up) a part of your 
output to create custom projection screens or to keep the projector from 
projecting onto something that you don’t want it to. The Mask is shown on 
the topmost layer of an Audience Screen.  


Enabling a Mask

Masks are enabled by using an 
Audience Look to set a certain 
Look for your Audience Screen. 
You can select which Mask you 
wish to use for each individual 
screen there. If you would like to 
create a new Mask, you can 
click Add New Mask or Edit 
Masks to access the Masks 
Editor.


Mask Editor

You can create and edit Masks via the Mask Editor. Open the Mask Editor by 
opening the Audience Looks Pane and then in the Mask dropdown menu, go 
to Add New Mask or Edit Masks


Note: The Mask Editor is very similar to the Slide Editor. This 
section will only cover parts of the Editor that are unique to 
the Mask Editor. For general information about the Editor as well 
as items that are not covered here, please see the Slide Editor 
section.


Mask Editor Interface

There is no Slide Notes feature in the Mask Editor.


Mask Tab

When no objects are selected on the Mask in the Editor, the Inspector on the 
right side of the Editor window will show a single Mask tab.
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Due to the limited nature of Masks, there are two editable options here.


• Name -- Here, you can name the Mask and this is the Label that will 
show on the thumbnail in the Mask dropdown in the Audience Look 
Pane.


• Size -- This allows you to set the size of the Mask itself -- typically, this 
would match the resolution of the screen the Mask will be displayed on.


Object Inspector

When you have an Object selected on the Mask, two tabs will appear in the 
Editor that are almost identical to those in the original Slide Editor.


Shape Tab

The difference in the Shape Tab is that the Visibility, Shadow and Stroke 
features are not available.


Text Tab

The only difference in the Text Tab is that the Linked Text feature is not 
available. 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Recording and RTMP Streaming

With the release of ProPresenter 7.1 comes the introduction of a Capture 
option for screen recording and streaming over RTMP.  The later release of 
ProPresenter 7.3 adds the option to stream with our partner, Resi.  More 
information on this is below in the Streaming with Resi section.    


Recording a screen from your ProPresenter output can be done with just a 
few simple steps of setup.  To access the Capture settings window, go to 
Screens>Capture Settings in your menu bar or click on the Live button in 
the Preview window.  The window that opens will allow you to set the 
parameters of your recording. 


The Capture Settings window offers you the options to set the parameters for 
your output recording.  Below we'll highlight each option in this window.  This 
first example explains how the settings will look to simply record your output 
and not stream to an RTMP server.  


• Source:  This is the screen that you wish to capture from your Screen 
Configuration window.  You can capture any currently set Audience or 
Stage screen.   At this time, this is a single source, so you can only 
capture one ProPresenter screen at a time.


• Destination:  This is where you select if your recording will be saved as a 
video file or sent out via an RTMP stream.  This is selected as recording 
only here.                          


• Save To:  Here you will select where you want the recorded video file to 
save.  You can select the Desktop, Documents, or Movies/Videos folder 
by default or browse to choose another location to save the file.  


• Codec:  This is the codec that your video file will be encoded in.  
Typically, H.264 is the most widely used option, but other codecs may 
be used to create a larger or higher quality video option.  
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• Resolution:  This is where you will set the resolution size of your video 
file.  We would recommend matching this resolution to the resolution of 
the screen you are capturing.  Typically, this is 1920x1080 or 1280x720, 
but there is also an option to set a custom resolution.


• Frame Rate:  Here you can set the Frame Rate of your recording -- 
again, the best setting here varies on how you will be playing this back 
and what needs you have.  If you are inputting a video input into the 
program, we recommend using the frame rate of that video input.  


We’ll now look at the Capture Settings window if you are looking to stream to 
an RTMP server.  You can even still record the screen that you’re streaming at 
the same time. 


• Source:  This is the screen that you wish to capture from your Screen 
Configuration window.  You can capture any currently set Audience or 
Stage screen.       At this time, this is a single source, so you can only 
capture one ProPresenter screen at a time.


• Destination:  This is where you select if your recording will be saved as a 
video file or sent out via an RTMP stream.   This example is setup for 
streaming first.  At this time, this is a single destination option, so you 
can only send to one RTMP server.


• Address:  This is the server URL that you are streaming to from your 
streaming provider. 


• Key:  This is the key that you'll need to retrieve also from the streaming 
provider allowing you to stream live from the program.  


• We recommend reaching out to your provider if you don’t know 
how to obtain this key
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• Encoding:  Here you can set the resolution and frame rate of your video 
stream.  We would recommend matching this to the resolution of the 
screen you are capturing and based around your internet upload 
speed.  


• Save Local Copy:  Enabling this option will allow you to also save the 
stream as a video file.  


• Save To:  This option will appear when Save Local Copy is enabled and 
you can select where you want the recorded video file to save.  You can 
select the Desktop, Documents, or Movies/Videos folder by default or 
browse to choose another location to save the file.  


Either way, once you have your settings in place, you can either click Start 
Capture to immediately begin the capture or close out of this window.  You 
can then go back to start a capture in the Screens menu by going to 
Screens>Start Capture.  


When you begin the Capture, a progress indicator will appear in the upper 
right of your Preview window. 


If you are streaming, there are 
three colors the indicator can be 
depending on the status of your 
streaming connection.  The 
indicator will typically be green as 
that means the connection is 
properly streaming and there are 
no interruptions through 
ProPresenter.  If the color is yellow, 
this is a warning that the stream 
is dropping frames.  If the color is 
red, this signals that your network 
connection has been lost or the 

stream has been stopped for another reason.  This check happens on a 
regular basis and we recommend watching this indicator to confirm the 
health of your stream.  


Once you are finished streaming, you can stop the capture through either 
clicking on the indicator in the Preview window and going to Stop Capture, 
going to the Screens menu>Stop Capture, or through the Stop Capture 
button in the Capture Settings window.   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Streaming with Resi

With the release of ProPresenter 7.3, Renewed Vision has partnered with Resi 
and their resilient streaming platform to allow for another option in 
streaming your screens.  Resi allows for you to simultaneously stream directly 
from ProPresenter to your website, Facebook, YouTube, or other platforms. 
Once you have created your account with Resi and started the account 
setup process on their site, streaming from ProPresenter to the Resi platform 
is a somewhat simple process. 


Setting up your Resi Account

You’ll first want to log in to your Resi 
account inside of the ProPresenter 
Preferences window. Click on the Resi tab 
and then click the Login button. The login 
process uses your Resi username and 
password.  If you don't have a Resi account 
yet, click on Need an Account? to head to 
the Resi website and get that setup.


If this is the first time you’ve used this 
computer for Resi integration, you will 
be prompted to enter a name for the 
Encoder. The "encoder" in this case, is 
the computer on which you are 
running ProPresenter and streaming to 
Resi. Typically, we recommend entering 
the room name or location that this 
computer will be operating from, but it 
could be any description that would 
identify this computer. 


Once set up is complete, the Resi Plug-In will begin installing so ProPresenter 
and Resi can communicate and you can begin streaming!  You'll see the 
Preferences window change once this is complete.  


The Capture Settings Window

Now that you’ve gone through the initial settings of your account, you can 
move to the Capture Settings window to get started with streaming. There 
are several ways to get to the Capture Settings window:
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• Click on the option in the Resi tab of ProPresenter Preferences


• Click the Live button in the upper right of the Preview window,


• Go to Screens>Capture Settings in the menubar. 


Each of these options will bring up the settings in place for video streaming. 


This window may be familiar to you if you’ve previously done any capture to 
disk or RTMP streaming from within ProPresenter 7. Here, you will select the 
Destination setting to be Resi. Once you’ve done this, you will see a list of 
options appear. 


• Source: This is the ProPresenter screen that will be streamed to Resi — this 
can be a dedicated Screen that is only for the stream itself, or a screen that 
is used for other purposes in ProPresenter. You can pick/choose what layers 
are active on this Screen in the Audience Looks window. 


• Event Name: This is the name of the stream that will appear within Resi's 
Control Center, as well as on Facebook and YouTube streams. This field is 
optional, and if left blank will use the name chosen for the Destination 
Group. 


• Destination Group: Here you will select what Resi Destination Group will 
be used for the stream.
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• Resolution: This dropdown allows you to select the preset for video format 
and bitrate which will be used for streaming. For best quality and 
performance, select an option that matches the output display resolution 
set for your screens in the Screen Configuration window. If there is not an 
exact match, select the option that most closely matches the output 
display resolution. 


• Audio: Here, you can route the audio from ProPresenter to your Resi 
stream. At this time, the stream audio is limited to two channels (left and 
right). — Audio is encoded in a stereo configuration at 128kbps using an 
AAC codec at a sample rate of 48kHz. 


Starting your Stream from ProPresenter

You can begin streaming with the settings chosen three different ways:


• Click Start Streaming from the Capture Settings window


• Use the Live button in the Preview window


• Choose Screens>Start Streaming in the menubar


Once you’ve started streaming, video that will be streamed on the web will 
begin encoding immediately and uploaded to Resi servers for re-encoding 
and transmission to the destinations specified in your Destination group.


When you begin the Capture, a progress indicator will appear in the upper 
right of your Preview window. There are three colors the indicator can be 
depending on the encoding process and the transmission of the stream to 
Resi's cloud.  


• Green: this means the 
connection is properly 
transmitting video content 
and there are no 
interruptions.  


• Yellow: This is a warning 
that the capture is 
dropping frames.  


• Red:, This signals that your 
network connection has 
been lost or the capture 
has been stopped for 
another reason. 
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The stream status is monitored on a regular basis, so we recommend 
watching this indicator to confirm the health of your stream.  


Once you are finished streaming, you can stop the capture by either clicking 
on the Live button in the Preview window and choosing Stop Capture, going 
to the Screens menu>Stop Capture, or through the Stop Capture button in 
the Capture Settings window.  


Remote Streaming through Resi Control

Resi streams can also be started from within the Resi Control Center once 
you’ve set up your Capture settings within ProPresenter and created the 
proper Destination Groups on the Resi Control interface. In addition, you can 
set schedules for your streams to start at a given date and time. 


When a stream is initiated by Resi Control (whether by hitting the "Start" 
button for the encoder or because of a scheduled event), the ProPresenter 
operator will see a notification when streaming is set to begin. This notice 
gives 15 seconds for the operator to either cancel the stream from starting. 
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Timeline

The Timeline allows you to sequence and playback your slides with or 
without an audio track. This makes it easy for you to create presentations 
with custom timings between slides or to record the slides to match a song. 
The ability to sequence slides with music is especially useful for worship 
leaders who don’t have a band or someone to run lyrics for them since the 
song and lyrics can be started with a single click.





You can open the Timeline for a given Presentation by clicking on the 
Timeline button in the Presentation header.


There are two ways to add slides to a Timeline. The first is to drag the 
thumbnails from the presentation to the Timeline. The second way is to click 
the Record button and record the slides live. Recording a Timeline is 
specifically helpful if you're looking to link the slides to an audio track.




Audio files can be added to the Timeline by dragging a file from the Audio 
Bin or dragging a file from the computer to the Timeline. After you have 
added an audio track, you’ll see a solid green bar with the song name added 
below the slides.
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You can right click on the audio track to access a few menu options. You can 
go to the Inspector... which allows you to modify the Audio Cue itself. You 
can also Remove or Replace the audio track here if needed.


To record the slides live, click on the Record button to ready the timeline for 
recording, then press the play button when you are ready. If you have added 
an audio file, the audio will begin playing. To record slides to a Timeline, click 
on the slides like you normally would when going through a presentation. 
When you have finished recording a presentation, click the record and 
playback to stop the recording. If you need a Timeline to loop, click on 
the Loop button to the right of the Record button.


Page  of 165 193



Transitions

ProPresenter has a robust Transition feature that allows for media and 
slides to be transitioned to and from the screen in many creative ways.


Tip: Generally speaking, if you see a Transition icon colored 
orange then it is in reference to a transition that affects the 
Slide Layer, whereas purple icons represent the Media Layer.


Transition Hierarchy

The first important concept for Transitions is the hierarchy of how 
ProPresenter decides what transition to use.


Let's start with talking about slides and how ProPresenter decides what 
transition to use when you click on a slide:


• Master Slide Transition: Across the bottom of the Slide window there 
are three transition buttons which determines the Master Slide 
Transition; think of this as a "default transition" that all slides will use 
unless there is reason to use a different transition


• Presentation Transition: Across the top right of the Slide window there 
is another, similar button which determines the Presentation Transition; 
if this is set then all slides in this Presentation will use this transition, if 
this is not set (if it is set to the Default position) then slides in this 
Presentation will default back to the Master Slide Transition


• Individual Slide Transition: Each slide can have its own Transition 
(added by right clicking on a slide and choosing Transition); this setting 
will override any Presentation Transition as well as the Master Slide 
Transition


The hierarchy for media is very similar:


• Master Media Transition: Across the bottom of the Media Bin (or the 
bottom of the Slide window if the Media Bin is closed) is the Master 
Media Transition; this is the default transition for all media


• Individual Media Transition: All Media Actions (be it in the Media Bin 
or as an Action added to a Slide) can have their own transition which 
trumps the Master Media Transition. This is set in the Media Cue 
Inspector.
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There are other features of ProPresenter where you may see the Transition 
feature, but they all follow similar rules as have been laid out here.


Transition Window

There are many features that use Transitions in ProPresenter, and thus there 
are many ways that you can open the Transition Window. For example you 
can click the Master Slide Transition button across the bottom of the slide 
view.


With the window open, click one of the transition thumbnails to select it. 
Scrub your mouse over a Transition thumbnail to see a preview of that 
Transition.


On the top left of the Transition window there is a dropdown menu where 
you can select a subset of transitions to view. Type a phrase in the Filter field 
to search for available Transitions. In addition to an organized list of 
available Transitions there is also at the top of the list your Favorite 
Transitions and Recent Transitions. (To clear your Recent Transitions, click on 
Clear to the right of the Recent Transitions section.)


With the exception of the Cut Transition, all Transitions allow you to set their 
Duration, and many Transitions have other parameters that you can adjust. 
Click Reset to Default Parameters to reset all of the parameters to their 
default setting. Click on the star to create a Favorite Transition.
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If you want to disable a Presentation Transition (so that all slides in that 
Presentation use the Master Slide Transition), click the word Default in the 
upper left of the transition window.


Favorites

You can set up multiple Transitions to be your favorites so that you can 
quickly use them throughout the program. To create a Favorite, select a 
Transition, set the parameters as you would like, then click the star icon to 
add it to the Favorites list.


Tip: You can have the same transition type multiple times as 
favorites (say, with different parameters); just create a 
favorite as normal, then select the transition again in the main 
Transition window and you can select the star again to create 
another copy of that type of transition.


To change the name of a favorited transition, select that transition and, on 
the right above the large preview window, click on the name of the 
transition.


After selecting a favorited transition, click the star on the top right to create a 
copy of that favorited transition ("Save As") or to Remove (delete) that 
transition. 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Preferences

ProPresenter has a large grouping of Preferences inside of the program that 
can affect/change how you use the software in many ways. It’s likely that you 
will need to make very few changes to your Preferences beyond the initial 
setup. Preferences are accessed by pressing Command-Comma on a Mac or 
Control-Comma on a PC, or clicking on the ProPresenter menu and selecting 
Preferences.  As of 7.3, you will see a Preferences menu in the ProPresenter 
menu that lets you select the specific tab you wish to open.  
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General Tab

The General tab of Preferences features different General settings of the 
program, the logo and Copyright settings (if House of Worship Integrations 
are enabled)


Show House of Worship Integrations toggles the visibility of certain icons/
features that are exclusive to Houses of Worship. The icons/features that are 
hidden include the Renewed Vision Media Store, Bibles, and the Planning 
Center Online Integration. It also will hide the integration with CCLI 
SongSelect in the QuickSearch window and Copyright Display options lower 
in the General tab of ProPresenter Preferences. All these are hidden in the 
toolbar and from the menu bar options.


Share Crash Reports turns on the ability for the program to send crash 
reports to the Renewed Vision team when your program has an issue. If you 
check this section, the application will attempt to submit crash reports when 
the application fails to work properly.


Share ProPresenter Analytics allows the Renewed Vision team to 
anonymously collect data on how you're using the program to empower 
future feature updates and improvements.


Under Logo, click on the box to load a computer dialog box to browse your 
machine for an image file. Having your organization’s logo or other image 
here provides you with something to display in case of an emergency. Once a 
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logo is set, a Clear to Logo button will appear in the Preview window in the 
upper right of the program, as well as, in the Actions menu. Clicking this 
button will clear the Slide Layer and send your Logo to that layer. To change 
the logo, simply click on the box showing the logo thumbnail to bring the 
computer Browse window up again and select a new logo.


Copyright is a section that allows you to choose whether to enable showing 
Copyright information, where it will show and "how" it will show. This section 
will only appear if Show House of Worship Integrations is enabled. You can 
learn more about this in the Copyright Display section.  


For Mac users, there is an option here for Render Mode where you can 
enable Metal Rendering.  This is currently a Beta feature in the software 
allowing you to use Metal for rendering your outputs.  Metal allows your GPU 
to accelerate your graphic output and this should be used for testing 
purposes at this time.  


Windows users will see an option here for selecting the preferred language 
they wish to run ProPresenter in.  More on this is available in the Localization 
section.  
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Screens Tab

The Screens Tab allows you to setup certain factors about your screens that 
you've setup and have a quick link to open the Screen Configuration window.


If you enable Automatically Enable Screens at Launch, this will cause any 
graphic outputs to toggle on the Stage and/or Audience Screens assigned to 
them when the program launches. Unchecking this option will mean you'd 
need to manually toggle on your screens by hitting the buttons in the 
Preview Window or by using Command+1 on Mac or Control+1 on Windows 
for Audience Screens and Command+2 on Mac or Control+2 on Windows for 
Stage Screens.


Show Performance Statistics on Screen allows you to see how many 
frames per second your screen is running at as well as the amount of video 
memory being used by the computer. This is an advanced setting to help 
diagnose additional data on your outputs and should not typically be 
displayed during a show.


Enabling Ignore Background Colors will render all slides without the set 
presentation or slide background colors from the Editor. This is especially 
helpful if you've set a bright background to see black text on your slide 
thumbnails, but don't want that Background Color to show through to your 
Screens.


If you use Keynote or PowerPoint for some of your presentations, you can 
enable Show Keynote & PowerPoint screens for the output window from 
those programs to show on top of your ProPresenter screens when you 
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trigger a show in their software.  At this time, this is a Mac only feature, but 
we hope to add this on Windows in the future.  


At the bottom of the window, click "Open Screen Configuration..." to open 
the Configure Screens window and setup your Outputs/Screens.
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Import Tab

The Import Tab customizes the defaults used when a piece of media is 
imported. 


Under Scaling, select which Scaling Behavior will be used any time a piece of 
media is imported into ProPresenter. This can be selected for both 
a Foreground or Background.  


In the Image section you can select whether you want the Action to behave 
as a Foreground or Background, the default Duration that the Action will 
have (you can set it to a constant Time, a Random Time, or None) and it's 
default Next Behavior to control what will happen after 
the Duration finishes.


The Video section lets you select if the Action will behave as a Foreground or 
Background and the Playback Behavior you wish for it to take of Loop or 
Stop. If you choose Stop for the Playback Behavior, the options for End 
Behavior and Next Behavior will enable where you can choose what you 
wish the action to do once it's finishes playing and what you would like to 
happen next on the screen. The Next Behavior will only apply if you are 
triggering content from the Media Bin specifically.


The Audio section has one option allowing you to choose what happens for 
the Playback Behavior of the file. You can choose for it to Stop, Loop or Next. 
Choosing Next will only work if the file is played back directly from the Audio 
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Bin, but Loop and Stop will follow this behavior in the Bin or when added as 
an Action on a Slide.
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Groups Tab

Groups are used to help you organize your slides in a song or presentation. 
You can add new labels and set their color here in Preferences. 


Click the plus icon to add a new label. Select the label name or right click on 
a Label and press Delete to remove a label. You can also set any color you 
want for your label.


A set of pre-made Group Labels and Slide Labels are included with the 
program by default.


Group Labels are used with the Arrangement feature of ProPresenter. Group 
Labels can also be used to add Hot Keys automatically to your presentations. 
Hot Keys can be used to jump to a certain slide just by using your keyboard.


Slide Labels can be used to add short notes to your slide. Group Labels are 
generally used for songs to organize stanzas and to make it easier to 
arrange your song. A slide can have both a Slide Label and a Group Label.  
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Input Tab

The Input Tab allows you to set both Audio and Video Inputs into the 
program and choose how they will operate in the program.  


Video Input


To add an input, click on the + button next to Video on the left column and 
you’ll see an Input added.  You can name this Input either by single clicking 
on the Name or entering the Name in the main section of the window.  This 
name will be used in the Description of the cue in the Video Input Playlist of 
the Media Bin.  Should you need to remove one of the Inputs you create, you 
can right click or swipe the Input in the left column to delete it.  


Once an input is added, you can link it to a device.  ProPresenter accepts 
inputs via USB and Thunderbolt devices, SDI, Syphon (Mac Only) and NDI.  
Each of the connected and available devices will show in the Device 
dropdown menu.  Once you select a device, a preview of your input will 
appear in the bottom part of that window.  Devices that allow for auto-
detection of their frame rate and resolution will display this information in 
the upper right corner of the preview window.  If your device does not auto-
detect a mode, you will see a box appear to manually select what mode the 
input is using and you’ll manually choose this from a dropdown.  
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The preview window can be toggled off/on by hitting the Play button in the 
bottom left of this window.  You can also use the camera or folder icons here 
to set the thumbnail for your Input cue.  Clicking on the camera takes a 
“picture” of the preview in that moment and saves it as a thumbnail.  The 
other option is to click on the folder and select an image file to use for the 
thumbnail.  


You can link an audio input source to the Video input that either is 
embedded with that Video or to a separate Audio source.  


Under Source, you can choose either the embedded audio (which is chosen 
by default if available) or you will need to select your audio device if needed.  
You can also have no audio attached to the video input by selecting -No 
Audio Source- 


Once you have an Audio source selected, you can set a delay in milliseconds 
(this is currently only for positive values), the master volume of the input and 
also see individual channels of the audio.  There is also an option here to set 
Audio routing if you are using some form of audio output device and need to 
send specific channels of the audio input to certain channels of 
ProPresenter’s audio output.  You can also set the specific volume for each 
channel of audio by either dragging up/down on the audio knobs or 
manually entering a value between -60 and 6.  
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Audio Input

Adding an Audio Input is similar to adding a Video Input, but involves some 
additional settings/steps.  


To add an audio input, click on the + button next to "Audio" on the left 
column and you’ll see an Input device added.  You can name this Input 
either by single-clicking on the Name or entering the name in the main 
section of the window.  Should you need to remove one of the input devices 
you create, you can right-click or swipe the Input in the left column to delete 
it.


There are four different modes that you can choose from for your Audio 
Input.  The option you select here will change when/how the audio is input 
into ProPresenter.  


• Off — this means that the input is turned off and no audio will be 
used.


• On — this means that the input is turned on at all times from the 
moment the application is launched.


• Auto Off — this option keeps the audio input device turned on at 
all times except when a Foreground video that contains and 
audio track is triggered.
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•Auto On — this option turns the 
audio device on any time a linked 
video input is triggered to an Audience 
screen.  With Auto On enabled, you 
will see an Options button appear 
where you can link your Audio to any 
number of current Video Inputs.


The mode you select is saved between restarts of the program and active 
immediately upon launch. 


You can select the Source for your audio input from the dropdown menu.  
Note that this dropdown will show you any video inputs that are coming into 
the program that contain audio, as well as audio-only interfaces. 


Once you have an Audio source selected, you can set a delay in milliseconds, 
the master volume of the input, and also see individual channels of the 
audio.  There is also an option here to set Audio routing if you desire a more 
advanced signal flow.  Clicking on the speaker next to Routing will allow you 
to monitor what your Audio Input 
sounds like.  This will send out 
through the audio device you have 
selected for Inspector output in 
the Audio tab of Preferences.


SDI audio inputs consist of 16 
available channels, while NDI 
audio is limited to 8 channels at 
this time. You can tweak the 
volume of individual channels 
either by dragging up/down on 
the audio knobs or by manually 
entering a value between -60 and 
6dB. 


As of 7.3, you can also set an Audio Transition Duration in the bottom left of 
this window, this will allow you to set an amount of time between 0 and 10 
seconds for how long the Audio Input will transition in/out from your output. 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Network Tab


In order to enable any network services, the Enable Network checkbox 
should be checked. The Network Name and Port will be set automatically. It 
is unlikely that you will need to change the port number. Generally you 
would only need to change the port if you need to specifically route 
ProPresenter’s network traffic through a certain port due to network 
management requirements.


If you wish to use ProPresenter Apps for iOS and Android devices, as well as, 
the Stage app for AppleTV, you'll need to enable the settings under 
the Remote Apps section.


In order to use the ProPresenter Remote app for iOS and Android you will 
need to check the box to Enable ProPresenter Remote and enable the 
mode(s) that you want available of Controller and/or Observer. You will also 
need to set a Password for each login option.  Please note that you cannot 
use the same password for both modes and must have a password listed in 
each box that you have enabled.  


Enable Stage Display App allows you to use the ProPresenter Stage Display 
app for iOS, Apple TV and Android. You will need to set a Password here to 
be used to login to the App on the respective device.
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Sync Tab

ProPresenter makes it easy to sync files between computers, including files 
other than just your Library. This makes it much easier to setup a new 
computer with ProPresenter as well as being able to keep computers in sync 
with each other.


Before you can even begin syncing, you will need to have a central folder for 
everything to be stored. This needs be a dedicated folder in a shared 
directory or on an external drive that is used only for syncing. You will place 
this Folder Path under Repository in this window.


You will next choose what data you wish to include in your Sync Service. This 
can include Libraries, Media, Playlists, Themes, and other Support Files. 
Check any/all of these options and then choose Sync Up to Repository to 
create your initial folders on the Repository. You will have up to five folders in 
your sync folder. After the sync is complete, you can use either of the sync 
options depending on if you wish to add items to the Repository or bring 
items down from the Repository.


Files that are deleted in one location are not deleted in the other locations 
when syncing. This Sync method only looks at the current file list to 
determine what needs to be synced each direction.
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Choosing Sync files down from repository will move files from the 
Repository to your Computer. Choosing Sync files up to repository will move 
files from the Computer to your Repository. Enabling Replace My Files will 
replace any file with the same name using the Source version to replace the 
Destination version regardless of the Date Modified on either file. You should 
only use this if you want to “reset” any edits in the destination from a main 
computer.
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Resi Tab

ProPresenter’s Preferences window has a Resi tab that offers some helpful 
resources when you are logged in to your Resi account.  If you’re not logged 
in, you’ll see a Login button and an option to load the Resi website.  


Once you login to your Resi account, you can:


• View the status of your Resi account and your encoder name for the 
ProPresenter machine you are using. 


• Open the Control Center for Resi by clicking the Management button. This 
opens a browser window to the Resi Control page for your account, where 
you can set Destination Groups, create Web Event Profiles and learn more 
about your Resi account. 


• Check for the latest version of the Resi ProPresenter encoder. You can 
Check for Updates here to make sure you have the latest version. 


• Open the Capture Settings window that is discussed above for setting up 
the factors used for your stream to Resi.


More information on streaming your event through Resi can be found on 
Page 154 of this user guide.   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Services Tab


If you use Planning Center Online you can login to access service plans and 
to use Planning Center Live features. Once logged in, you will see your user 
name and organization listed at the top and the Login button will now show 
as an option to Logout. There are a number of settings available for 
Planning Center.


• Automatically Check for Plan Updates -- This option will check 
Planning Center every five minutes to see if your Plan has been 
updated. If ProPresenter notices a change, like a new item or a new 
compatible file attachment, it will alert you of the change in the 
playlist.


• Match Songs in Library -- Song matching helps speed up the process 
of connecting plan items to presentations that exist in ProPresenter. For 
example, if you have "Who You Say I Am" by Hillsong in your service on 
Planning Center, and you also have "Who You Say I Am" in your Library 
in ProPresenter, once you add the plan ProPresenter will automatically 
match the item and the presentation and load it for you in your playlist. 
ProPresenter can match on Title or CCLI number.


• Show Historical Service Plans -- When this option is checked you will 
be able to see past Planning Center plans shown in ProPresenter when 
you are creating a new Planning Center playlist. We will highlight this 
functionality again when we look at adding a Planning Center playlist 
in ProPresenter. If this option is unchecked, you will only see future 
plans.
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• Make Arrangements from Sequences -- Planning Center has put 
together a massive collection of pre-built sequences for songs that can 
be linked to your plans. These sequences can be used to help speed up 
the process of setting up new songs in ProPresenter. You can use the 
pre-built sequences or create your own custom arrangements. You can 
even add a song to your Planning Center Plan multiple times with 
different sequences and each of them will be added with the right 
arrangements in ProPresenter!


• Automatically Upload Documents and Media -- If you attach a 
ProPresenter presentation to a song or you attach a media cue to a 
media item in the playlist, those can both be uploaded to your 
Planning Center account. Planning Center Service plans do have 
storage limits, so be sure to check your plan before you start uploading 
files, especially video files which will quickly use up your storage space. 
The benefit of this option is that if you are creating everything from 
Computer 1 you can then add the same Planning Center playlist on 
Computer 2 and have all the songs and media download. We need to 
clarify one thing about media. This does not synchronize media within 
presentations. Backgrounds won't be synchronized. However, if you 
have a standalone media cue, like a welcome video, in your playlist, 
that can be uploaded.


• Automatically Download Documents and Media -- This is simply the 
reverse of the option above. As mentioned, you can download 
presentation attachments and media attachments. Other attachment 
types, like audio, text, or PDFs, cannot be downloaded and are ignored 
by ProPresenter.


At the bottom of this tab of Preferences is one of the areas you 
can Login to SongSelect. Click the Login button and a dialog box will come 
up where you can link your SongSelect account to ProPresenter. If you have 
already logged in, you'll see your user name listed there and a button 
to Logout should you need to.
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Audio Tab

As there are different options for setting up screens for video display in 
ProPresenter, there also are options in place for setting up your Audio 
Output.  


You can select what audio device/setup works best for you in the Audio tab of 
ProPresenter Preferences.  


Here you first select the number of channels you wish for ProPresenter to 
process for both input and output. This number is set to 2 by default for a 
typical stereo (Left and Right) channel output. If you are using multi-channel 
audio input devices or want more flexibility in how you process your audio, 
you can choose more channels.  There are different audio output options for 
the Media Inspector, the Main output, and for SDI and NDI outputs. 


For the Inspector Output, you can choose a device to preview the audio of 
media shown in the media inspector. This is useful, for example, if you want 
to use headphones plugged in to the computer to check the audio of a 
media file without impacting the audio going out the main output.  You can 
also choose individual Routing for the Inspector output and an overall 
volume level. 


For the Main Output, you can also choose an output device. Typically, this will 
be the System Setting unless you are using a more specialized setup for your 
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audio output. You have the option to set a volume level for the main output 
of the program, as well as the ability to delay the audio up to 1500 ms.


You can also route different channels of audio to different channels on your 
device if you need. You can find more information on Audio Routing on page 
117.  


If you are outputting your main audio output via either NDI or SDI, you will 
enable the SDI & NDI option below. This functionality allows you the ability to 
output directly over DeckLink and UltraStudio devices, instead of using 
system audio outputs. You now also have the ability to output directly over 
an NDI output. This allows the hardware or NDI output to read this Audio 
and go through their internal channels which eliminates internal audio 
processing. 


Note: If your Main Audio output is set to your BlackMagic Audio 
output device, or System Setting- and your system setting is that 
device — you will hear double audio over your SDI line. To 
prevent this, please turn the Main Audio output level down in 
ProPresenter, or choose another device for your Main Audio out.  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Advanced Tab


Video Playback -- The Use Option-Click (Alt-Click on Windows) to 
Suppress Auto Start Video option allows you to cue up a media file instead 
of it automatically triggering when clicked on. If this feature is enabled, 
holding Option (Alt on Windows) down when clicking on a Media action will 
load the video, but not beginning playing it back automatically. To play the 
file, you would hit the Space Bar and that would trigger the Play/Pause 
button on the video file.


Foreground Media Behavior -- These dropdown options allow you to set a 
behavior for audio outputs in the program when a Foreground is triggered 
on either the Presentation or Announcements Layer.  There are 5 options 
here that each behave slightly different…


• Audio layer ignores foreground media — This option simply means 
that the audio layer sees no effect if a piece of Foreground media is 
triggered 


• Audio layer is cleared for all media — This option clears any audio 
playing in the program anytime a piece of Foreground media is 
triggered


• Audio layer is cleared if media has audio — This option clears any 
audio playing in the program when a piece of Foreground media with 
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an audio channel is triggered.  As long as the media has an audio 
channel embedded on it (even a blank one) this will occur.  


• Audio layer pauses/resumes for all media — This option pauses any 
audio playing in the program when a piece of Foreground media is 
triggered.  Once that Foreground media is cleared, the audio will 
resume.  


• Audio layer pauses/resumes if media has audio — This option pauses 
any audio playing in the program when a piece of Foreground media 
with an audio channel is triggered.  As long as the media has an audio 
channel embedded on it (even a blank one) this will occur.  Once that 
Foreground media is cleared, the audio will resume.  


Support Files -- The folder path listed here is where the Support Files for the 
program are housed. By clicking the folder icon, you can choose a new folder 
on the machine to use as this repository.


Media Repository -- If you enable the Manage Media Automatically option, 
any media that you add to ProPresenter will be copied to the Assets folder in 
the Support Files folder location. By default this option is not checked, so any 
media added to ProPresenter doesn’t move the original files. If you enable 
this option, all media files will be added to ProPresenter and automatically 
moved into your media repository, preventing accidental broken links. If you 
already have a well organized media storage method, you may not want to 
enable this option.


Search Paths -- Search Paths are used to re-link media files that come up as 
missing in the program with the same files if they are being housed in a 
different location on your machine. You can enable this setting by checking 
the box for Automatically Relink Missing Media Using Alternate Paths and 
then check any folder paths you wish for the program to use to try and 
locate missing media. This setting will likely not be needed if you 
have Manage Media Automatically enabled above.
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Devices Tab

In the Devices Tab, you can add Communication Devices for ProPresenter to 
use. The Windows version offers the ability to add Midi communication. The 
Mac version offers more communication options of Midi, DMX, AMP, CITP, 
GlobalCache, GVG100, RossTalk, Sony BVS, Sony BVW and VDCP.


To add a device, click on the + button at the bottom left of the window and 
choose the type of protocol you're using. Each device will have unique 
settings you'll need to enter based on its type. Once you have created a 
Device you will see it listed in the Devices Tab of preferences. Click 
the Connect button to connect to that Device. To Delete a Device, right click 
on it and select Delete, or click the Delete button from within 
the Settings window.


More information on Communication with these devices can be found in the 
Communications section. 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Updates Tab

The Updates section of Preferences allows you to see what the current 
version of the program is, update your software to a newer version release 
and also view our Beta channel.  


Updates

Click the Check Now button to see if there are any current updates based on 
which Update Channel you’re running on.  You can click on Show Release 
Notes and view our Version History that includes a list of what improvements 
are present in each update of the program.  


You can also see the currently installed version and build number and the 
date at which the program was last updated on your system.  Here is where 
you’d also enable for notifications to appear when launching the program as 
to if an update is available.  We recommend enabling this option to make 
sure you’re able to use the latest release of the program.  


Update Channel

You can also choose if you wish to be on our Release or Beta update channel.  
The Release updates are generally more stable and intended for live 
production.  Beta updates are published more often, but may not be fully 
tested and are only recommended after extensive testing in your 
environment.   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Additional Resources

You can access a wealth of information about ProPresenter and search for 
help in our knowledge base at: http://support.renewedvision.com
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